$V_{ARTRAN}$

**Statistical Tolerances**

- LSL
- USL
- $T$
- $8.7534$
- $11.243$
- $ml/min$

**Worst-Case Tolerances**

- LSL
- USL
- $T$
- $11.243$
- $ml/min$

**Robust Designs**

- Temperature
  - Hot Bar (°F)
  - $200$
  - $175$
  - $150$
  - $0$
- Dwell Time (sec)
  - $0.5$
  - $0.75$
  - $1.0$
- Seal Strength Standard Deviation
  - $1.4$
  - $1.1$
  - $1.7$

**Cause of Variation**

- $X_1$
- $X_2$
- $X_3$
- $X_4$
- $X_5$
- $X_6$
- $X_7$
- $X_8$
- $X_9$
- $X_{10}$
User's Guide

VARTRAN

Version 3.1

Dr. Wayne A. Taylor
This software package was created by:

Dr. Wayne A. Taylor

Dr. Taylor is the founder and chairman of Taylor Enterprises, Inc. where he is responsible for the development of the VarTran®, Change-Point Analyzer, and Sampling Plan Analyzer software packages as well as providing consulting and training on the Six Sigma approach and tools including Robust Design, Tolerance Analysis, Design of Experiments, SPC, Acceptance Sampling, and Statistics.

Dr. Taylor retired from his position as Director of Quality Technologies at Baxter Healthcare Corporation where he was responsible for implementing Baxter's Six Sigma program. He had been with Baxter for 22 years.

Dr. Taylor is author of the books *Optimization and Variation Reduction in Quality* and *Guide to Acceptance Sampling*. The first book outlines the approach implemented at Baxter for achieving six sigma quality. The second book provides an easy to use approach for selecting valid sampling plans and for reducing inspection costs that has saved Baxter over 30 million dollars annually. His two courses *Successful Acceptance Sampling* and *Robust Tolerance Analysis* have been attended by thousands of engineers and scientists.

Dr. Taylor is a leading expert on acceptance sampling and process validation in the pharmaceutical, medical device and diagnostics industries. His articles on selecting statistically valid sampling plans have become standards in the industry. He is one of the authors of the Global Harmonization Task Force guideline on Process Validation.

The VarTran software and Dr. Taylor's course Robust Tolerance Analysis have rapidly become a key component of many companies DFSS (Design for Six Sigma) programs. Honeywell, the Six Sigma Academy and numerous other companies have adopted VarTran as an essential tool for designing high quality products.

Dr. Taylor received his Ph.D. in Statistics from Purdue University. He is a fellow of the American Society for Quality.
# Table of Contents

## Chapter 1  Program Installation  1
1.1 System Requirements  1
1.2 Installation VarTran  1
1.3 Registering the Software  2
1.4 Uninstalling VarTran  2

## Chapter 2  Tutorials  3
2.1 Design of a Pump  4
2.2 Optimization of a Heat Sealer  12
2.3 Dimensional Stack-Up Problem  20
2.4 VarTran as a Mathematics Package  28

## Chapter 3  Overview  33
3.1 Optimization & Variation Reduction  33
3.2 The Importance of Reducing Variation  35
3.3 How to Reduce Variation  37
3.4 Robustness  40
3.5 Variation Transmission Analysis  43
3.6 Behavior of the Inputs  44
3.7 Strategy  48

## Chapter 4  Entering Information  49
4.1 Main Window  49
4.2 Adding Variables  50
4.3 Continuous Input Variables  51
4.4 Category Input Variables  61
4.5 Output Variables  63
4.6 Objective Functions  70
4.7 I/O System Window and Editing Variables  74
4.8 Summary Table  76

## Chapter 5  Predicting Capability  79
5.1 Capability Study Window  79
5.2 $C_p$, $C_c$, $C_{pk}$ and Six Sigma  81
5.3 Statistical Tolerances  90
5.4 Worst-Case Tolerances  94
5.5 Process Tolerances  97
5.6 Objective Functions  102
# Table of Contents

## Chapter 6  Optimization and Robustness  103
- 6.1 Find Optimal Targets Dialog Box  103
- 6.2 Simplex Method  106
- 6.3 Interval Method  107
- 6.4 Optimization Options  109

## Chapter 7  Tightening Tolerances  111
- 7.1 Pareto Chart Window  111
- 7.2 Working With More Than One Design  116

## Chapter 8  Understanding the Results  121
- 8.1 Effects Tables  121
- 8.2 Plots Dialog Box  125
- 8.3 Plot Window  127
- 8.4 Checking Results Using Simulations  136

## Chapter 9  Using VarTran with Designed Experiments  139
- 9.1 Types of Equations  139
- 9.2 Dual Response Approach  141
- 9.3 Tolerance Analysis Approach  143

## Chapter 10  Menus and Toolbar  147
- 10.1 File Menu  147
- 10.2 Variables Menu  150
- 10.3 Analysis Menu  152
- 10.4 Window Menu  153
- 10.5 Options Menu  154
- 10.6 Help Menu  155
- 10.7 Toolbar  157

Glossary  159
References  169
Index  171
1 Program Installation

This section describes the system resources required by VarTran® and how to install VarTran on your computer.

1.1 System Requirements

VarTran runs on any 32-bit Windows operating system including Windows 95, 98, 2000, XP and NT. It requires 5 MB of hard disk space to install.

1.2 Installing VarTran

VarTran is a shareware program. A full version of the software can be downloaded for a 30-day trial. If you want to continue using the software after trial period, you must register it.

To install VarTran, download the file vta31.exe from www.variation.com/vta. Executing this file will run the installation program. The software will be automatically installed to the directory C:\Program Files\Taylor Enterprises\VarTran. Along with the software, the user manual, a tutorial, and numerous example files are copied to this directory. VarTran data files end with the extension vta.

A shortcut is added to the desktop for starting the program. It appears as below. Double clicking this shortcut will start the program.

![VarTran shortcut]

In addition, three menu items are added to Programs menu. Click on the button in the lower left corner of the screen and then click on the Programs menu item. Find the VarTran folder and click on it. This displays the following three menu items:

![Programs menu]

The third menu item starts the program. The first two menu items display program documentation in pdf format. You must have a copy of the free Adobe Acrobat Reader® to view these files.
1.3 Registering the Software

VarTran can be used free of charge for 30 days. After the 30 days trial period, you must register the software to continue to use it. To register the software, go to www.variation.com/vta and click the Register button. Up to date pricing information will be provided along with further instructions. The registration process can be completed online. The Help menu of VarTran also contains further details about registering the software.

Once the software is registered, you will receive a user name and registration code by email. These must be entered into the software. The user name and registration code can be manually entered into VarTran by selecting the Enter Registration Code menu item on the Help menu. This displays the Registration dialog box shown below. The user name and registration code must both be entered exactly as provided (case-sensitive). Once done, click the OK button.

1.4 Uninstalling VarTran

VarTran can be uninstalled using the Add or Remove Programs icon on the Control Panel. Step-by-step instructions follow:

- Click the Start button.
- Select the Control Panel menu item from the Settings menu.
- Double click the Add or Remove Programs icon.
- Select the program VarTran and click the Change/Remove button.

This will remove the program, user manual, tutorial and example files. It will not affect any files you created using the software.
VarTran® has numerous capabilities. It can be used to perform tolerance analysis. VarTran performs both worst-case and statistical tolerancing. It can be used to solve tough nonlinear problems for which the classical tolerancing formulas fail. VarTran also implements an entirely new approach to tolerancing called process tolerancing. This novel approach to tolerancing represents a unified approach that allows worst-case tolerances to be used for some variables, statistical tolerances for others and a combination of the two for the rest. Process tolerancing solves the age-old debate of worst-case versus statistical tolerances.

VarTran, however, is much more than a tolerancing package. It can be used to reduce variation through robust designs. You can ask VarTran to find the set of targets that maximizes Cpk, minimizes the Taguchi loss or that achieves some other objective. You can then ask VarTran which tolerances contribute the most to the remaining variation so that tolerances can selectively be tightened based on cost and benefit. The result is high quality at a low cost.

VarTran can be used in product design, process development, material development and manufacturing. Of all the variation reduction tools, it is the one that can be used earliest in the design process. Despite its state of the art capabilities, VarTran is easy to use. The typical analysis including optimization can be performed in less than 15 minutes. This type of analysis has traditionally taken days to complete.

The following four tutorials can be used to quickly explore VarTran's capabilities:

**Design of a Pump:** Demonstrates the use of VarTran in product development.

**Optimization of a Heat Sealer:** Demonstrates the use of VarTran on a process following a response surface study.

**Dimensional Stack-up Problem:** Demonstrates the variety of methods available in VarTran for addressing dimensional tolerance stack-up problems.

**VarTran as a Mathematics Package:** Demonstrates VarTran's mathematical capabilities including its state of the art optimization routines based on interval analysis.

The tutorials can be explored in any order. Start with the tutorial of greatest interest. However, it is a good idea to explore all four tutorials. Each highlights a different aspect of VarTran's capabilities.

Once the tutorials are completed, turn to Chapter 3 to understand the basic principles and strategies for using VarTran. The remaining chapters provide complete documentation on the software. They can be read in their entirety or referenced as needed. Much of this same documentation is also available through the program's help system.
Introduction

Design offers the first and best opportunity for reducing variation. To illustrate the strategies and tools required, consider the task of designing a new pump. Suppose that the pump must be capable of delivering solution at a constant rate of 10 ml/min. Customer usage requires that the flow rate remain between 9 and 11 ml/min. The first step is to develop a design concept. Taguchi calls this the system design. Suppose we decide to use a piston to push the solution. This concept requires a motor to drive the piston and a valve to control the direction of the flow. This is the creative part of design.

Now the work begins. We need to determine all the specifics such as "How far should the piston travel?" and "How fast should the motor turn?" To accomplish this task, we need to make a list of all the factors affecting flow rate. Three obvious factors are the piston radius (R), the stroke length (L), and the motor speed (S). Another possible factor is the amount of backflow through the valves (B). Factors affecting flow rate are referred to as the input variables. Flow rate is referred to as the output variable. It is the output for which we want to optimize the average and reduce the variation. This is accomplished by establishing requirements and controls for the inputs.

Initial Design

To accomplish our task, we must be able to predict how the output will behave. This requires knowledge of how the inputs behave and how the inputs affect the output. For a pump, it is possible to use geometry to derive the following equation for flow rate:

\[ F = (16.388 \pi R^2 L - B) S \]

The expression \( \pi R^2 L \) represents the volume of a cylinder of radius R and height L. Multiplying by 16.388 converts the quantity from cubic inches to milliliters. The volume is then reduced by the backflow and multiplied by the motor speed to obtain the final flow rate.

We also need information on how the inputs behave. This requires us to call the plant to obtain process capability information on drilling the piston hole. They tell us the standard deviation of their process is 0.0005". We must also call the motor supplier to determine the capability of their process in controlling motor rpm. They have both $5 and $20 motors. Our initial design will be based on low-cost components and processes so we request information on the $5 motor. Changes can be made later if necessary. They inform us that the standard deviation of their process is 0.17 rpm. The valve supplier must also be contacted to determine their process capability information for valve backflow. There is a choice between a $1 and a $2 valve. Again we start with the $1 valve. The valve manufacturer provides us with both an average and standard deviation. The table on the next page shows the information collected.
Data from Plants and Suppliers

<table>
<thead>
<tr>
<th>Inputs</th>
<th>Average</th>
<th>Standard Deviation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Piston Radius (R)</td>
<td>-</td>
<td>0.0005&quot;</td>
</tr>
<tr>
<td>Stroke Length (L)</td>
<td>-</td>
<td>0.0017&quot;</td>
</tr>
<tr>
<td>Motor Speed (S)</td>
<td>-</td>
<td>0.17 rpm</td>
</tr>
<tr>
<td>Backflow (B)</td>
<td>0.05 ml</td>
<td>0.005 ml</td>
</tr>
</tbody>
</table>

Targets must be selected for piston radius, stroke length and motor speed. Values of $R = 0.1"$ and $L = 0.5"$ were selected based on judgment. Plugging these values into the equation for flow rate, setting the equation equal to 10 ml/min and solving for motor speed results in a motor speed of 48.2 rpm. This completes the preliminary design. The average should be on target, but what about the variation?

**Using VarTran**

For a demonstration of VarTran's abilities, start VarTran and open the file *pump.vta*. This is accomplished by selecting the *Open...* menu item from the *File* menu. Highlight *pump.vta* and then click on the *OK* button. The *I/O System* window shown below will be displayed. The input variables are shown on the left of the window and the output variables are shown on the right.

All of the information about the input and output variables has already been entered into VarTran. To view the information entered for a variable, double click on it in the *I/O System* window. For example, double clicking on the output variable F displays the dialog box shown on the next page. This dialog box is used to enter the equation, target and specification limits for flow rate. Press the *OK* button to close the dialog box.
Try the same for the input variable \( R \). The dialog box shown below is displayed. This dialog box is used to enter the target and standard deviation for \( R \). A tolerance has been entered that is +/-3 standard deviations. The standard deviation is then specified as \( 1/6 \) the width of the tolerance. A maximum and minimum target has also been entered representing the range of alternative targets considered when optimizing the design later. The Include in Optimization check box is checked indicating that the target for this input can be changed during design optimization. Press the OK button to close the dialog box.
For input variable B (valve backflow), the *Include in Optimization* check box is not checked. This prevents the backflow target from changing during optimization. The target for backflow was provided by the supplier and cannot be adjusted by the designer.

### Evaluating the Initial Design

If you know how the inputs behave and you know how the inputs affect the output, you can predict how the output will behave. While this can be accomplished using a simulation, VarTran uses analytic methods instead. To view the results, click on the *Capability Study* button on the toolbar. This performs a tolerance analysis and displays the results shown below.

#### Analysis – Capability Study

![Analysis – Capability Study](image)

In designing this pump, our goal is six sigma quality. This requires a defect rate of 3.4 defects per million (dpm) or below. The capability study predicts that the defect rate will be 297 dpm and that some pumps will have flow rates as low as 8.7544 and as high as 11.242 ml/min. Both these values are outside the specifications of 9 to 11 ml/min. The initial design does not achieve our six sigma goal. Since the flow rate average is on target, the variation must be reduced. Leave the *Capability Study* window open.
Robust Design

One way of reducing the flow rate variation is through what Taguchi calls robustness. Robustness is obtained by designing the pump to be less sensitive to the variation of the inputs. The inputs continue to vary, but less of this variation is transmitted to the output. Robust design is accomplished through the setting of the inputs' targets. Since it is generally less costly to adjust targets than tighten tolerances, building in robustness is the preferred method of reducing variation. This is what Taguchi calls the second stage of design, which he refers to as Parameter Design.

A robust design can be obtained by finding the set of targets for the inputs that minimizes the defect rate. Start by clicking on the Optimize button on the toolbar. The Find Optimal Targets dialog box shown below is displayed. Specify that the flow rate percent defective is to be minimized and then click on the Simplex Optimize button. The optimization will take just a couple of seconds.

Once the optimization is completed, exit the Find Optimal Targets dialog box by clicking on the Close button. The Capability Study window will automatically update itself. It will now appear as shown on the next page. The variation has been cut in half while maintaining an average flow rate of 10 ml/sec. Since the defect rate is below 3.4 dpm, our design is now six sigma. The capability study predicts that nearly all units will fall in the range of 9.3224 to 10.678 ml/min. This is well within the specification limits. All this was accomplished using the low cost components. Your results may differ slightly due to the properties of the optimization routine but should be very close.
To view the new design, click on the Summary Table button on the toolbar. The result is shown below. The new targets are $R = 0.1737''$, $L = 0.40942''$ and $S = 17.064$ rpm. The target for valve backflow did not change because it was excluded from the optimization. It was provided by the supplier and cannot be adjusted by the designer.

Variables – Summary Tables

<table>
<thead>
<tr>
<th>Input</th>
<th>Type</th>
<th>Tolerance / Category</th>
<th>LSL</th>
<th>USL</th>
<th>Average and Variation Requirements</th>
<th>Interval for Values +/- 4.5SD</th>
</tr>
</thead>
<tbody>
<tr>
<td>$R$</td>
<td>Statistical</td>
<td>0.1737 +/- 0.0015</td>
<td>0.1722</td>
<td>0.1752</td>
<td>Average = 0.1737, Std. Dev. = 0.0015</td>
<td>(0.17145, 0.17595)</td>
</tr>
<tr>
<td>$L$</td>
<td>Statistical</td>
<td>0.40942 +/- 0.0065</td>
<td>0.40442</td>
<td>0.41442</td>
<td>Average = 0.40442, Std. Dev. = 0.001697</td>
<td>(0.40362, 0.41629)</td>
</tr>
<tr>
<td>$S$</td>
<td>Statistical</td>
<td>17.064 +/- 0.5</td>
<td>16.564</td>
<td>17.564</td>
<td>Average = 17.064, Std. Dev. = 0.5</td>
<td>(15.314, 17.814)</td>
</tr>
<tr>
<td>$B$</td>
<td>Statistical</td>
<td>0.005 +/- 0.015</td>
<td>0.005</td>
<td>0.005</td>
<td>Average = 0.005, Std. Dev. = 0.015</td>
<td>(0.0025, 0.0075)</td>
</tr>
</tbody>
</table>
Tightening Tolerances

What if the desired performance had not been achieved? The next step would be to tighten tolerances. This generally requires using more expensive components and processes. The question is which tolerances and by how much? In deciding which tolerances to tighten, you should consider both the cost and the effect of tightening each tolerance. To determine the effect of tightening the tolerances on the different inputs, click on the Variation Pareto Chart button on the toolbar. The window shown below is displayed.

Motor speed variation (S) is the largest contributor to the flow rate variation. Tightening its tolerance requires using the $20 motor. One could enter the tolerance (standard deviation) for the $20 motor, re-optimize the process and then view the new capability. One should also consider tightening the tolerance for valve backflow. This requires using the $2 valve which is significantly cheaper. The Pareto chart indicates the effect is nearly the same as tightening the tolerance of motor speed. The option representing the best value to the customer should be selected. This is what Taguchi refers to as the third stage of design, which he calls Tolerance Design.
Summary

The above example illustrates the following strategies:

(1) The designer must take the time to identify:

- The key outputs
- Customer requirements for the key outputs
- The key inputs
- How the key inputs behave (manufacturing and suppliers capabilities)
- How the key inputs affect the outputs (equations)

Without this knowledge, the design process breaks down into one of trial and error.

(2) Designing in robustness results in higher quality and lower costs. Otherwise, variation must be reduced by tightening tolerances which drives up costs. This requires that variation be considered when determining the inputs' targets.

(3) The initial design should be based on low-cost tolerances. This ensures manufacturability of the product. Tolerances are selectively tightened only if needed. Instead designers frequently specify overly tight tolerances for the inputs to insure design performance which in turn drives up costs.
2.2 Optimization of a Heat Sealer

Introduction

A heat sealer is used to form the top seal of a pouch protecting the product. The top seal must be strong enough to survive shipping and handling but weak enough to be easily opened by the customer. The target seal strength is 26 pounds with spec limits of 20 to 32 pounds.

A response surface study was run to optimize the performance of the heat sealer. Eight inputs variables were studied. Of these, hot bar temperature, dwell time, pressure and material temperature had significant effects on the average. The seal strength standard deviation was analyzed separately. Hot bar temperature and dwell time were found to also affect the standard deviation. Contour plots were then used to identify the input targets minimizing the variation and achieving an average seal strength of 26 pounds. Selecting targets for the inputs that minimize the seal strength variation is called a robust process. This approach is called the dual response (average and standard deviation) approach to robustness.

Studies like the one above have proven highly successful. However, they also have their limitations. First, the dual response approach optimizes the process performance under the conditions that were present when the study was run. Frequently, the variation present during the study is not representative of the full range of variation that will be experienced over more extended periods of production. For example, if only one roll of plastic sheeting is used in the study, roll-to-roll variation of sheeting thickness would not be captured as part of the variation. This can result in making the process robust to the wrong sources of variation.

Taguchi suggest an alternative approach called the inner/outer array approach that overcomes this limitation. His outer array corresponds to the design array of the response surface study. He suggests that for each trial in the outer array, those inputs potentially contributing to the variation be purposely varied in a pattern that mimics their variation in production. This pattern is called the inner or noise array. This approach increases the costs of performing the study but ensures the process is optimized for production conditions. Using VarTran, the process can be optimized for actual production conditions without the added expense of running an inner/outer array type study.

The second limitation of the dual response approach is that it does not identify the root cause of the variation. If adjusting targets fails to obtain the desired performance, further reduction in the variation must be achieved by tightening the tolerances of the inputs. However, it is not known which tolerances to tighten. VarTran can be used to identify the root cause of the variation allowing further reduction of the variation through the tightening of tolerances. The following tutorial shows how VarTran can be used to overcome both these limitations.

Response Surface / Tolerance Analysis Approach

The first step using this approach is to run a response surface study. The purpose of this response surface study is to obtain an equation for how the inputs affect the output. The equation shown below was obtained:
SS = 27.9029646803808 + 0.0822867601868433 (THB - 175) - 9.00263649461868 (DT - 0.75) + 0.0458833145964137 (P - 100) + 0.0430545023685393 (MT - 90) - 0.00749437527699365 (THB - 175)² - 83.3209058456264 (DT - 0.75)² - 1.03469576191631 (THB - 175) (DT - 0.75)

where SS = seal strength, THB = temperature of the hot bar, D = dwell time, P = pressure and MT = material temperature. This equation is for the average seal strength.

We also need information on how the inputs behave. This requires collecting additional data from the process. To obtain information on temperature of the hot bar, a temperature transducer was attached to the hot bar and the results recorded over an extended production run. From this data the standard deviation of the hot bar temperature was estimated. Likewise, standard deviations for the other inputs were also obtained. These standard deviations should be representative of long term production. The results are shown below. Also displayed are the targets for the inputs that are used in production.

### Data on the Behavior of the Inputs

<table>
<thead>
<tr>
<th>Inputs</th>
<th>Production Target</th>
<th>Standard Deviation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Temperature of the Hot Bar (THB)</td>
<td>190 °F</td>
<td>2 °F</td>
</tr>
<tr>
<td>Dwell Time (D)</td>
<td>0.8 sec</td>
<td>0.08 sec</td>
</tr>
<tr>
<td>Pressure (P)</td>
<td>100 lbs</td>
<td>1 lbs</td>
</tr>
<tr>
<td>Material Temperature (MT)</td>
<td>75 °F</td>
<td>4 °F</td>
</tr>
</tbody>
</table>

We are now ready to perform a tolerance analysis using VarTran. For a demonstration of VarTran's abilities, start VarTran and open the file heatseal.vta. This is accomplished by selecting the Open... menu item from the File menu. Highlight heatseal.vta and then click on the OK button. The I/O System window below is displayed showing the inputs and outputs. The inputs are displayed on the left followed by the outputs on the right.

To view the information entered for a variable, double click on it in the I/O System window. For example, double clicking on the output SS displays the dialog box on the next page. This dialog box is used to enter the equation from the response surface study along with the target and specification limits. Press the OK button to close the dialog box.
Try the same for temperature of the hot bar. The dialog box shown below is displayed. The standard deviation is 2°F. This standard deviation represents the full variation expected during production. A tolerance has been entered that is +/-3 standard deviations. The standard deviation is then specified as 1/6 the width of the tolerance. The minimum and maximum targets have been set to the response surfaces region of study. This avoids extrapolation by restricting the range of alternative targets considered when the process is later optimized to the region of study. The target is initially set to the production target. It will change later when the process is optimized. The Include in Optimization check box is checked signifying that the target for this input can be changed during optimization. Click the OK button to close the dialog box.
Predicting Seal Strength Variation

If you know how the inputs behave and you know how the inputs affect the output, you can predict how the output will behave. While this can be accomplished using a simulation, VarTran uses analytic methods instead. To view the predicted results at the original operating conditions, click on the Capability Study button on the toolbar. The predicted performance is shown below.

The predicted performance is far from that desired. The process is only slightly off target. The most significant issue is the excessive variation. Leave the Capability Study window open.
Optimizing Seal Strength to Achieve Robustness

One way of reducing the seal strength variation is through what Taguchi calls robustness. Robustness is obtained by setting up the heat sealer to be less sensitive to the variation of the inputs (both process parameters and material properties). The inputs continue to vary, but less of this variation is transmitted to the output. Robust design is accomplished through the setting of the inputs' targets. Since it is generally less costly to adjust targets than tighten tolerances, robustness is the preferred method of reducing variation.

A robust process can be obtained by finding the set of targets for the inputs that minimizes the defect rate. Start by clicking on the Optimize button on the toolbar. The Find Optimal Targets dialog box shown below is displayed. Specify that the seal strength percent defective is to be minimized and then click on the Simplex Optimize button. The optimization will take just a couple of seconds.

Once the optimization is completed, exit the Find Optimal Targets dialog box by clicking on the Close button. The capability study is automatically updated. It will now appear as shown on the next page. The variation has been cut by 70% while achieving an average seal strength of 26 pounds. The predicted defect rate is well below 1 dpm (defects per million). The capability study predicts that nearly all units will fall in the range of 22.429 and 29.571 pounds. This is well within the specification limits. All this was accomplished by adjusting the targets at which the process is operated. This simply requires adjusting a few knobs. No tolerances were tightened.
To view the targets selected for the inputs, click on the Summary Tables button on the toolbar. The result is shown below. The new targets are a hot bar temperature of 191°F, a dwell time of 0.596 seconds and a pressure of 55.28 pounds. Material temperature remains at 75°F. Material temperature did not change because its Include in Optimizations check box was not checked. The optimization determined: "Without preheating of the material, what is the best setup?" Since the process safely fits between the specification limits, preheating of the material is not necessary.
Cause of the Variation

We have still not answered the question of what is causing the variation. This is especially important when the desired objective has not been achieved. The answer can be obtained by clicking on the Variation Pareto Chart button on the toolbar. The results are shown below. Dwell time variation turns out to be the largest source of variation. Using VarTran, one could enter a new tolerance for dwell time, re-optimize the process and then view the new predicted capability.

Analysis - Variation Pareto Chart

The above example illustrates that VarTran can be used to:

1. Optimize the process for production rather than study conditions.
2. Identify the root cause of the variation.
3. Be used to tighten tolerances to achieve the desired performance even when the response surface fails to find targets that achieve the desired result.

Summary

The above example illustrates that VarTran can be used to:

1. Optimize the process for production rather than study conditions.
2. Identify the root cause of the variation.
3. Be used to tighten tolerances to achieve the desired performance even when the response surface fails to find targets that achieve the desired result.

Any time a response surface study is run, one should use VarTran to complete the task of establishing operating windows.
The response surface/tolerance analysis approach to robustness offers a third alternative to the dual response and Taguchi inner/outer array approaches. The response surface/tolerance analysis approach has all the advantages of Taguchi’s approach without the added cost of running a more complex study. It also has another significant advantage over both the dual response and Taguchi approaches. The estimates of the variation resulting from the response surface/tolerance analysis approach are generally more accurate and precise than estimates resulting from the other two approaches. The response surface/tolerance analysis approach is the best demonstrated practice for achieving robustness.

The response surface study is only required if an equation is not otherwise available. If the equation is already known, VarTran can be used directly. For the infamous Wheatstone bridge example used by Taguchi, the equation was first derived. This equation can be entered directly into VarTran and the problem solved within minutes without needing a designed experiment.
2.3 Dimensional Stack-up Problem

Suppose that four identical components are to be stacked on top of each other and that we are interested in controlling the overall height. The height will be denoted by the symbol $H$ and will be referred to as the output variable. We desire an overall height of 4.0". The customer will not tolerate a deviation from target of more than ± 0.1". This results in a lower specification limit of 3.9" and an upper specification limit of 4.1".

The four components are identical. Their manufacturing tolerance is 1.00" ± 0.03" or stated another way from 0.97" to 1.03". Essentially all components fall within these tolerances. The heights of the four components will be denoted $D_1$, $D_2$, $D_3$ and $D_4$ and will be referred to as the inputs. The overall height is equal to:

$$H = D_1 + D_2 + D_3 + D_4$$

The question we want to answer is whether the overall height requirement will be met. There are several different approaches to answering this question. These are illustrated below.

**Worst-Case Tolerancing Approach**

One commonly used approach is called worst-case tolerancing. For a demonstration of VarTran's abilities in calculating worst-case tolerances, start VarTran and open the file `stack-wc.vta`. This is accomplished by selecting the *Open...* menu item from the *File* menu. Highlight `stack-wc.vta` and then click on the *OK* button. The results of a worst-case tolerance analysis are displayed below.

![Overall Height - (H)](image)

<table>
<thead>
<tr>
<th>Characteristic</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>At Target:</td>
<td>4</td>
</tr>
<tr>
<td>Minimum:</td>
<td>3.88</td>
</tr>
<tr>
<td>Maximum:</td>
<td>4.12</td>
</tr>
</tbody>
</table>

The interval for values = (3.88, 4.12)

The resulting worst-case tolerance for overall height is from 3.88" to 4.12". This fails to meet the specification limits for the overall height. As a result, tolerances for the inputs must be tightened if the specification limits for overall height are to be met.

Worst-case tolerancing assumes that all four components can simultaneously be at the same extreme value. For example, if all four components have the minimum height of 0.97", the overall height will be 3.88". Likewise, if all four components have the maximum height of
1.03", the overall height will be 4.12". This yields a worst-case tolerance for overall height of 3.88" to 4.12". If the tolerances for the individual components are all met, the resulting worst-case tolerance for overall height is guaranteed to be met.

To view the information that was entered into VarTran, double click on the different variables in the I/O System window shown below.

For example, double clicking on input D1 displays the dialog box shown below. This dialog box contains the target and worst-case tolerance for D1. To close the dialog box, press the OK button.
Double clicking on overall height, displays the dialog box shown below. This dialog box contains the equation for overall height along with its target and specification limits. Again, press the OK button to close the dialog box.

Statistical Tolerancing Approach

A second commonly used approach is called statistical tolerancing. The results of a statistical tolerance analysis can be displayed by opening the file \textit{stack-st.vta}. The results are shown below

![Overall Height - (H)
Statistical Tolerance](image)

<table>
<thead>
<tr>
<th>Characteristic</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Average:</td>
<td>4</td>
</tr>
<tr>
<td>Standard Deviation:</td>
<td>0.02</td>
</tr>
<tr>
<td>Cp:</td>
<td>1.67</td>
</tr>
<tr>
<td>Cc:</td>
<td>0.00</td>
</tr>
<tr>
<td>Cpk:</td>
<td>1.67</td>
</tr>
<tr>
<td>Def. Rate (normal):</td>
<td>0.573 dpm</td>
</tr>
<tr>
<td>Z-Score (short-term):</td>
<td>4.86</td>
</tr>
<tr>
<td>Sigma Level:</td>
<td>4.86</td>
</tr>
</tbody>
</table>

Interval for Values = (3.94, 4.06) +/- 3SD
The resulting statistical tolerance for overall height is from 3.94" to 4.06". This easily meets the specification limits. The tolerance for the components does not require tightening. Statistical tolerancing results in the opposite conclusion as worst-case tolerancing.

Statistical tolerancing assumes that the components come from a process that is centered on the target and that traditionally has a maximum standard deviation equal to 1/6 the tolerance. In this case, the tolerance of ± 0.03" results in a maximum standard deviation of 0.01". For tolerance stack-up problems, statistical tolerances are obtained for the outputs by using the root sum of squares formula. In this case, the resulting tolerance for overall height is:

$$\sqrt{0.03^2 + 0.03^2 + 0.03^2 + 0.03^2} = 0.06$$

The resulting statistical tolerance of 4.0" ± 0.06" is exactly half that of the worst-case tolerance.

To view how the information entered for input D1 has changed, double click on D1 in the I/O System window. The dialog box shown below will appear. This dialog box contains the target and tolerance of D1. In the standard deviation field, the standard deviation is defined to be 1/6 the width of the tolerance. To close the dialog box, press the OK button.
Statistical Versus Worst-Case Tolerances

The dilemma faced when tolerancing is which approach to tolerancing should be used. As the above example illustrates, the approach selected can make a large difference. So what are the pros and cons?

Worst-case tolerancing is a safe approach. If the 4 components all meet their tolerances, the overall height is guaranteed to be within the calculated worst-case tolerance. However, worst-case tolerancing guards against the unlikely event where all four components are simultaneously at the same extreme, either all at the lower tolerance value or all at the upper tolerance value. This is unlikely in any case. However, it is especially unlikely if the components come from a process with variation. When variation is present, the average height of the components must be safely within the tolerance limits to ensure that the individual components all remain within the tolerances. As a result, only a small number of components are actually at the extreme value. The probability of selecting four components all at the same extreme is therefore extremely small.

Worst-case tolerancing guards against a worst-case scenario that can only occur if the variation is zero. As a result, worst-case tolerances for the output are wider than will be experienced in practice. This can result in the unnecessary tightening of tolerances for the components driving up costs. Worst-case tolerancing, while safe, is overly expensive.

Statistical tolerancing results in much narrower tolerances for the outputs. As a result, the tolerances for the inputs do not require as much tightening resulting in lower costs. However, there is a risk involved. Statistical tolerancing assumes that the process producing the components remains centered at the selected target. No process remains perfectly centered all the time. With statistical tolerancing, off center processes can result in components that meet the tolerance for the individual components but, when assembled together into a finished unit, result in a finished unit that exceeds specifications. As a result, statistical tolerances for the output can be narrower than will be experienced in practice. As such, statistical tolerancing might be better called best-case tolerancing. Statistical tolerancing, while less expensive, is more risky. The real answer generally falls somewhere between the worst-case and statistical approaches.

This long recognized dilemma has lead to a number of less than ideal practices. One approach used is called Benderizing tolerances. It basically is to do statistical tolerancing and then inflate the resulting tolerance by 50%. Another approach is to split the difference. This approach involves doing both worst-case and statistical stack-ups and taking the midpoint between them. As unscientific as either of these approaches sounds, both are probably closer to the correct answer than either the worst-case or the statistical stack-up.

A Solution – Process Tolerancing

Worst-case tolerancing results in tolerances for the outputs that are too wide. It is safe but expensive. Statistical tolerancing results in tolerances for the outputs that are too narrow. It is less expensive but risky. Ideally we want to be somewhere between these two extremes.
A new method of tolerancing called process tolerancing has been implemented in VarTran that allows just this

The results of a process tolerance analysis can be displayed by opening the file *stack-pr.vta*. The results are shown below.

![Overall Height - (H)](image)

<table>
<thead>
<tr>
<th>Characteristic</th>
<th>On-Target</th>
<th>Worst-Case</th>
</tr>
</thead>
<tbody>
<tr>
<td>Average - Minimum:</td>
<td>4</td>
<td>3.96</td>
</tr>
<tr>
<td></td>
<td>Maximum:</td>
<td>4.04</td>
</tr>
<tr>
<td>Standard Deviation:</td>
<td>0.013333</td>
<td>0.013333</td>
</tr>
<tr>
<td>Cp:</td>
<td>2.50</td>
<td>2.50</td>
</tr>
<tr>
<td>Cc:</td>
<td>0.00</td>
<td>0.40</td>
</tr>
<tr>
<td>Cpk:</td>
<td>2.50</td>
<td>1.50</td>
</tr>
<tr>
<td>Def. Rate (normal):</td>
<td>6.38 10^-8 dpm</td>
<td>3.37 dpm</td>
</tr>
<tr>
<td>Z-Score:</td>
<td>7.41</td>
<td>4.50</td>
</tr>
<tr>
<td>Sigma Level:</td>
<td>7.41</td>
<td>6.00</td>
</tr>
</tbody>
</table>

*Interval for Values = (3.92, 4.08) +/-3SD*

The resulting process tolerance calculated for overall height is from 3.92” to 4.08”. This meets the specification limits for overall height. The process tolerance falls between the worst-case and statistical tolerances and is more representative of what will actually occur in production.

Process tolerances are obtained by specifying requirements for the processes that produce the components rather than for the individual components. Process tolerances are specified by giving a minimum average, a maximum average and a maximum standard deviation. They do not assume that the standard deviation is zero nor do they assume that the process is perfectly centered. To see how a process tolerance was specified for D1, click on D1 in the *I/O System* window. The dialog box shown below is displayed.

In the example above, it was specified that the average height must be in the range 1" ± 0.01". It was also specified that the standard deviation must be less than or equal to 0.006667". This was done by specifying a standard deviation equal to 1/9 the width of the tolerance and an operating window for the average of ± 1.5 standard deviations. The three normal curves in the graphic represent the minimum average, on-target average and maximum average all with the maximum standard deviation. This results in the same overall tolerance for the individual components as before, namely 1.00" ± 0.03".
For the specified process tolerances for the individual components, it can be determined that the average overall height will remain between 3.96" and 4.04" and that the standard deviation for overall height will be at or below 0.013333". Extending the interval for the average 3 standard deviations in either direction results in a tolerance for overall height of 3.92" to 4.08". So long as the process producing the components meets the process tolerance, overall height is guaranteed to be within the specification limits. This falls between the 4 ± 0.12 from worst-case tolerancing and 4 ± 0.06 from statistical tolerancing. Like worst-case tolerancing, process tolerancing is safe. However, process tolerancing is much less expensive.

A Unified Approach to Tolerancing

Process tolerancing is much more than simply a third approach to tolerancing. It represents a unified approach to tolerancing that combines both of the previous approaches. Worst-case tolerances are special cases of process tolerances where the standard deviation is zero. Statistical tolerances are special cases of process tolerances where the minimum average and maximum average are set equal to the target. Neither of these two special cases is very realistic. Using process tolerances, you are no longer forced to make a choice between worst-case tolerances with its increased costs or statistical tolerances with its increased risks.

With VarTran you can also use a combination of all three approaches. You can specify worst-case tolerances for environmental variables and usage conditions over which you have no control. You can specify statistical tolerances for machine parameters that are controlled using automatic controllers to ensure they remain centered. You can also specify process tolerances for components from a supplier where you can not guarantee that the process remains perfectly centered. With VarTran, you can choose the appropriate type of tolerance for each input. No longer are you forced to treat all inputs the same.
VarTran is not restricted to performing tolerancing on just stack-up problems. It can perform all three methods of tolerancing for any equation, including complex nonlinear equations. This allows one to perform tolerancing on problems impossible to solve by hand and for which the tolerance stack-up formulas do not apply. The pump and heat seal tutorials serve as two examples.
2.4 VarTran as a Mathematics Package

For a demonstration of VarTran's mathematical capabilities, start VarTran and open the file `math.vta`. This is accomplished by selecting the Open... menu item from the File menu. Highlight `math.vta` and then click on the OK button.

The I/O System window shown below is displayed. There is one output variable f shown on the right of the window. The output is the function of two inputs variables x and y. These are shown on the left of the window. This represents a function f in two parameters x and y.

The equation for f is shown below. This dialog box is displayed by double clicking on the box labeled f in the previous window. Close this dialog box by pressing the OK button.

In tolerance analysis, inputs have behaviors described by the tolerances selected. These tolerances describe a range of possible values. In a mathematical analysis, inputs have a
single value. This can be represented in VarTran by a worst-case tolerance of width zero as shown below. To display this dialog box, double click on x in the I/O System window

![Continuous Input Variable Dialog Box]

The values of the inputs can be viewed in the Summary Tables window. Initially both values are set to zero.

![Variables – Summary Tables]

<table>
<thead>
<tr>
<th>Input</th>
<th>Type</th>
<th>Tolerance / Category</th>
</tr>
</thead>
<tbody>
<tr>
<td>x</td>
<td>Constant</td>
<td>0 +/- 0</td>
</tr>
<tr>
<td>y</td>
<td>Constant</td>
<td>0 +/- 0</td>
</tr>
</tbody>
</table>
When constant values are entered for the inputs, performing a capability study amounts to evaluating the function. To display a capability study, double click on the *Capability Study* button on the toolbar. When x and y are zero, the function is equal to 1. Leave the *Capability Study* window open.

VarTran can be used to obtain line, interaction and contour plots of this function. One such contour plot is shown below. This contour plot shows that this function has numerous local minimums and maximums.

To generate your own plots, click on the *Plot* button on the toolbar. This displays the *Plots* dialog box shown on the next page. Try selecting the different types of plots. To copy a plot to a separate window, click on the *Window* button. Close the dialog box by pressing the *Close* button.
To find the maximum and minimum values of $f$, click on the Find Optimal Targets button on the toolbar. This displays the Find Optimal Targets dialog box shown below. Initially, this dialog box is set to maximize the value of $f$. Click on the Optimize Using Interval button to start the optimization.
Once the optimization is completed, close the dialog box by clicking the Close button. The maximum value will now appear in the Capability Study window. The settings of the inputs that result in the maximum are displayed in the Summary Tables window. If a red X appears in these windows, click on them to update them. The function $f$ is maximized when $x=0.9082$ and $y=-0.73633$. Its maximum value is 4.0619. Try resetting the inputs and repeating the optimization. You get the same answer every time. The Interval optimization routine is never fooled by local maximums.

Try minimizing $f$ as well. The function $f$ is minimized when $x=0.48828$ and $y=0.71094$. Its minimum value is -2.2202. Try repeating the optimization. Again, the optimization routine is never fooled by local minimums. Most optimization routines have difficulties with functions containing local minimums and maximums.

VarTran has extensive mathematical capabilities including a novel new method of optimization based on interval analysis. However, it differs from traditional math packages in the way that it handles the input variables. In most math packages, input variables represent values. These values are used to calculate the value of the function (output variable). In VarTran, the input variables represent behaviors. For example, an input variable might be assigned a statistical distribution (statistical tolerance) or an interval that its value must fall within (worst-case tolerance). VarTran then determines how the function or output variable will behave. When dealing with products and processes, this represents the difference between how the product or process performs in theory (value) versus how it will perform in practice (behavior).
3.1 Optimization & Variation Reduction

The goal is to optimize the product/process performance and to reduce its variation. There are two parts to this objective: (1) optimization of the average, i.e., drive the average to its ideal value and (2) reduction of the variation. This goal is shown below.

The above figure shows what is called the “Closer to Target the Better” case. An example of this case is fill volume. The target represents the ideal value. There are also upper and lower specification limits since we are guarding against both high and low fills. In this case, optimization of the average means to center the average on target.

A second case, shown below, is called the “Larger the Better” case. Seal strength is an example. In this case the ideal value is as large as possible or infinity. There is only a lower specification limit guarding against low values. In this case, optimization of the average means to maximize the average.
A third case, shown below, is called the “Smaller the Better” case. An example is harmful emissions. In this case the ideal value is zero. There is only an upper specification limit guarding against high values. In this case, optimization of the average means to minimize the average.

Optimization of the average can mean to maximize the average, minimize the average or to center it at target. In all cases, the variation should also be reduced. Otherwise some product can be outside the specification limits.

VarTran is based on the input/output system model. The I/O system could be a product like a pump. The output might be flow rate. The inputs could be piston radius, stroke length, motor speed and valve backflow. The I/O system could also be a process like a heat sealer. The output might be seal strength. The inputs could be time, temperature, pressure and material thickness.

It is the outputs for which optimization and variation reduction is desired. The variation of the outputs is caused by variation of the inputs. Optimization and variation reduction of the outputs is accomplished by identifying the key input variables and determining proper controls including targets (nominal) and tolerances (process windows). Further information can be found in the book *Optimization and Variation Reduction in Quality*; Taylor (1991). Much of the material in this chapter is borrowed with permission from this book.
3.2 The Importance of Reducing Variation

Why reduce variation? The obvious answer is to reduce the number of defectives as shown below.

Reducing Variation Results in Fewer Defects

Now assume we have achieved the right-hand picture above. Are there additional benefits from reducing the variation further? The answer is yes. Further reduction of the variation results in a wider operating window as shown below. The left-hand process only makes good product if the process is close to being perfectly centered. The right-hand process makes good product if the process average is anywhere in the center half of the specification limits. Operating windows are important if one wants to consistently make good product.

Reducing Variation Results in Wider Operating Windows
There is another reason for continuing to reduce variation. We frequently view specification limits as goal posts. Units of product inside the specification limits are perfectly good. Units of product outside the specification limits are bad. It does not matter where the product falls within the specification limits so long as it is within the limits. That is all that counts.

![Goal Post Model for Specification Limits](image1)

Your customers may view it differently. They may find it hard to distinguish between a “good” unit barely inside the specification limit and a “bad” unit barely outside the specification limit. The customer is more likely to notice the difference between a unit that is right on target and one that is near the specification limits. Customers are more likely to view your product in terms of the Taguchi loss function shown below. According to the Taguchi loss function, the further the product deviates from the ideal value, the greater the loss associated with it. In this case, reducing the variation results in more units closer to the ideal value. The customer views this as a higher quality product. Units barely within spec, while they might function initial, could fail early in the life of the product (latent defect).

![Taguchi Loss Function](image2)

The goal post model and the Taguchi loss function are models. Neither one might perfectly fit your particular product. However, more products more closely fit the Taguchi loss function than the goal post model.
3.3 How to Reduce Variation

So how do we reduce the variation of the outputs? Variation of the outputs is caused by variation of the inputs. As shown below, variation of the inputs is transmitted to the output through the functional relationship between the inputs and the output. This is called transmission of variation.

One way of reducing variation is to reduce the variation of the inputs. This amounts to tightening the tolerances of the inputs.
While all the key inputs contribute to the variation, they generally do not contribute equally. Applying the Pareto principle, 80% of the variation is due to 20% of the inputs. As a result, 1 or 2 of the key inputs are responsible for most of the variation.

Those key inputs that make significant contributions to the variation of the output will be referred to as Variation Inducing Parameters (VIP's). When tightening tolerances, only tightening the tolerances of the VIP's does any good. Other tolerances should be set to their low-cost values, i.e., based on the low-cost materials and processes. The VIP's are the limiting factors of the process. They prevent the process from performing better. It is important to identify the VIP's. Otherwise one is forced to specify tight tolerances for all inputs or to resort to trial and error.

Effects of Tightening the Tolerances of the VIPs and the Other Inputs
Tightening tolerances is not the only way of reducing variation. A second approach is to design the product or process to be less sensitive to the variation of the inputs. The figure below shows how the target of an input can be adjusted to reduce the amount of transmitted variation. Reducing the variation by adjusting targets is called robust design. Changing targets is generally less costly than tightening tolerances. It may cost nothing. As a result, robustness is generally the preferred approach to reducing variation.

Reducing Variation by Adjusting Targets of Input Variables

There is a third way of reducing variation. This is to change the design concept. For example, instead of designing a pump using a piston to move the solution, you might decide to use roller bars to push the solution through a tube. This results in a different set of inputs and a different relationship between the inputs and outputs. The figure below summarizes the three approaches to reducing variation.
3.4 Robustness

The concept of robustness was introduced by Taguchi (1986). It is such an important concept it requires further discussion. Robustness reduces the variation of the output by making the output less sensitive to the variation of the inputs. As a result, the inputs can continue to vary but less of this variation is transmitted to the output. As shown below, robustness is achieved by identifying targets for the inputs were the slope is shallow. Shallow slopes mean less sensitivity, less transmitted variation and more robustness. Steep slopes mean increased sensitivity, more transmitted variation and less robustness.

Opportunities for achieving robustness abound. We have a product, a process and materials. Each can be designed to be robust to the others. In addition, all can be designed to be robust to the usage conditions and environment as well as to wear and deterioration of the components and materials.
You can design the product to be robust to its components and materials. For example, in the pump tutorial, the pump was designed to be robust to motor speed. Besides improving quality, this allows the use of less expensive components.

You can design the product to be robust to the process. Taguchi gives an example where there is excessive warping of tiles due to a large temperature gradient across the drying oven. One solution is to reduce the temperature gradient, which requires a large capital investment. However, the solution actually implemented was to reformulate the tiles to make them less sensitive to the temperature gradient. As a result, quality was improved without a large expenditure. This allows the use of less expensive processes.

You can design the product to be robust to wear and deterioration of its components. For a car door, closure force is an important characteristic. Closure force is highly dependent upon the strength of the spring used. As the spring deteriorates over time, the closure force will change. When the car is 5 years old, we would still like the door to open and close with ease. One solution is to use a more expensive spring that deteriorates less. Another solution is to design the hinge to be less sensitive to the spring deterioration. This results in smaller changes in the closure force as the spring deteriorates. The effect is the same. Robustness to wear and deterioration results in more reliable products and processes.

You can design the product to be robust to usage conditions and the environment. Suppose one is designing a copy machine. The user would like to use a variety of different weights of papers as well as different materials such as transparencies. If excessive variation in copy darkness results from changes in the weight of the paper, the customer will complain. The designer cannot tighten the tolerance for paper weight because it is based on the customers’ requirements. Robustness can be used to solve this problem. The trick is to find an input whose target you can adjust that interacts with the weight of the paper. An interaction is where adjusting one input changes the effect that the other input has on the output. The figure below shows how adjusting arm gap from 0.10” to 0.11” can make the product robust to the weight of the paper. Through interactions, you can design your product or process to be robust to inputs that you cannot control.
You can design the process to be robust to materials and components. On an injection molding machine, the melt point of the material has a large impact on part quality. By adjusting zone temperatures, pressures and times, the injection molder can be set up to be robust to the melt point. This results in fewer process adjustments as the material changes. Robustness can be used to make processes easier to control.

You can design a process to be robust to itself. In the heat sealer tutorial, it was determined that the primary cause of the seal strength variation was dwell time variation. By adjusting the hot bar temperature and dwell time, the process was made robust to the dwell time variation. This resulted in less variation and higher quality. By achieving maximum performance from your processes it can also result in fewer capital expenses.

You can design a process to be robust to the environment. Suppose you are manufacturing gloves. By identifying the proper temperatures and line speed, the glove line can be setup so that is robust to daily fluctuations in room temperature and room humidity. This results in fewer process adjustments as the room conditions change.

You can design a material or component that is robust to itself. In rubber compounds, an important characteristic is elongation. When mixing batches of the compound, there will be variation in the amount of the ingredients added. As a result, the elongation will vary. Targets should be selected that makes elongation insensitive to variations in the amounts of the ingredients.

You can design a material or component that is robust to the environment. Temperature often has an effect on the strength of a plastic. When formulating the plastic, targets should be selected for the ingredients that make the strength insensitive to fluctuations in temperature. This results in a more reliable product, i.e., one less likely to encounter conditions under which it will fail.

The potential applications of robustness are endless. Besides improving quality, robustness allows the use of less expensive components and processes, improves reliability, increases the range of conditions under which the product or process can operate successfully, reduces capital expenses and makes a process easier to operate.

Almost all products and processes can be made robust. So long as nonlinear effects like squared, square root, log and trigonometric terms exist or so long non-additive effects like multiplication, division and power exist, robustness is possible. The only equation for which robustness is not possible is one of the form:

$$b_0 + b_1 x_1 + b_2 x_2 + b_3 x_3 + \ldots$$

where the $b_i$'s are constants and the $x_i$'s are input variables. This type of equation is generally limited to dimensional stack-up problems. In a dimensional stack-up problem you might be interested in controlling the overall height of a product where the overall height is the sum of the heights of the components. In all other cases, robustness can be used to improve quality and reduce costs.
3.5 Variation Transmission Analysis

So how does one optimize and reduce the variation of a product or process? By setting targets and tolerances for the inputs. This is a 2-step process. First, starting with the low cost tolerances, the optimal targets are identified. The effects of the targets on both the average and variation are considered when finding the optimal targets. This reduces the variation resulting in a robust design. The second step is to tighten tolerances to achieve the desired performance. The trick is to only tighten those tolerances necessary and only to the degree necessary to meet the customer requirements. The result is high quality and low cost.

Before you can use this 2-step process, you first have to gather some information. First you must identify the output variables of concern. Next you need to determine which inputs affect these outputs. Then you must gather the following information about these variables:

1. The target and specification limits for the output variables. These are the customer requirements that must be met.
2. A standard deviation and initial target and for each of the input variables. These can be obtained by performing capability studies on the inputs. This information describes how the inputs behave.
3. Equations describing the effects of the inputs on the outputs. In some cases these equations can be derived or are available in books or articles. However, in other cases, designed experiments will be necessary to empirically fit equations. This information describes how the inputs affect the outputs.

As shown below, if you know how the inputs behave and you know how the inputs affect the outputs, you can predict how the outputs will behave. Such an analysis will be referred to as a Variation Transmission Analysis from which the name VarTran is derived.

Variation Transmission Analysis

One method of predicting the behavior of the output is to perform a simulation. While VarTran can perform such simulations, it is also capable of much more powerful analytic methods allowing alternate designs to be quickly evaluated and the optimal design selected.
3.6 Behavior of the Inputs

If you know how the inputs behave and you know how the inputs affect the outputs, you can predict how the outputs will behave. The behaviors of the inputs are described using tolerances. More than one way exists to describe the behaviors of the inputs. This section explores three different approaches called worst-case, statistical and process tolerances.

Tolerances are typically given in the form of an interval. For example, it might be specified that the tolerance for piston radius is $0.1 \pm 0.003"$. This means that the radius should be between $0.097"$ and $0.103"$. A unit exceeding this tolerance is called a defective unit. These limits represent the limits for individual values and will be denoted by LIV (lower end interval for values) and UIV (upper end interval for values) respectively. While a standard notation exists for expressing tolerances, the interpretation of these tolerances can vary greatly.

### 3.6.1 Worst-Case Tolerances

For a worst-case tolerance, you must specify three values: the target ($T$), delta upper ($\Delta_+$) and delta lower ($\Delta_-$). In the above example, $T = 0.1"$ and $\Delta_+ = \Delta_- = 0.003"$. The upper and lower ends of the interval for values are determined as follows:

$$\text{UIV} = T + \Delta_+ = 0.103"$$
$$\text{LIV} = T - \Delta_- = 0.097"$$

Worst-case tolerances are represented by the symbols shown below.

![Worst-Case Tolerance](image)

Worst-case tolerances are interpreted as meaning that the input can take any value over the specified range.

### 3.6.2 Statistical Tolerances

A statistical tolerance is specified using two values: the target ($T$) and the standard deviation ($\sigma$). The upper and lower intervals for individual values are determined by adding and subtracting a specified number of the standard deviations from the target. Traditionally, 3 standard deviations is used. For piston radius, you might specify $T = 0.1"$ and $\sigma = 0.001"$. The upper and lower ends of the interval for values are then determined as follows:

$$\text{UIV} = T + 3\sigma = 0.103"$$
$$\text{LIV} = T - 3\sigma = 0.097"$$
Based on the normal curve, 99.73% of the units will fall within $\pm 3\sigma$ of the average. One can use values other than 3 for calculating the upper and lower tolerances. In VarTran, the default value is 4.5. In this case, only 6.8 units per million fall outside the interval for values.

Statistical tolerances are represented by the two equivalent drawing symbols shown below. The symbol $\sigma$ is used to indicate the tolerance is a statistical tolerance. Optionally an informational box can be added providing clarification. It is recommended that one specify either the standard deviation of the capability index $C_p$ in an information box so that there is no confusion about the interpretation of the statistical tolerance.

### Drawing Symbols for Statistical Tolerances

0.01” +/- 0.003” $\sigma \leq 0.001$  
0.01” +/- 0.003” $C_p \geq 1$

The above statistical tolerances are interpreted as meaning that the average radius is 0.1” and that the individual parts vary around this average with a maximum standard deviation of 0.001”.

### 3.6.3 Process Tolerances

Instead of specifying requirements for individual units of products, a process tolerance specifies requirements for the process producing the product. A process tolerance consists of a minimum and maximum average and a maximum standard deviation. These are specified using four parameters: the target ($T$), delta upper ($\Delta_+$), delta lower ($\Delta_-$) and the maximum standard deviation ($\sigma$). Process tolerances are interpreted as meaning that the average must be in the interval $[T-\Delta_-, T+\Delta_+]$ and that the standard deviation must be below $\sigma$.

For piston radius, suppose that $T = 0.1”$, $\Delta_+ = 0.001”$, $\Delta_- = 0.001”$ and $\sigma = 0.0067”$. The upper and lower ends of the interval for the average are then:

- UIA = $T + \Delta_+ = 0.101”$
- LIA = $T - \Delta_- = 0.099”$

This process tolerance is shown below. The two normal curves represent the maximum variation at the minimum and maximum averages.
Process Tolerance

The upper and lower ends of the interval for individual values can be determined as follows:

\[ \text{UIV} = T + \Delta_k + 3\sigma = 0.103" \]
\[ \text{LIV} = T - \Delta_k - 3\sigma = 0.097" \]

Process tolerances are represented by the two equivalent drawing symbols shown below. The symbol ST is used to indicate the tolerance is not a worst-case tolerance. An informational box must be added providing clarification. One should specify either an interval for the average or the capability index \( C_c \) in an information box. One should also specify either the maximum standard deviation or the capability index \( C_p \).

\[ \text{0.01" } +/- \text{ 0.003" } \underline{\Delta \mu \leq 0.001, \sigma \leq 0.00067} \]

\[ \text{0.01" } +/- \text{ 0.003" } \underline{C_c \leq 1/3, \ C_p \geq 1.5} \]

Drawing Symbols for Process Tolerances

A process tolerance is like a statistical tolerance but with an operating window for the average added. A process tolerance is also like a worst-case tolerance but with the worst-case conditions defined in terms of process conditions rather than for individual units of product.

Process tolerances are much more than simply a third approach to specifying tolerances. Process tolerances represent a unified approach to tolerancing that encompasses both worst-case and statistical tolerances. A process tolerance with \( \sigma=0 \) is in effect a worst-case tolerance. Worst-case tolerances guard against the event that all units are at the same extreme value. This is unlikely if not impossible when variation is present.

A process tolerance with \( \Delta \mu=0 \) is in effect a statistical tolerance. Statistical tolerances assume that the process is perfectly centered, i.e., that no operating window is required.
Again this is unlikely if not impossible in most situations. Process tolerancing allows more realistic tolerances to be developed. Further comparisons will be made in Chapter 5.

An important benefit of process tolerancing is the flexibility that it allows in specifying the behavior of the inputs. Traditionally you had to select between using worst-case tolerances or statistical tolerances for all inputs. With VarTran you can select worst-case tolerances for some inputs, statistical tolerances for others and process tolerances for the rest.

### 3.6.4 Which Type of Tolerance Should I Use?

Worst-case tolerances should be specified for environmental inputs. For example, suppose that one factor affecting the flow rate of a pump is usage temperature. An advertising claim is made that the pump's flow rate is between 9 and 11 ml/min over a temperature range of 40°F to 125°F. A worst-case tolerance should be specified for usage temperature such as 75 -35 +50 °F. This ensures all pumps operate in very hot and very cold environments.

Statistical tolerances are frequently used for machine parameters that are automatically controlled. For example, suppose that one input affecting seal strength of a heat sealer is die temperature. A strip chart of die temperature indicates that the temperature averages 150°F with a standard deviation of 5°F. A statistical tolerance based of this information could be specified for die temperature. The automatic controller ensures continual centering of the process.

Process tolerances are frequently used for components and manually controlled processes. Suppose a supplier is being considered for the pistons in a pump. A capability study indicates that the radius of the supplier's pistons average 0.1” with a standard deviation of 0.0005”. Specifying a statistical tolerance based on these values would only be appropriate if all future lots have the same average. However, in reality, the average of each lot will be slightly different. An allowance for an operating window needs to be made. One approach is to specify the process tolerance T = 0.1”, Δ⁺ = 1.5σ, Δ⁻ = 1.5σ and σ = 0.0005”. This amounts to allowing a ±1.5σ operating window for the average. This approach sets a clear requirement on the average that can be inspected for or enforced using a control chart. It is appropriate to use a value of 1.5σ for stable processes and processes controlled using a control chart. A larger operating window should be used if the process is unstable. A narrower operating window may be achievable using online controllers.

Process tolerances can also be used to account for product wear. Suppose a car door hinge is being designed and that one input variable is the spring force of the spring. A capability study of springs from a supplier indicates an average of 10 lbs. with a standard deviation of 0.2 lbs. Life testing of the springs predicts that the springs will weaken by 1 pound over a five-year period. Specifying a process tolerance of T = 10, Δ⁺ = 0, Δ⁻ = 1 and σ = 0.2 describes both the manufacturing variation and the variation over time due to deterioration of the springs.

The purpose of a tolerance analysis is to accurately predict the behavior of the output. This requires accurate descriptions of the behaviors of the inputs. Not all inputs behave the same.
Some inputs are best described using statistical tolerances. Other inputs are best described using worst-case tolerances. Some inputs don’t adequately fit either of these two behaviors and are better represented with process tolerances. VarTran allows you to mix all these different behaviors. The type of tolerance specified for each input should be that which best describes its behavior. When specifying the tolerances of the inputs, be sure to include variation due to manufacturing and materials, variation due to wear and deterioration and variation due to usage and environmental conditions. This helps to ensure that all units of product perform as required over their entire useful life and under all conditions they might encounter.

### 3.7 Robust Tolerance Analysis

VarTran you can set targets and tolerances on the inputs to optimize average and reduce the variation of the outputs. It is recommended you use the strategy below called a Robust Tolerance Analysis. A Robust Tolerance Analysis is a systematic approach to setting targets and tolerances for the inputs to achieve a specified level of quality at the lowest possible cost. The process involves:

- Determining the key outputs and their specifications, the key inputs and their low cost tolerances and the relationship between the inputs and outputs (This is the information that must be entered into VarTran to perform an analysis).
- Find the optimal targets starting with the low-cost tolerances to achieve a robust design (use Find Optimal Targets dialog box in Section 6.1).
- Determine if the capability meets specified level of quality (perform capability study per Section 5.1).
- If not, determine cause of variation and tighten its tolerance (perform Pareto chart of variation per Section 7.1).
- Repeat previous 3 steps until the specified level of quality is achieved

Key to this process is gathering good information on the behavior of the inputs and the effects of the inputs on the outputs. Capability studies can be used to study the behavior of the inputs. Equations describing the effects of the inputs on the outputs can always be obtained using designed experiments. While gathering all this information takes time, without such knowledge, one is reduced to trial and error. With this information, mistakes can be avoided and the time to market reduced.

Starting with the low cost tolerances helps to ensure the design’s manufacturability. The use of robust design methods and the selective tightening of tolerances only when necessary reduces costs. The result is high quality and low cost. Further, design issues are found earlier in the design process resulting in fewer design iterations. This speeds up time to market.
This section describes how to enter information into VarTran. It also describes how to display this information, print it, edit it, save it and restore it.

4.1 Main Window

When the program is first started, the main window shown below is displayed. The main window consists of from top to bottom: the caption bar, the menu bar, the toolbar, the interior containing the I/O System window and the status bar.

Caption Bar: The caption bar contains the program name and the name of any associated file. When the program is not maximized to cover the entire screen, dragging the caption bar moves the window. Double clicking on the caption bar maximizes/restores the window. On the left of the caption bar is the system menu button . Clicking this button displays the system menu containing items to move, size, and close the window. The program can also be closed by double clicking on this button. On the right of the caption bar are the minimize button , the maximize/restore button , and the close button .

Menu Bar: The menu bar provides a list of drop-down menus containing menu items. These menu items serve as the primary means of telling the program what to do. Menu items exist for adding variables, performing analysis, printing the results and much more. Chapter 10 gives a complete description of all the menus.
**Toolbar:** The toolbar contains buttons serving as shortcuts for the most commonly used menu items. To see what a particular button does, hold the mouse cursor over the top of the button. A description of the button will appear.

**Interior:** The interior initially contains the \textit{I/O System} child window. Later we will encounter other child windows that can also be displayed in the interior. If a child window extends outside the interior of the main window, scroll bars are provided for shifting the child windows up/down and left/right.

**Status Line:** The status line is at the bottom of main window. It contains a description of the current status of the session. If there are input errors, the status line will initially display a list of the variables containing errors. Handling errors is covered in Section 4.3.

A sizing border surrounds the window except when the main window is maximized. Dragging the border causes the window to be resized.

### 4.2 Adding Variables

The first step is to add the different variables. Begin by clicking the \textit{Add Variable} button on the toolbar. This button serves as a short cut to selecting the \textit{Add Variable...} menu item on the \textit{Variables} menu.

Both cause a menu to appear for specifying the type of variable to add. Selecting a variable type will display a dialog box for entering further information about the variable. This process must be repeated for each variable.

Four types of variables are available: continuous input variable, categorical input variable, output variable and objective function. Continuous input variables are inputs that can be adjusted over a continuous scale. Examples include temperature, length and viscosity. Category input variables are inputs that are restricted to specific levels. One example is cavity where the only possible values are 1, 2, 3 and 4. Another example is material with levels A and B. Output variables are outputs such as flow rate and seal strength. Objective functions combine several outputs into a single desirability function which can be optimized. An example is “Minimum \([O1\{Cpk\}, O2\{Cpk\}]\)” where O1 and O2 are output variables.

Once the variables have been added, it is a good idea to save the data immediately. Do this by selecting the \textit{Save} menu item from the \textit{File} menu.
4.3 Continuous Input Variables

A continuous input is an input that can be adjusted over a continuous scale. Examples include dwell time and temperature on a heat seal machine and stroke length and motor speed on a pump. When a continuous input variable is added, a Continuous Input Variable dialog box like the one shown below is displayed. This dialog box is used to enter and change information concerning the continuous input variable.

The Symbol edit box is used to enter the symbol. The variable’s symbol is used to represent the variable in equations. Each variable must have a unique symbol. It can be of any length but is best limited to 3 characters or less. The symbol must consist of letters, the digits 0-9 and underscores. It cannot begin with a digit. Some examples of valid symbols are: A, _1, A1 and A_1. 1A and 1_ are not valid symbols because they begin with a digit. A*B is not a valid symbol because it contains an illegal character. A B is not a valid symbol because it contains an embedded blank which is an illegal character.
The **Name edit box** is used to enter a more detailed name or description of the variable. It can contain any characters and be of any length. While the symbol should be short, the name should be descriptive.

The **Units edit box** can optionally be used to enter the units of measure associated with this variable. It can be any combination of characters and any length.

The **xx.xx button** displays the popup menu to the right for specifying the number of digits to report for this variable. The default is five significant digits. You can choose between 2-12 significant digits and from 0 to 12 digits after the decimal point. When VarTran displays numbers, it discards trailing zeros.

### Tolerance Group Box

The **Target edit box** is used to specify the current target (or nominal). Capability studies, variation Pareto charts and simulations are all performed at the target. The target must be between the minimum and maximum targets specified in the *Optimizations Options for Target* group box. It must be a constant expression meaning it can include operators and functions but not variables. Some examples are: “1.5”, “2/3”, “1.4 10^-5” and “Log[30]”. Further information on expressions can be found in the glossary. To reference this field in other edit boxes, use the symbols Target or T.

The **Δ+ edit box** is used to specify the distance the tolerance extends above the target. It must be greater than or equal to zero. You can enter an expression that includes only the variables T or Target, both referring to the value entered into the Target edit box. Some examples are: “0.1”, “1/12”, “1.0 10^-5”, “Log[30]”, and “0.1 Target”. To reference this field in other edit boxes, use the symbol ToleranceDeltaUpper or TDU. The upper spec limit is equal to Target + TDU. To reference the upper spec limit in other edit boxes, use the symbols UpperSpecLimit or USL. For statistical and process tolerances, this field may generally be left blank.

The **Δ- edit box** is used to specify the distance the tolerance extends below the target. It must be greater than or equal to zero. You can enter an expression that includes only the variables T or Target. Some examples are: “0.1”, “1/12”, “1.0 10^-5”, “Log[30]”, and “0.1 Target”. To reference this field in other edit boxes, use the symbol ToleranceDeltaLower or TDL. The lower spec limit is equal to Target - TDL. To reference the lower spec limit in other edit boxes, use the symbols LowerSpecLimit or LSL. For statistical and process tolerances, this field may generally be left blank.

The **Type of Tolerance radio group** is used to specify whether the tolerance is a worst-case tolerance, statistical tolerance or process tolerance. If either a statistical or process tolerance is selected, a group box for specifying the variation is displayed. If a process tolerance is selected, a second group box for specifying an operating window for the average is displayed as well.
**Variation Group Box**

This section is only displayed for statistical and process tolerances. You must specify the distribution and the maximum standard deviation (σ). Other information might also be required depending on the distribution selected.

The **Distribution list box** is used to select the distribution of the individual units around the average. The normal distribution is the default distribution and is sufficient for most purposes. The full list of distributions is shown to the right. All these distributions are available for statistical tolerances. Those distributions with the “Fit to Spec” designation cannot be used with process tolerances.

To see what the different distributions look like, select the distribution and view the results on the **Graphics** tab. Below are a few of the distributions.

### Distributions

- **Triangular (Fit to Spec)**
- **Uniform (Fit to Spec)**
- **Uniform Minus Center 50%**
- **Normal**
- **Lognormal**
- **Negative Lognormal**

The “Fit to Spec” distributions determine their parameters from the upper and lower spec limits. When one of these distributions is selected, values must be entered in both the Δ+ and Δ- edit boxes. The width of the spec limits determines the standard deviation as follows:

<table>
<thead>
<tr>
<th>Distribution</th>
<th>Standard Deviation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Triangular (Fit to Spec)</td>
<td>0.20412 (USL – LSL)</td>
</tr>
<tr>
<td>Uniform (Fit to Spec)</td>
<td>0.28868 (USL – LSL)</td>
</tr>
<tr>
<td>Uniform Minus Center 25% (Fit to Spec)</td>
<td>0.33072 (USL – LSL)</td>
</tr>
<tr>
<td>Uniform Minus Center 1/3 (Fit to Spec)</td>
<td>0.34694 (USL – LSL)</td>
</tr>
<tr>
<td>Uniform Minus Center 50% (Fit to Spec)</td>
<td>0.38188 (USL – LSL)</td>
</tr>
<tr>
<td>Uniform Minus Center 2/3 (Fit to Spec)</td>
<td>0.41944 (USL – LSL)</td>
</tr>
<tr>
<td>Uniform Minus Center 75% (Fit to Spec)</td>
<td>0.43899 (USL – LSL)</td>
</tr>
</tbody>
</table>
For all the others distributions, the parameters of the distribution must be entered directly. All require that the standard deviation be entered. The lognormal and gamma distributions require that a second parameter be entered, namely a lower bound. The negative lognormal and negative gamma distributions require that an upper bound be entered. The beta distribution requires both a lower and upper bound.

In general, the distribution does not have much of an effect compared to the standard deviation. However, for the “Fit to Spec” distributions the standard deviation depends on the distribution. Therefore, changing distributions changes the standard deviation. Care should be taken when using these distributions to ensure the standard deviation fits the input. It is better practice to obtain an estimate of the standard deviation and use a distribution that allows the standard deviation to be entered. The “Fit to Spec” distributions are primarily intended for use as part of a preliminary analysis prior to obtaining good capability data on the inputs.

For the other distributions, the standard deviation must be specified. In this case, changing distributions from normal to uniform to lognormal will generally have little effect. The exception is when the input is limited by some bound. For example, piston radius is bounded below by zero. Either the lognormal or gamma distributions should be selected in the event of a lower bound. Otherwise, negative values could be generated for which the equation may not be defined. This can be especially troublesome when performing simulations.

The Standard Deviation edit box is used to enter a constant or expression for the standard deviation. This edit box does not appear if you selected one of the “Fit to Spec” distributions. You may enter any differentiable expression referencing the following variables: Target, T, ToleranceDeltaUpper, TDU, UpperSpecLimit, USL, ToleranceDeltaLower, TDL, LowerSpecLimit and LSL. Examples of valid entries for the standard deviation are:

\[
\begin{align*}
0 & \quad 0.01 & \quad 1/3 \\
\log_{10} & \quad 1/2 \, \pi & \\
0.03 \, \text{Target} & \quad 0.03 \, \times \, T & \quad (\text{USL} - \text{LSL}) / 12
\end{align*}
\]

The value or expression entered must be greater than or equal to zero for all values of the target between the minimum and maximum targets. To reference this field in other edit boxes, use the symbol "StandardDeviation" or "SD".

Clicking the Cp button displays a popup menu shown to the right for automatically entering various equations into the Standard Deviation edit box including equations to specify a Cp of 1, 1.5 and 2, and a CV of 1%. There are also menu items for specifying a Cp value or CV value. For the beta distribution, the standard deviation must also be below:

\[
\sqrt{\text{Max} - \text{Average}} - \text{Min}
\]

This condition must be satisfied for all averages in the interval from the minimum target to the maximum target. If process tolerances are specified, this interval must be expanded by the width of the operating window for the average.

1 For the beta distribution, the standard deviation must also be below:

\[
\sqrt{\text{Max} - \text{Average}} - \text{Min}
\]

This condition must be satisfied for all averages in the interval from the minimum target to the maximum target. If process tolerances are specified, this interval must be expanded by the width of the operating window for the average.
These two menu items insert equations for the standard deviation with an 'X' at the place to insert the value. Finally, there is also a menu item to specify Six Sigma quality which sets the tolerance type to process, $C_p = 2$ and $C_c = 1/4$.

The **Min edit box** is used to enter a lower bound for the lognormal, gamma and beta distributions. This edit box is only displayed when one of these distributions is selected. Traditionally these distributions have a lower bound of zero. However, it can be modified to other values. These modifications are referred to as the three-parameter lognormal, three-parameter gamma and four-parameter beta distributions. The lower bound must be less than the minimum target specified in the optimization panel.

The **Max edit box** is used to enter an upper bound for the negative lognormal, negative gamma and beta distributions. This edit box is only displayed when one of these distributions is selected. Traditionally the beta distribution has an upper bound of one. However, it can be modified to other values. This modification is referred to as the four-parameter beta distribution. The upper bound must be less than the maximum target specified in the optimization panel.

If bounds exist, not specifying them can lead to erroneous results. To see why, consider the case where $Y = \text{SquareRoot} \ [X]$ and $X$ has a normal distribution with a target (average) of 3 and a standard deviation of 1. Performing a simulation will eventually result in the random number generator generating a negative value for $X$ causing an error in calculating $Y$. When this happens, the program will not be able to print any simulation results.

### Average Group Box

This section is only displayed for process tolerances. It is used to specify an operating window for the average. The average must stay within the interval $(\text{Target} - \text{AverageDeltaLower}, \text{Target} + \text{AverageDeltaUpper})$.

The **Average Delta Upper edit box** is used to enter the maximum amount that the average can be above the target. You may enter any differentiable expression referencing the variables `Target`, `T`, `ToleranceDeltaUpper`, `TDU`, `UpperSpecLimit`, `USL`, `ToleranceDeltaLower`, `TDL`, `LowerSpecLimit`, `LSL`, `StandardDeviation` and `SD`. Examples of valid entries are:

- $0 \ 0.01 \ 1/3$
- $1/2 \pi \ [] \ 0.25 \ TDU \ (USL-LSL)/8$
- $0.01 \ \text{Target} \ 0.03 * \ T \ 1.5 \ \text{StandardDeviation}$

The value or expression entered must be greater than or equal to zero for all possible values of the target between the minimum and maximum specified in the optimization panel.

The **Average Delta Lower edit box** is used to enter the maximum amount that the average can be below the target. Its requirements are then same as the **Average Delta Upper edit box**.
Clicking the **Cc button** displays a popup menu shown to the right for automatically entering various equations into the *Average Delta Upper* and *Average Delta Lower* edit boxes including equations to specify a Cc of 1/4, 1/3 and 1/2, and a +/- 1.5 standard deviation operating window. There is also a menu item to specify a Cc value. This menu item inserts equations for the Average Delta Upper and Average Delta Lower with an 'X' at the place to insert the value of Cc. Finally, there is a menu item to specify Six Sigma quality which sets the tolerance type to process, \( \text{Cp} = 2 \) and \( \text{Cc} = 1/4 \).

### Optimizations Options for Target Group Box

The group box is used to specify options for performing an optimization per the *Find Optimal Targets* dialog box covered in Section 6.1. The values entered do not affect the current design including the *Capability Study* and *Pareto Chart* windows.

The **Minimum and Maximum Target edit boxes** are used to specify limits for the target. They must be constant expressions. The minimum must be less than or equal to the maximum. There may be further restrictions depending on the distribution selected. Optimizations, effects tables and plots are all performed over the region specified by the minimum and maximum targets. The minimum and maximum may represent physical or practical limits. In event that a response surface study was used to obtain equations for the outputs, the minimum and maximum targets should be no wider than the region of study.

When the **Include in Optimizations check box** is checked, the target for this input will change when an optimization is performed using the *Find Optimal Targets* dialog box. When unchecked, the target for the input is not optimized. By default it is checked. Certain targets may not be adjustable in which case the check should be removed. Other inputs may have preferred values. By setting the input to its preferred value and removing the check, the product/process can be optimized for the preferred setting and the results compared to the overall optimum.

The dial control that appears in this group box shows the position of the target in the interval determined by the minimum and maximum targets. It can also be used to change the current target by double clicking on the desired value.
Graphics and Buttons

The 3-tabs represent pictorially the type of tolerance specified. The information on the first and third tabs is similar to that displayed for an output variable in a Capability Study window. For further information on interpreting the values, see Section 5.1 and the Glossary.

The middle tab displays how the tolerance would be represented on a drawing. The two equivalent forms are given.

To resize, print or copy these tabs, click the Options menu. This displays the popup to the right. An alternative is to right mouse click over the graphic.

To close the dialog box and save the changes, click the OK button. The symbol is checked to verify that it is valid and not already in use. If an error is encountered, a message is displayed.

To cancel the changes including the addition of a new variable, click the Cancel button, press the Esc key or click the X in the upper right corner of the dialog box. To delete the variable, click the Delete button. For help, click the Help button or press the F1 key.
**Updating Analysis and Reporting Errors**

When an edit box is exited or a new item selected from a combo box, all other windows are immediately notified of the change. Some windows such as the I/O System window, will immediately display the change. However, analysis windows will generally wait to update their results until the analysis window is selected by clicking on it. To show that the window is no longer current, a red X is drawn through it. For edit boxes, as long as the cursor remains in the edit box, no update is performed. The update occurs when the edit box is exited by using the tab key or clicking on another control.

If an error is made entering data for an input, an error message will be displayed on the status line. The status error message initially displays a list of variables with errors. However, when a variable dialog box like the Input Variable dialog box is opened, the status error message changes to a list of controls in that dialog box with errors. When a control is clicked on for which an error is reported, the status error message again changes to a description of what is wrong. In this way, errors can be quickly tracked down.

**Determining Which Type of Tolerance to Use**

The purpose of a tolerance analysis is to accurately predict the performance of the output. Key to this goal is to accurately describe the behaviors of the inputs. However, not all inputs behave the same. Some are uncontrolled environmental variables while others may be carefully controlled including close-loop feedback to keep them on target. For this reason neither worst-case nor statistical tolerances are adequate on their own. VarTran’s ability to do a process tolerance analysis allows it to combine these two approaches and to cover behaviors not adequately captured by either. This added flexibility will allow more accurate predictions of the output’s behavior to be made.

For each input separately, we must decide which type of tolerance to use. Our choice will be based on which best describes the behavior of the input. Three examples follow.

**Example 1: Manufactured Component**

Suppose you are designing a pump and must specify a tolerance for piston radius. A capability study was run on the piston radius, which resulted in an estimated standard deviation of 0.0005”. Since the radius has a lower bound of zero, the lognormal distribution was selected. Because this is a manufactured component, an operating window should be allowed. The capability study indicates that the process is stable. Therefore a ±1.5σ operating window is sufficient.

The target was initially set to 0.1. However, this can be changed so the Include in Optimization check box is checked. Zero was specified for the minimum target since a negative radius is impossible. The maximum target was set to 1 since at this point the pump is getting larger than desired. The Input Variable dialog box appears as on the next page:
Example 2: Usage Environment Input

Suppose one factor effecting flow rate of a pump is the usage temperature. An advertising claim is made that the pump’s flow rate will be between 9 and 11 ml/min over a temperature range of 40 °F to 125 °F. A worst-case tolerance should be used to ensure the pumps give the desired performance at each temperature in this range. In addition, the Include in Optimization check box should be unchecked to prevent the target from being changed during optimizations. The Input Variable dialog box appears as below:
Example 3: Machine Parameter

A factor affecting seal strength of a heat seal machine is temperature of the hot bar. The heat sealer continuously monitors hot bar temperature and automatically adjusts it. This ensures the temperature remains centered. A record of hot bar temperature is printed out in the form of a strip chart. Using this chart, the standard deviation of hot bar temperature is estimated to be $5^\circ\text{F}$. A statistical tolerance is appropriate since the process remains centered.

The target was initially set to 150. However, this can be changed so the *Include in Optimization* check box is checked. A designed experiment was used to fit an equation for seal strength. The minimum and maximum targets for hot bar temperature were set to the limits of the study region. The *Input Variable* dialog box appears as below:

These three examples demonstrate that all three types all tolerances have their applications.
4.4 Category Input Variables

A category input variable is an input variable that is restricted to specific choices or levels referred to as categories. One example is material type A and B. Types A and B represent the categories. Other examples are mold cavity 1, 2, 3 and 4, and vendor A, B and C.

When a category input variable is added, a Category Input dialog box like the one shown below is displayed. This dialog box is used to enter and change information concerning category input variables.

The **Symbol edit box** is used to enter the symbol. The variable’s symbol is used to represent the variable in equations. Each variable must have a unique symbol. It can be of any length but is best limited to 3 characters or less. The symbol must consist of letters, the digits 0-9 and underscores. It cannot begin with a digit.

The **Name edit box** is used to enter a more detailed name or description of the variable. It can be any combination of characters and any length. While symbols should be short, names should be descriptive.

The **Selected Category combo box** is used to select a category to use for the analysis. Optimizations, capability studies, Pareto charts, effects tables, plots and simulations are all performed for the currently selected category.

The **List of Categories list box** is used to display all categories and used to select categories for the edit and delete operations. To add a new category to this list, press the **Add Category button**. This displays the Add or Edit Category dialog box shown on the next page. To
change the symbol or name associated with a category, select the category and press the **Edit Category button**. This displays the *Add or Edit Category* dialog box below. To delete a category, select the category and press the **Delete Category button**. A prompt will appear to confirm that you want to delete the selected category.

Suppose the symbol for the category input variable is M and there are two categories Old and New. These are referenced as M{Old} and M{New} in an equation. When New is the selected category, the symbol M{New} has value 1 and M{Old} has value 0.

To close the dialog box and save the changes, click the **OK** button. The symbol is checked to verify that it is valid and not already in use. If an error is encountered, a message is displayed.

To cancel the changes including the addition of a new variable, click the **Cancel** button, press the *Esc* key or click the X in the upper right corner of the dialog box. To delete the variable, click the **Delete** button. For help, click the **Help** button or press the F1 key.

When an edit box is changed, new category is selected, or a category is added, edited or deleted, all other windows are immediately notified of the change. Some windows such as the *I/O System* window, will immediately display the change. However, analysis windows will generally wait to update their results until the analysis window is selected by clicking on it. To show that the window is no longer current, a red X is drawn through it. For edit boxes, as long as the cursor remains in the edit box, no update is performed. The update occurs when the edit box is exited by using the tab key or clicking on another control.

### Add or Edit Category Dialog Box

The *Add or Edit Category* dialog box shown below is used to add a new category and to edit an existing category. A symbol and description of the category must be specified. This dialog box is displayed as a result of clicking the **Add Category** or the **Edit Category** buttons on the *Category Input* dialog box.

![Add or Edit Category Dialog Box](image)

The **Symbol edit box** is used to enter the symbol associated with the category. This symbol is used in equations referencing this variable. It must be a valid symbol consisting entirely of
Entering Information 63

letters, the digits 0-9 and underscores. The symbol cannot begin with a digit. The symbol can be of any length but is best limited to 1-3 characters.

The Description edit box is used to enter a more detailed description of the category. It can be any combination of characters and any length.

Click the OK button or press the Enter key when done. The symbol is checked and an error message displayed if the symbol is not valid. Otherwise the category is added or changed and the dialog box closed. Clicking the Cancel button or pressing the Esc key closes the dialog box without adding or changing the changes. Clicking on the Help button displays help concerning the Add or Edit Category dialog box.

4.5 Output Variables

An output variable is a measurable characteristic of direct interest to the user of the product or process. Examples include seal strength of a heat sealer and flow rate of a pump. Before the analysis can be performed, an equation must be entered representing the effect that the inputs have on the output. When an output variable is added, an Output Variable dialog box like the one below is displayed. This dialog box is used to enter and change information concerning the output variable.

The Symbol edit box is used to enter the symbol. The variable’s symbol is used to represent the variable in equations. Each variable must have a unique symbol. It can be of any length but is best limited to 3 characters or less. The symbol must consist of letters, the digits 0-9 and underscores. It cannot begin with a digit.
The *Name edit box* is used to enter a more detailed name or description of the variable. It may contain any characters and be of any length. While the symbol should be short, the name should be descriptive.

The *Units edit box* can optionally be used to enter the units of measure associated with this variable. It can be any combination of characters and any length.

The *xx.xx button* displays a popup menu for specifying the number of digits to report for this variable. The default is five significant digits. You can choose between 2-12 significant digits and from 0 to 12 digits after the decimal point. When VarTran displays numbers, it discards trailing zeros.

The *Equation edit box* is used to enter the equation representing the effect of the inputs on this output. It must be a valid expression. This equation can include the symbols of continuous input variables and other output variables. It can also include references to the categories of category input variables. A complete list of the operators, function and constructs allowed in the equation are:

- **Numbers**: 2, 2.0, 2.02 10^-3, ...
- **Unary Operators**: -
- **Binary Operators**: +, -, * (multiplication), / and ^ (power).
- **Input Variables**: Symbol
- **Output Variables**: Symbol
- **Category Inputs**: Symbol{Category}
- **Functions**: Log[param], Log10[param], Exponential[param], SquareRoot[param], Sine[param], Cosine[param], Tangent[param], ArcSine[param], ArcCosine[param], ArcTangent[param], HyperbolicSine[param], HyperbolicCosine[param], HyperbolicTangent[param], Gamma[param], LogGamma[param], Beta[param1,param2], LogBeta[param1,param2], AbsoluteValue[param], Minimum[param1,param2], Maximum[param1,param2], NormalDistribution[param1], InverseNormalDistribution[param1], pi[] and e[].
- **Parentheses**: ( and )

A reference of the form Cav{2} refers to category _2 of the category input variable whose symbol is Cav. It has the value 1 when the given category is the selected category and a value of 0 when it is not. Categories are selected using the *Category Input* dialog box.

Multiplication signs may be omitted. A reference like 2 A is interpreted as two times the variable A. A number like 2.02 10^-3 is interpreted as 2.02 times 10 to the negative three. Squared brackets are used to enclose the parameters of a function. For example, Log[2.0] refers the log of 2.0. The reference Log (2.0) would be interpreted as meaning the variable Log times 2.0.
The operator precedence and association rules determine the default order that the operators in expressions are performed. This order can always be overridden using parentheses. The operations are first performed in the order of precedence. The highest precedence operators are performed first. The precedence of the different operators are given below starting with those with the highest precedence.

1. - (negative)
2. ^
3. *, /
4. +, - (subtraction)

Operators that have the same precedence are performed according to their order. Sometimes they are performed from left to right and sometimes from right to left. The order they are performed in is called their association. The associations of the different operators are given below:

Left to Right:   *, /, +, - (subtraction)
Right to Left:  - (negative), ^

If in doubt about the order that the operations will be performed, use parentheses. Some examples are:

\[ 1 + 2 \times 3 = 1 + (2 \times 3) = 7 \]
\[ -1 ^ 2 = (-1) ^ 2 = 1 \]
\[ 8 / 2 \times 3 = (8 / 2) \times 3 = 12 \]
\[ 2 ^ 1 ^ 2 = 2 ^ (1 ^ 2) = 2 \]

While an equation can be directly typed into the *Equation* edit box, it is generally simpler to click the *Keypad button* and use the calculator style interface provided by the *Keyboard Equations* dialog box to enter the equation. The *Keyboard Equations* dialog box is described later in this section.

If the equation was fit to a set of data using a statistics package, you can paste the equation by clicking the *Paste button* and using the *Paste Equation* dialog box to automatically convert the equation into the format required by VarTran. The *Paste Equation* dialog box is also described later in this section.

The *Target edit box* is used to enter the target if one exists. Otherwise, leave it blank. It must be a valid constant expression and must be between the lower and upper specification limits, if they exist. The target is needed to calculate the distance from target.

The *Lower Spec Limit edit box* and *Upper Spec Limit edit box* are used to enter the specification limits if they exist. If a specification limit does not exist, leave the edit box blank. The values entered must be valid constant expressions. The lower spec limit must be less than the upper spec limit. At least one specification limit is required to calculate \( C_{pk} \), the defect rate, \( Z \)-score, sigma level and the distance inside spec. Both specification limits are required to calculate \( C_p \).
The **Method of Estimating Average and Standard Deviation list box** is used to specify the analytic approach to be used to derive equations for the average and standard deviation of the output. There are two basic approaches used: curve fit and Taylor series. Both approaches locally approximate the equation by a polynomial for which the average and standard deviation can be derived. The Taylor series approach uses Taylor series expansions to generate the polynomial. The curve fit approach fits a curve through specific points. The Taylor series approach is generally faster to execute but requires continuously differentiable functions so is not applicable when the following functions are used: Minimum, Maximum, and AbsoluteValue. The higher the order used, the better the approximation but the longer the execution time. A first order corresponds to fitting a straight line, second order to fitting a quadratic polynomial, etc. The default is second order Taylor series approach. Further information on the methods for deriving such equations can be found in Cox (1986), Evans (1975) and Taylor (1991).

When the **Include in Optimization with Multiple Outputs check box** is checked, the output will be included in optimizations involving multiple outputs. When using the **Find Optimal Targets** dialog box and there are multiple outputs, one has an option to optimize all outputs. This option will construct an objective function to optimize that includes all the output functions that have the **Include in Optimization with Multiple Outputs check box** checked. The default is to check this box. If you wish to exclude an output from the optimization, remove the check mark. Some outputs might represent intermediate calculations used by other outputs and not be appropriate for use in the optimization. Other times, you may wish to exclude outputs of lesser importance that appear to prevent other more important outputs from reaching acceptable values.

To close the dialog box and save the changes, click the **OK** button. The symbol is checked to verify that it is valid and not already in use. If an error is encountered, a message is displayed.

To cancel the changes including the addition of a new variable, click the **Cancel** button, press the **Esc** key or click the X in the upper right corner of the dialog box. To delete the variable, click the **Delete** button. Clicking the **View Equations** button displays the **View Equations** dialog box for viewing the derived equations for the average the standard deviation as described later in this section. For help, click the **Help** button or press the F1 key.

When an edit box is exited, all other windows are immediately notified of the change. Some windows such as the **I/O System** window, will immediately display the change. However, analysis windows will generally wait to update their results until the analysis window is selected by clicking on it. To show that the window is no longer current, a red X is drawn through it. For edit boxes, as long as the cursor remains in the edit box, no update is performed. The update occurs when the edit box is exited by using the tab key or clicking on another control.

If an error is made entering data for an output, an error message will be displayed on the status line. It should be handled as described in Section 4.3.
The View Equations dialog box is used to display the derived equations for the average and standard deviation, as well as the full equation for the output. It is displayed by clicking the View Equations button on the Output Variable dialog box.

The Type of Equation list box is used to select which equation to display. The options are:

- **Value (Original Equation):** This is the full equation used for the output in terms of the inputs. It is constructed by taking the equation entered and substituting the equations for other outputs into it.

- **Average:** Equation derived for the average of the output in terms of the averages and standard deviations of the inputs. This equation is evaluated to calculate the value of the average displayed in the Capability Study window.

- **Standard Deviation:** Equation derived for the standard deviation of the output in terms of the averages and standard deviations of the inputs. This equation is evaluated to calculate the value of the standard deviation displayed in the Capability Study window.

The Show All Parenthesis check box is used to indicate how to display parentheses. When checked, parentheses are displayed around each operator so that the order of calculation is clear. When not checked, only the parentheses necessary to ensure the correct order of calculation are displayed. The operator precedence and association rules apply to all other operators.
The *Show Multiplications check box* is used to indicate how multiplications are to be displayed. When checked, multiplication signs are displayed. When not checked, no multiplication signs are displayed.

Close the dialog box by clicking the *OK* button. Alternatives are to press the *Enter* and *Esc* keys. Pressing the *Copy* button causes a copy of the equation to be added to the clipboard for pasting into other programs. These equations can become very lengthy. Equations more than nine printed pages are truncated. The *Help* button is used to display help specific to the *View Equations* dialog box.

**Keypad Equation Dialog Box**

The *Keypad Equation* dialog box is used to enter an equation for either an output variable or objective function. It is displayed by clicking on the *Keypad* button in either the *Output Variable* dialog box or *Objective Function* dialog box.

The *Equation edit box* displays the current equation. It is initialized to the equation appearing in either the *Output Variable* dialog box or *Objective Function* dialog box. While the equation can be typed directly into this edit box, it is easier to enter it by double clicking on the variables and functions below as well as clicking on the character keys.

The *Variables list box* displays a list of available variables for entering into the equation. Double click a variable to insert it into the equation. For an output variable, the inputs and other output variables are listed. For an objective function, all characteristics of the inputs and outputs are listed along with other objective functions.
The **Functions list box** displays a list of all available functions. Double click a function to insert it into equation.

The **character keys** are used to enter numbers, operators and delimiters.

To close the dialog box and save the changes, click the **OK** button. To cancel the changes, click the **Cancel** button, press the **Esc** key or click the X in the upper right corner of the dialog box. For help, click the Help button or press the F1 key.

### Paste Equation Dialog Box

The **Paste Equation** dialog box is used to paste and convert an equation from another software package. Supported packages include EXCEL, JMP, Mathematica, Minitab and Statgraphics. The equation is converted into the format required for either an output variable or objective function. For each of these 5 packages, specific instructions are available in the help system for generating the equation and copying it into the clipboard ready for pasting. Start by clicking on the **Help** button and then click on the package you are using to locate these instructions.

Once the equation is in the clipboard, click the **Paste button**. This copies the equation from the clipboard into the **Equation edit box**.

The **Equation edit box** displays the equation as copied from the clipboard, before any conversion. This control is read only.
The **Source radio box** is used to specify the source of the equation. When the equation is pasted, VarTran will automatically determine the source and sets this radio box.

If the **Create Inputs check box** is checked, VarTran will automatically create any input variables referenced in the equation which don’t already exist. When generating these variables, VarTran uses the name field to determine if a variable already exists. Name fields should not be edited until all equations have been converted.

Once the equation to be converted has been pasted into the *Equation* edit box and the appropriate options selected, click the **Convert button** to complete the conversion process. The converted equation will appear in the *Equation* edit box in the *Output Variable* dialog box or *Objective Function* edit box in the *Objective Function* dialog box.

To abort the conversion process, click the **Cancel button**, press the *Esc* key or click the X in the upper right corner of the dialog box. For help, click the **Help button** or press the *F1* key.

### 4.6 Objective Functions

An objective function is a function used for optimization that can contain characteristics of several output variables. This allows the simultaneous optimization of several outputs. A commonly used objective function for this purpose is the minimum $C_{pk}$ of the outputs. Maximizing this objective function helps to ensure that all outputs have acceptable values of $C_{pk}$. Objective functions can also be written for Taguchi’s signal to noise ratios allowing them to be maximized.

When an objective function is added, an *Objective Function* dialog box like the one below is displayed. This dialog box is used to enter and change information concerning the objective function.
The **Symbol edit box** is used to enter the symbol. The variable’s symbol is used to represent the variable in equations. Each variable must have a unique symbol. It can be of any length but is best limited to 3 characters or less. The symbol must consist of letters, the digits 0-9 and underscores. It cannot begin with a digit.

The **Name edit box** is used to enter a more detailed name or description of the objective function. It may contain any characters and be of any length. While the symbol should be short, the name should be descriptive.

The **Units edit box** can optionally be used to enter the units of measure associated with this variable, if any. It can be any combination of characters and any length.

The **xx.xx button** displays a popup menu for specifying the number of digits to report for this variable. The default is five significant digits. You can choose between 2-12 significant digits and from 0 to 12 digits after the decimal point. When VarTran displays numbers, it discards trailing zeros.

The **Objective Function edit box** is used to enter the equation representing the objective function. It must be a valid expression. This equation can include the symbols of other objective functions as well as properties of the input and output variables. A complete list of the operators, function and constructs allowed in the objective function are:

- **Numbers**
  - 2, 2.0, 2.02 \(10^{-3}\), ...

- **Unary Operators**
  - - (multiplication), / and \(^\) (power).

- **Binary Operators**
  - +, -, * (multiplication), / and \(^\) (power).

- **Input Variables**
  - Symbol\{Property\} where the following properties and abbreviations are allowed: Target (T), Average (A), StandardDeviation (SD), UpperSpecLimit (USL), and LowerSpecLimit (LSL).

- **Category Inputs**
  - Symbol\{Category\}

- **Output Variables**
  - Symbol\{Property\} where the following properties are allowed: Average (A), StandardDeviation (SD), Cp, Cc, Cpk, Cpm, RootMeanSquareError (RMSE), PercentDefective (PD), ZScore (Z), CoefficientVariation (CV), LowerIntervalValues (LIV), UpperIntervalValues (UV), DistanceInsideSpec (DIS), DistanceFromTarget (DFT), LowerSpecLimit (LSL), UpperSpecLimit (USL), and Target (T).

- **Objective Functions**
  - Log[\(param\)], Log10[\(param\)], Exponential[\(param\)], SquareRoot[\(param\)], Sine[\(param\)], Cosine[\(param\)], Tangent[\(param\)], ArcSine[\(param\)], ArcCosine[\(param\)], ArcTangent[\(param\)], HyperbolicSine[\(param\)], HyperbolicCosine[\(param\)], HyperbolicTangent[\(param\)], Gamma[\(param\)], LogGamma[\(param\)],
Beta[param1,param2], LogBeta[param1,param2],
AbsoluteValue[param], Minimum[param1,param2],
Maximum[param1,param2],
NormalDistribution[param1],
InverseNormalDistribution[param1], pi[] and e[].

Parentheses ( and )

The different properties available for the inputs and outputs all have abbreviations associated with them. For example, to refer to the percent defective of output O1 you can type O1{PercentDefective} or O1{PD}.

For a category input variable, a reference of the form Cav{_2} refers to category _2 of the category input variable Cav. This reference has the value 1 when the given category is the selected category and a value of 0 when it is not. Categories are selected using the Category Input dialog box.

Multiplication signs may be omitted. A reference like 2 A is interpreted as two times the variable A. A number like 2.02 10^-3 is interpreted as 2.02 times 10 to the negative three. Squared brackets are used to enclose the parameters of a function. For example, Log[2.0] refers the log of 2.0. The reference Log (2.0) would be interpreted as meaning the variable Log times 2.0.

The operator precedence and association rules are the same as for the equation of an output variable. This order can always be overridden using parentheses.

While an equation can be directly typed into the Objective Function edit box, it is generally simpler to click the Keypad button and use the calculator style interface provided by the Keyboard Equations dialog box to enter the equation. The Keyboard Equations dialog box was described in Section 4.5.

If an equation was fit to a set of data using a statistics package, you can paste the equation by clicking the Paste button and using the Paste Equation dialog box to automatically convert the equation into the format required by VarTran. The Paste Equation dialog box was described in Section 4.5. When an equation is pasted into an objective function, the equation can be evaluated and optimized directly, but cannot be used for a tolerance analysis. An example of such an equation is a model for the standard deviation or percent defective fit using a response surface study. Chapter 9 covers this topic in greater depth.

To close the dialog box and save the changes, click the OK button. The symbol is checked to verify that it is valid and not already in use. If an error is encountered, a message is displayed.

To cancel the changes including the addition of a new variable, click the Cancel button, press the Esc key or click the X in the upper right corner of the dialog box. To delete the variable, click the Delete button. For help, click the Help button or press the F1 key.
When an edit box is exited, all other windows are immediately notified of the change. Some windows such as the I/O System window, will immediately display the change. However, analysis windows will generally wait to update their results until the analysis window is selected by clicking on it. To show that the window is no longer current, a red X is drawn through it. For edit boxes, as long as the cursor remains in the edit box, no update is performed. The update occurs when the edit box is exited by using the tab key or clicking on another control.

If an error is made entering data for an output, an error message will be displayed on the status line. It should be handled as described in Section 4.3.

One important use of objective functions is in the case of multiple output variables. To simultaneously optimize several outputs, combine them into a single objective function. Assuming two outputs with symbols $O_1$ and $O_2$, the following objective functions might be used:

- $\text{Minimum}[O_1\{Cpk\}, O_2\{Cpk\}]$
- $O_1\{\text{PercentDefective}\} + O_2\{\text{PercentDefective}\}$

Another use of objective functions is to construct Taguchi loss functions like the one below. The value 3.2 represents the $k$ value for output $O_1$. If several outputs exist, the total loss can be obtained by summing the losses for each output.

$$3.2 \left( (O_1\{\text{Average}\} - O_1\{\text{Target}\})^2 + O_1\{\text{StandardDeviation}\}^2 \right)$$

Taguchi signal-to-noise ratios can also be constructed for the outputs. Several commonly used objective functions are:

- Nominal The Best I: $10 \log_{10} [O_1\{\text{Average}\}^2 / O_1\{\text{StandardDeviation}\}^2]$
- Nominal The Best II: $-10 \log_{10} [O_1\{\text{StandardDeviation}\}^2]$
- Smaller The Better: $-10 \log_{10} [O_1\{\text{Average}\}^2 + O_1\{\text{StandardDeviation}\}^2]$
4.7 I/O System Window and Editing Variables

The I/O System window is a child window that displays the symbols and names of the variables. It is initially displayed. If closed, it can be reopened by clicking on the button on the toolbar or by selecting the I/O System Window menu item on the Variables menu. Click on the X in the upper right corner to close this window.

The continuous input variables and category input variables are displayed on the left. The output variables and objective functions are displayed to the right. The title at the top can be changed.

The primary purpose of the I/O System window is to allow easy access to the variables for editing. Double clicking on a variable in the I/O System window results in the appropriate dialog box being displayed so that the variable can be edited. This also works in many of the other windows as well. This is a short cut to selecting the Edit Variables menu item on the Variables Menu.

The buttons at the bottom can be hidden by removing the check from the Show Buttons menu item on the Options menu. When hidden, the popup menu can still be used to perform the functions of these buttons. The following buttons are available:

- Used to add a new variable. Displays a menu for selecting the type of variable. The appropriate variable dialog box is then displayed so that the variable's information can be entered. Shortcuts are the Add button on the toolbar, the Add menu item on the Variables menu, and to double click the yellow region in the center of the graphic.
Displays the *Name I/O System* dialog box for changing the name at the top of the graphic. Short cut is to double click on the name in the graphic.

Clicking this button displays the popup menu to the right associated with this window. This popup menu has menu items that correspond to each of the buttons shown at the bottom of the window. It also has items that can be used to change how the graphic is sized within the window. A short cut is to right mouse click on the graphic.

Prints the I/O system graphic. Shortcuts are to click the *Print* button on the toolbar or to select the *Print* menu item on the *File* menu.

Copies the I/O system graphic to the clipboard. Shortcuts are to click the *Copy to Clipboard* button on the toolbar or to select the *Copy to Clipboard* menu item on the *File* menu.

Displays help on using this window. Short cut is to press F1 key.

**Name I/O System Dialog Box**

Clicking the *Name* button displays the *Name I/O System* dialog box shown below. Double clicking on the name in the *I/O System* window has the same effect.

Enter the new name in the *Name I/O System* edit box. All characters are allowed. The title can be of any length. It cannot be blank.

When done click on the *OK* button or press the *Enter* key. To cancel without making any changes, click on the *Cancel* button or press the *Esc* key. For further help, click on the *Help* button.
### 4.8 Summary Table

The *Summary Table* window is a child window for displaying information about all the variables at once. The table has 7 tabs containing various displays. It is displayed by selecting the *Summary Tables* menu item on the *Variables* menu. A shortcut is to press the button on the toolbar. Click on the X in the upper right corner to close this window.

The *Summary Table* window automatically updates itself when information affecting the displayed results is changed. When the program is in immediate update mode, the updates occur immediately following the change being made. If the program is in delayed update mode, the *Summary Table* window draws a red X through itself when it is not current. Clicking on the window will cause it to update and redraw itself. The update mode is selected using the *Options* menu.

Double clicking on a variable in the window results in the appropriate variable dialog box being displayed so that the variable can be edited. This is a short cut to selecting the *Edit* menu item on the *Variables* menu.

There are seven tabs displaying the following information:

- **Tab 1 - Tolerances - Inputs:** Displays specified tolerances and settings for all continuous input variables and category input variables. Shows the same information as displayed on the tabs in the *Continuous Input Variable* dialog boxes and in the *Category Input Variable* dialog boxes.

- **Tab 2 - Tolerances - Outputs:** Displays calculated tolerances and values for all output variables and objective functions. Shows the same information as displayed in the *Capability Study* windows. Also displays simulation results if available.

- **Tab 3 - Continuous Inputs:** Displays all values and settings specified for continuous input variables in their *Continuous Input Variable* dialog boxes.

- **Tab 4 - Category Inputs:** Displays all values and settings specified for category input variables in their *Category Input Variable* dialog boxes.
Tab 5 - Outputs: Displays all values and settings specified for output variables in their Output Variable dialog boxes.

Tab 6 - Objective Functions: Displays all values and settings specified for objective functions in their Objective Function dialog boxes.

Tab 7 - Simulation Inputs: Displays simulation results for the continuous input variables. The corresponding simulation results for the outputs are on Tab 2.

The buttons and controls at the bottom can be hidden by removing the check from the Show Buttons menu item on the Options menu. When hidden, the popup menu can still be used to perform the functions of these buttons and controls. To display the popup menu, right mouse click over the tables. The following buttons and controls are available:

- **Options**: Clicking this button displays the popup menu associated with this window. This popup menu has menu items that correspond to each of the buttons shown at the bottom of the window. It also has items that can be used to change how the graphic is sized within the window. A short cut is to right mouse click on the graphic.

- **Print**: Prints the table of selected tab. Shortcuts are to click the Print button on the toolbar or to select the Print menu item on the File menu.

- **Copy**: Copies the table on the selected tab to the clipboard in both text (tab delimited) and graphic formats. Shortcuts are to click the Copy to Clipboard button on the toolbar or to select the Copy to Clipboard menu item on the File menu.

- **Help (F1)**: Displays help on using this window. Short cut is to press F1 key.

- **Lock check box**: Checking this box locks the window so that it does not update as changes are made to the variables. Locking the window causes a complete copy of the I/O System to be saved. It also causes the Restore button to be displayed which can be used to restore the I/O System to the state it was in when the Lock check box was clicked. Unlocking a window deletes the saved copy of the I/O System.

- **Note edit box**: Used to enter a note that appears on the caption bar. It is primarily intended to be used when the window is locked to describe the version of the design being displayed.

- **Restore**: This button is only displayed when the window is locked. Clicking it restores the I/O System to the exact state it was in when this window was locked.
Once the targets and tolerances for the inputs have been entered and once the equations for the outputs have been entered, it is time to perform the different analysis often starting with a tolerance stack up to determine how the outputs are expected to behave. The result of a tolerance analysis is displayed in the form of a capability study.

5.1 Capability Study Window

The *Capability Study* window is a child window used to display the results of a tolerance stack up for an output variable or objective function. Click on the button on the toolbar to display a *Capability Study* window. This is a shortcut for the *Capability Study* menu item on the *Analysis* menu. If there is only one output or objective function, the results will be displayed immediately. If there is more than one, a menu will appear as shown below for specifying which variable to display the results for.

An example of the *Capability Study* window is shown on the next page. It has 3 tabs containing various results. The results displayed depend on the type of tolerances that were specified for the inputs. Section 5.3 covers statistical tolerances, Section 5.4 covers worst-case tolerances and Section 5.5 covers process tolerances. Prior to this, the next section provides a summary of the different capability indices displayed in the *Capability Study* window. Click on the X in the upper right corner to close this window.

The *Capability Study* window automatically updates itself when information affecting the displayed results is changed. When the program is in immediate update mode, the updates occur immediately following the change being made. If the program is in delayed update mode, the *Capability Study* window draws a red X through itself when it is not current. Clicking on the window will cause it to update and redraw itself. The update mode is selected using the *Options* menu.

Double clicking on the title in the window displays the variable’s *Output Variable* dialog box. This is a short cut to selecting the *Edit* menu item on the *Variables* menu.
The buttons and controls at the bottom can be hidden by removing the check from the Show Buttons menu item on the Options menu. When hidden, the popup menu can still be used to perform the functions of these buttons and controls. To display the popup menu, right mouse click over the graphic. The following buttons and controls are available:

**Clicking this button displays the popup menu associated with this window.** This popup menu has menu items that correspond to each of the buttons shown at the bottom of the window. It also has items that can be used to change how the graphic is sized within the window. A short cut is to right mouse click on the graphic.

**Prints the graphic on the selected tab.** Shortcuts are to click the Print button on the toolbar or to select the Print menu item on the File menu.

**Copies the table on the selected tab to the clipboard in graphic format.** Shortcuts are to click the Copy to Clipboard button on the toolbar or to select the Copy to Clipboard menu item on the File menu.

**Displays help on using this window.** Short cut is to press F1 key.
Lock check box: Checking this box locks the window so that it does not update as changes are made to the variables. Locking the window causes a complete copy of the I/O System to be saved. It also causes the Restore button to be displayed which can be used to restore the I/O System to the state it was in when the Lock check box was clicked. Unlocking a window deletes the saved copy of the I/O System.

Note edit box: Used to enter a note that appears on the caption bar. It is primarily intended to be used when the window is locked to describe the version of the design being displayed.

This button is only displayed when the window is locked. Clicking it restores the I/O System to the exact state it was in when this window was locked.

5.2 \( C_p, C_c, C_{pk} \) and Six Sigma

To interpret the results of a capability study, you must first have an understanding of \( C_p, C_c, C_{pk} \) and Six Sigma. These terms are defined in this section.

**Capability Index: \( C_p \)**

\( C_p \) stands for capability of the process. It is a measure of how well the process variation fits within the specification limits. Its formula is

\[
C_p = \frac{USL-LSL}{6\sigma}
\]

where USL is the upper specification limit, LSL is the lower specification limit and \( \sigma \) is the process standard deviation. \( C_p \) is independent of the units of measure. The numerator is the distance between the specification limits. The denominator is the width of the process. For a normal distribution, 99.73% of the product falls within \( \pm 3\sigma \) of the average. Therefore, 99.73% of the product falls within an interval that is \( 6\sigma \) wide. \( C_p \) compares the width of the specification limits to the width of the process.

When \( C_p \) is 1, the process variation is equal to the width of the specification limits as shown on the next page. A \( C_p \) of 2 means the specification limits are twice as wide as the process variation. A \( C_p \) of \( \frac{1}{2} \) means the specification limits are \( \frac{1}{2} \) the width of the process. The larger \( C_p \) is, the better. \( C_p \) can only be calculated in the case where there are two specification limits.
Interpreting $C_p$

Each company has its own guidelines as to acceptable values of $C_p$. However, some general guidance will be given here. First, suppose that $C_p$ is 1. At first appearances this might seem OK. However, a $C_p$ of 1 only produces good product if the process is kept perfectly centered. If the process shifts off-target, high levels of defects can result. No process remains perfectly centered all the time. Suppose the process shifts off-target by 1.5σ. As shown below, the average would now be only 1.5σ from the specification limit resulting in 6.7% defective.

When interpreting $C_p$, it is important to keep in mind the need for an operating window. An operating window of ±1.5σ is frequently allowed. This operating window is based on the ability of a control chart to keep the process centered. Suppose you were using an $\bar{X}$–$R$ control chart. Every hour a sample of 5 units is selected and plotted on the control chart. The figure below shows the average number of samples required to detect different size shifts. If the process is $\frac{1}{2}$σ off-target, it takes an average of 33.4 samples before a point goes outside the control limits. The process can run for days off-target by $\frac{1}{2}$σ before signaling a problem. If the process is 1σ off-target, it takes an average of 4.5 samples before a point goes outside the control limits. The process can run much of a shift off-target by this amount. Such a control chart does not detect shifts of 1σ or less in reasonable periods of time.
Now suppose that the process is 1.5σ off-target. The control chart only averages 1.6 samples before detecting the condition. In fact, 64% of the time, the first point plotted following the shift falls outside the control limits. Such a control chart does a good job of detecting shifts of 1.5σ and above. Therefore, when using a control chart to keep the process centered, a ±1.5σ operating window should be allowed.

Take a second example. Suppose a capability study was performed on the process and that this capability study indicated that the process was stable, i.e., all points were within the control limits. Since a control chart was used to determine whether the process was stable and since this control chart is only assured of detecting shifts of 1.5σ or greater, a stable process is in essence a process capable of holding a ±1.5σ operating window. Unstable processes require wider operating windows. If automatic controllers with real-time feedback are used to keep the process centered, a narrower operating window might be achieved.

Now, consider the case where $C_p$ is 1.5. Now if the process shifts off-target by 1.5σ it is still 3σ from the nearest specification limit. This worst case would result in 0.135% defective or 1350 defects per million (dpm). A $C_p$ of 1.5 is generally considered acceptable.
Finally, consider the case where $C_p$ is 2. Now if the process shifts off-target by $1.5\sigma$, it is still $4.5\sigma$ from the nearest specification limit. This would result in no more than 3.4 defects per million (dpm). As seen later, this represents a level of quality known as Six Sigma.

$C_p = 2$

$C_p$ only evaluates the variation. It does not consider the average. In fact, the average could be outside the spec limits and still yield a great $C_p$ value. A second capability index called $C_c$ is used to evaluate the average.

**Capability Index: $C_c$**

$C_c$ stands for capability of centering. It is a measure of how well the process is centered relative to the specification limits. Its formula is

$$ C_c = \text{Maximum} \left( \frac{\mu - T}{\text{USL} - T}, \frac{T - \mu}{T - \text{LSL}} \right) $$

where USL is the upper specification limit, LSL is the lower specification limit, $T$ is the target and $\mu$ is the process average. $C_c$ is independent of the units of measure. The numerator is the distance off-target. The denominator is the distance from target to the spec limit. $C_c$ measures the relative distance off-target.

A value of 0.25 means the average is in the middle quarter of the spec. A value of 0.50 means the average is in the middle half of the spec. Smaller values of $C_c$ are better. Ideally a $C_c$ of 0.25 should be obtained. This in combination with a $C_p$ of 2 results in Six Sigma Quality.

$C_c$ can only be calculated in the event of two specification limits and target. $C_c$ only evaluates the average. It does not consider the process variation. In fact, the average could be right on target ($C_c = 0$) but with a large variation resulting in a large number of units out of spec. Variation is evaluated using $C_p$. A third capability index, $C_{pk}$, jointly evaluates the average and variation.
Capability Index: $C_{pk}$

$C_{pk}$ stands for capability of the process after adjusted for centering. It is a measure of how well the process fits within the specification limits. The formula for $C_{pk}$ is:

$$C_{pk} = \frac{\min(USL - \mu, \mu - LSL)}{3\sigma}$$

where USL is the upper specification limit, LSL is the lower specification limit, $\mu$ is the process average and $\sigma$ is the process standard deviation. The term USL-$\mu$ is the distance to the upper specification limit. The term $\mu$-LSL is the distance to the lower specification limit. The numerator is the smaller of these two values, which represents the distance to the nearest specification limit. The denominator is the half the width of the process. $C_{pk}$ compares the distance to the nearest specification limit to the process variation.

Calculating $C_{pk}$

When $C_{pk}$ is 1, the process average is exactly $3\sigma$ from the nearest specification. The figure below shows several processes with $C_{pk}$ of 1. In each case, one or both ends of the normal curve is touching the specification limits.

Processes with $C_{pk}$ of 1

When $C_{pk}$ is 2, the distance from the process average to the nearest specification limit is twice the process variation. The figure below shows several processes with $C_{pk}$ of 2.
Processes with Cpk of 2

Cpk is always less than or equal to Cp. They are equal only when the process is perfectly centered. The figure below shows a series of processes with a Cp of 2. As the process average shifts further off-target, the value of Cpk decreases.

While Cp requires two specification limits, only one specification limit is required to calculate Cpk. If only a lower specification exists, Cpk is:

\[
C_{pk} = \frac{\mu - LSL}{3\sigma}
\]

If only an upper specification limit exists, Cpk is:

\[
C_{pk} = \frac{USL - \mu}{3\sigma}
\]

When two specification limits exist, Cpk is the lesser of these two quantities.

When there two specification limits and the target is in the middle of specification limits, the following special formula can be used to calculate Cpk:

\[
C_{pk} = C_p \left(1 - C_c \right)
\]

Historically, the quantity \(C_p\times C_c\) has been referred to as k resulting in the following formula from which Cpk derives its symbol:
$$C_{pk} = C_p - k \quad \text{where} \quad k = \frac{\mu - \frac{USL + LSL}{2}}{3\sigma} = C_p C_c$$

**Defect Rate and Z-Score**

$C_{pk}$ measures the relative distance to the nearest specification limit. An alternative measure is the Z-Score. For a lower specification limit, the Z-score is:

$$Z - \text{Score}_{\text{lower}} = \frac{\mu - LSL}{\sigma}$$

For an upper specification limit, the Z-score is:

$$Z - \text{Score}_{\text{upper}} = \frac{USL - \mu}{\sigma}$$

For the one-sided case:

$$C_{pk} = \frac{Z - \text{Score}}{3}$$

For the two-sided case:

$$C_{pk} = \frac{\text{Minimum}(Z - \text{Score}_{\text{lower}}, Z - \text{Score}_{\text{upper}})}{3}$$

Assuming the normal distribution, Z-scores can be used to determine the defect rate by looking up the defect rate that corresponds to the Z-score. Below is an abbreviated table.

**Normal Curve**

<table>
<thead>
<tr>
<th>Z-Score</th>
<th>Percentage Outside Specification</th>
<th>$C_{pk}$</th>
</tr>
</thead>
<tbody>
<tr>
<td>5</td>
<td>0.3/million</td>
<td>1.6667</td>
</tr>
<tr>
<td>4.5</td>
<td>3.4/million</td>
<td>1.5</td>
</tr>
<tr>
<td>4</td>
<td>31/million</td>
<td>1.3333</td>
</tr>
<tr>
<td>3.5</td>
<td>233/million</td>
<td>1.1667</td>
</tr>
<tr>
<td>3</td>
<td>0.135%</td>
<td>1</td>
</tr>
<tr>
<td>2.5</td>
<td>0.6%</td>
<td>0.8333</td>
</tr>
<tr>
<td>2</td>
<td>2.3%</td>
<td>0.6667</td>
</tr>
<tr>
<td>1.5</td>
<td>6.7%</td>
<td>0.5</td>
</tr>
<tr>
<td>1</td>
<td>15.8%</td>
<td>0.3333</td>
</tr>
<tr>
<td>0.5</td>
<td>30.9%</td>
<td>0.1667</td>
</tr>
<tr>
<td>0</td>
<td>50%</td>
<td>0</td>
</tr>
</tbody>
</table>
The function that relates the Z-score and defect rate is called the normal distribution function. It is represented by the symbol \( \Phi() \). The defect rate as a fraction defective is calculated as follows:

- **Lower Specification Limit:** \( \text{Defect Rate} = \Phi(Z - \text{Score}_{\text{lower}}) \)
- **Upper Specification Limit:** \( \text{Defect Rate} = \Phi(Z - \text{Score}_{\text{upper}}) \)
- **2-Sided Specification:** \( \text{Defect Rate} = \Phi(Z - \text{Score}_{\text{lower}}) + \Phi(Z - \text{Score}_{\text{upper}}) \)

Multiply the defect rate by 100 to get a percent defective. Multiply the defect rate by 1,000,000 to get the defect per million (dpm).

Previously, formulas were given for the Z-score for the case of a single specification limit. In the event of a 2-sided specification limit, it is calculated as follows

\[
Z - \text{Score} = \Phi^{-1}\left(\Phi(Z - \text{Score}_{\text{lower}}) + \Phi(Z - \text{Score}_{\text{upper}})\right)
\]

where \( \Phi^{-1}() \) is the inverse of the normal distribution function. The Z-score is determined by calculating the defect rate at each specification limit, adding them together to get the total defect rate, and then looking up the Z-score corresponding to the total defect rate.

**Six Sigma Quality**

Six sigma quality requires that each measurable characteristic such as fill volume and seal strength have a defect rate of no more than 3.4 defects per million. In the table of the normal curve shown previously, the value 3.4 defects per million corresponds to a Z-score of 4.5 and a \( C_{pk} \) of 1.5. Six sigma quality requires that the process average be kept at least 4.5\( \sigma \) from the nearest specification limit.

Six sigma quality can be translated into the process tolerance shown on the next page. This process tolerance requires:

1. Maximum \( \sigma \leq \frac{\text{USL} - \text{LSL}}{12} \) or equivalently \( Cp \geq 2 \)
2. Average be kept within \( \pm 1.5\sigma \) of the target or equivalently \( C_c \leq 0.25 \)

The second requirement is met if the process is stable or a control chart is used to keep it centered on the target. If the process average comes off-target by the maximum amount of 1.5\( \sigma \), the process average will still be at least 4.5\( \sigma \) from the nearest specification limit ensuring six sigma quality.

Per the notation introduced in 3.6.3, a six sigma tolerance is written as:

\[
T \pm \Delta_{\text{6D}} \begin{cases} \text{6D} \end{cases} C_c \leq 1/4, \ C_p \geq 2
\]
At first appearance, the requirement for six sigma quality may appear to be too stringent.

**First 100 Samples:** If 100 samples are selected from a six sigma process, they generally fall in a range of $\pm 3\sigma$ around the average. A histogram of these units might appear as to the right. The units all fit in the middle half of the specs. However, the histogram of these 100 units does not display all the variation in the lot.

**Complete Lot:** Suppose the sample was selected from a lot of 10,000 units. One unit has the highest value and another has the lowest. The chance of including both these units in your sample is small. There are probably dozens of units in the lot more extreme than the 100 samples. The entire lot might appear as to the right.

**Year's Production:** Not all lots will have exactly the same average. If you can hold a $\pm 1.5\sigma$ operating window, the year’s production might appear as to the right. It fills the specifications. The truth is that if your first 100 units do not fit within the middle half of the specs, it is unreasonable to expect to be able to produce millions of units nearly free of defects.
5.3 Statistical Tolerances

We return to the main topic of this chapter, performing capability studies. When a capability study is performed by clicking on the button, the results displayed will depend on the type of tolerances specified for the input variables. When statistical tolerances are specified for the input variables, a statistical tolerance is calculated for the output. The results are shown on 3 tabs.

Tab 1: Calculated Results

The first tab shows the results of a tolerance analysis performed using the analytic approach.

The name of the output variable and the type of tolerance are displayed at the top. Further down, a table of the capability study results is displayed. The following values are displayed:

Average: The predicted average of the output variable. Assumes the continuous input variables are at their selected targets and that the category input variables are set to their selected categories.

Standard Deviation: The predicted standard deviation of the output variable.

Cp: Predicted value of C_p. Six sigma quality requires a C_p ≥ 2.0.
Cc:  Predicted value of $C_c$. Six sigma quality requires a $C_c \leq 0.25$ or below. For a statistical tolerance, $C_c$ is calculated assuming all the inputs are exactly on target. As such, it will frequently be zero and represent the best case. It tends to underestimate what will occur in practice.

Cpk:  Predicted value of $C_{pk}$. Six sigma quality requires maintaining $C_{pk}$ above 1.5. The value shown assumes the inputs are exactly on target so represents the best $C_{pk}$ obtainable. Lower $C_{pk}$ values will result in practice as the inputs vary from their selected targets. To maintain a $C_{pk}$ of 1.5 requires an on target $C_{pk}$ of 2 or more.

Defect Rate:  Predicted defect rate as either a percent defective or in defects per million (dpm). 10,000 dpm is equivalent to 1% defective. 1000 dpm is equivalent to 0.1% defective. The defect rate is calculated assuming the normal distribution. Six sigma quality requires 3.4 dpm or better. The value shown assumes the inputs are exactly on target so represents the best defect rate obtainable. Higher defect rates will result in practice as the inputs vary from their selected targets. To average 3.4 dpm requires an on target defect rate that is considerable lower.

Z-Score:  Predicted value of Z-score. Six sigma quality requires maintaining a Z-score above 4.5. The value shown assumes the inputs are exactly on target so represents the best Z-score obtainable. Lower Z-scores will result in practice as the inputs vary from their selected targets. To maintain a Z-score of 4.5 requires an on target Z-score of 6 or more.

Sigma Level:  Predicted sigma level. For statistical tolerances, the sigma level is the same as the Z-score.

An interval for individual values is displayed at the bottom of the Capability Study window. This tolerance represents an interval containing almost all the individual units of product. For a statistical tolerance it is calculated as follows:

\[
\text{Upper End Interval for Values} = \text{Average} + 4.5 \text{ Standard Deviations}
\]
\[
\text{Lower End Interval for Values} = \text{Average} - 4.5 \text{ Standard Deviations}
\]

The number 4.5 in these formulas is selected so that no more than 3.4 units per million will fall outside each end of the interval. The value 4.5 can be changed using the Number Standard Deviations for Interval for Values... menu item from the Options menu.

The graphic visually represents the relationship between the interval for individual values and the specification limits. The width of the normal curve displayed always matches the interval for individual values.

To perform statistical tolerancing VarTran derives an equation for the output’s average and standard deviation. These equations can be viewed using the View Equation button at the bottom of the Output Variable dialog box as described in Section 4.6.
Tab 2: Simulation Results

The second tab shows the results of a tolerance analysis performed by a Monte Carlo simulation. To perform a simulation, use the Simulation menu item on the Analysis menu as described in Section 8.4.

If no simulation was performed, the message “No Simulation Data” will appear. Otherwise, the results will appear as above. The results are almost identical to those for the analytic approach on the first tab with the following exceptions:

- At the top, a histogram of the data is shown.
- The defect rate is determined by counting the number of units outside the specifications. It does not assume the normal distribution.

Tab 3: Worst-Case Conditions

The third tab does not apply to statistical tolerances so displays the message “Only Applicable to Worst-Case and Process Tolerances.”
Pros and Cons of Statistical Tolerancing

Statistical tolerancing should be used with care. It assumes that all the inputs are exactly at target. Set-up errors and process shifts can result in performance worse than that predicted.

Take as an example the case of overall height of a part created by stacking four identical components of top of each other. Suppose the specification limits are from 3.94” to 4.06”. Each component has an average of 1” with a standard deviation of 0.01”. Using 3 standard deviations to form a tolerance results in a tolerance of 1” ± 0.03” for the components. The resulting statistical tolerance for the overall height is 4” ± 0.06”. These are shown in light gray in the two figures below. The tolerance for overall height falls with the specifications.

![INPUTS](image1)

![OUTPUT](image2)

How Statistical Tolerances Can Result in Out-of-Spec Product

Now suppose that a batch of components is received with an average of 0.0985” and a standard deviation of 0.004”. The variation is much smaller than required. However, the process is not centered, a violation of the assumptions of statistical tolerancing. All the components are within the tolerance for the components and would pass an attribute sampling plan or a 100% inspection. In this case, the overall height will average 3.94” with a standard deviation of 0.008”. The actual behavior of the inputs and output are shown in dark gray above. Despite the fact that the individual components are within their tolerances, the final assemblies are outside of specifications.

Statistical tolerancing requires centered processes. If control charts are used to keep processes centered, it can perform well. However, if your plants or your suppliers let the processes wander throughout the specifications, even though the process remains within the specification limits statistical tolerancing can have disastrous effects.

Since it is impossible to keep processes perfectly centered all the time, some allowance needs to be made for the average deviating from the target. In other words, an operating window must be allowed. One practice, called Benderizing tolerances, inflates the input standard deviations by 50% (multiplies by 1.5) before performing statistical tolerancing. See Bender
(1962). A better approach is to use process tolerances and specify the allowable operating window for the average. This results in a clearer and enforceable set of requirements.

Despite its serious shortcoming, statistical tolerancing is less expensive than worst-case tolerancing as will be seen in the next section. It deserves serious consideration.

## 5.4 Worst-Case Tolerances

When worst-case tolerances are specified for the input variables, a worst-case tolerance is calculated for the output. The results are shown on 3 tabs.

### Tab 1: Calculated Results

The first tab shows the results of a tolerance analysis performed using the analytic approach.

![Flow Rate - (F) Worst-Case Tolerance](image)

The name of the output variable and the type of tolerance are displayed at the top. Further down, a table of the capability study results is displayed. The following values are displayed:

- **At-Target:** The value of the output when all the inputs are at their targets.
- **Minimum:** The minimum value of the output variable over the worst-case tolerances specified for the continuous input variables. Assumes that the category input variables are set to their selected categories.

The interval for values is calculated as $(8.6938, 11.34)$.
Maximum: The maximum value of the output variable over the worst-case tolerances specified for the continuous input variables. Assumes that the category input variables are set to their selected categories.

An interval for individual values is displayed at the bottom of the Capability Study window. For a worst-case tolerance it is calculated as follows:

Upper End Interval for Values = Maximum Value
Lower End Interval for Values = Minimum Value

The graphic visually represents the relationship between the worst-case tolerances and the specification limits.

**Tab 2: Simulation Results**

The second tab does not apply to worst-case tolerances so displays the message “Simulation only applicable to statistical and process tolerances.”

**Tab 3: Worst-Case Conditions**

The third tab shows the settings of the inputs that result in the minimum and maximum values of the outputs shown on the first tab.
Pros and Cons of Worst-Case Tolerancing

Worst-case tolerancing is completely safe. It guards against the situation where all inputs are simultaneously at their worst-case conditions. If the inputs meet their tolerances, the output is assured of being within its worst-case tolerance.

Worst-case tolerancing is more expensive than statistical tolerancing. Given the same tolerances for the inputs, worst-case tolerancing results in a wider tolerance for the output. This in turn requires more frequent tightening of the inputs’ tolerances in order to meet the specifications, driving up costs.

Take as an example the case of overall height of a part created by stacking four identical components of top of each other. Suppose the specification limits are from 3.9” to 4.1”. Each component has a tolerance of 1” ± 0.03”. The resulting statistical tolerance for the overall height is 4” ± 0.06”. This meets the spec. The resulting worst-case tolerance for overall height is 4” ± 0.12”. This is twice as wide as the statistical tolerance and fails to meet the spec. Therefore, the inputs’ tolerances must be tightened increasing costs.

Which is correct? In the last section we saw that statistical tolerancing makes the unlikely assumption that the process is kept perfectly centered. As a result, the statistical tolerance for overall height is probably narrower than what will be experienced in production. However, worst-case tolerancing also has its flaw. The worst-case conditions it guards against are unlikely if not impossible to occur in production. As a result, the worst-case tolerance for overall height is wider than will be experienced in production.

Returning to the overall height example, if the components have a standard deviation of 0.005”, the average must be in the range 0.985” to 1.015” in order to meet the tolerance of 0.97” to 1.03” (below left). At these two extremes, the resulting distributions of overall height are shown below on the right. Because of the variation, it is unlikely that an assembly will be produced with an overall height close to either 3.88” or 4.12”. Worst-case tolerancing results in tolerances wider than will be experienced in production.
5.5 Process Tolerances

Statistical tolerancing results in tolerances for the outputs that are narrower than what will be experienced in production. Worst-case tolerancing results in tolerances for the outputs that are wider than what will be experienced in production. The truth lies somewhere in between. Process tolerances offer a solution to this dilemma.

When process tolerances are specified for the input variables or a combination of statistical, worst-case and process tolerances are specified, a process tolerance is calculated for the output. The results are shown on 3 tabs.

Tab 1: Calculated Results

The first tab shows the results of a tolerance analysis performed using the analytic approach.

![Flow Rate - (F)
Process Tolerance](image)

The name of the output variable and the type of tolerance are displayed at the top. Further down, a table of the capability study results is displayed. There are two columns of numbers. The first column gives the values of the characteristics when all the input averages are equal to the target. This amounts to doing a statistical stack up ignoring the operating windows for
the averages and ignoring any worst-case tolerances. It is represented in the graphic by the center normal curve.

The second column represents the worst-case values for the different characteristics as the input averages vary over their allowed operating windows. The three values, minimum average, maximum average and maximum standard deviation, define the resulting process tolerance for the output. In the graphic, the left-hand normal curve represents the minimum average with the maximum standard deviation and the right-hand normal curve represents the maximum average with the maximum standard deviation. The other worst-case values are calculated from these three. The following worst-case values are displayed:

Minimum Average: The minimum average of the output variable. Using the derived equation for the average, the minimum average is found over the operating windows for the averages and over any worst-case tolerances for the continuous input variables. It assumes that the category input variables are set to their selected categories.

Maximum Average: The maximum average of the output variable. Using the derived equation for the average, the maximum average is found over the operating windows for the averages and over any worst-case tolerances for the continuous input variables. It assumes that the category input variables are set to their selected categories.

Maximum Std. Dev.: The maximum standard deviation of the output variable. Using the derived equation for the standard deviation, the maximum standard deviation is found over the operating windows for the averages and over any worst-case tolerances for the continuous input variables. It assumes that the category input variables are set to their selected categories.

Minimum Cp: Predicted minimum value of C_p. It is calculated as follows:

\[
\text{Min } C_p = \frac{\text{USL} - \text{LSL}}{6 \times \text{Max. Std. Dev.}}
\]

Maximum Cc: Predicted maximum value of C_c. It is calculated as follows:

\[
\text{Max } C_c = \text{Max} \left( \frac{\text{Max. Ave.} - T}{\text{USL} - T}, \frac{T - \text{Min. Ave.}}{\text{USL} - T} \right)
\]

Minimum Cpk: Predicted minimum value of C_{pk}. It is calculated as follows:

\[
\text{Min. Cpk} = \frac{\text{Min}(\text{USL} - \text{Max. Ave.}, \text{Min. Ave.} - \text{LSL})}{3 \times \text{Max. Std. Dev.}}
\]

Maximum Defect Rate: Predicted maximum defect rate as either a percent defective or in defects per million (dpm). The reported value assumes the normal distribution. The defect rate is calculated assuming the
maximum standard deviation at both the minimum and maximum averages. The larger of the two defect rates is reported. 10,000 dpm is equivalent to 1% defective. 1000 dpm is equivalent to 0.1% defective.

**Minimum Z-Score:** Predicted minimum Z-Score. Value reported is the Z-Score associated with the maximum defect rate.

**Minimum Sigma Level:** Predicted minimum sigma level. Value reported is minimum Z-Score plus 1.5.

An interval for individual values is displayed at the bottom of the *Capability Study* window. This tolerance represents an interval containing almost all the individual units of product. For a process tolerance it is calculated as follows:

\[
\text{Upper End Interval for Values} = \text{Max. Average} + 4.5 \times \text{Max. Std. Dev.}
\]

\[
\text{Lower End Interval for Values} = \text{Min. Average} - 4.5 \times \text{Max. Std. Dev.}
\]

The number 4.5 in these formulas is selected so no more than 3.4 units per million will fall outside the interval. This value can be changed using the *Number Standard Deviations for Intervals for Values...* menu item from the *Options* menu.

The graphic visually represents the relationship between the process tolerance, the tolerance for individual values and the specification limits. The outside two normal curves represent the minimum and maximum averages and the maximum standard deviation, i.e., the two worst-case distributions. The width of the normal curve equals the number of standard deviations used to calculate the interval for values.

Six sigma quality was introduced in Section 5.2. Meeting any of the following criteria assures six sigma quality:

- Minimum \( C_{pk} \geq 1.5 \)
- Maximum defect rate \( \leq 3.4 \text{ dpm} \)
- Sigma Level \( \geq 6 \)
- Tolerance for individual tolerances fits inside specification limits (when calculated using 4.5 standard deviations)

In each case, meeting the criteria above ensures six sigma quality throughout the entire operating window specified for the inputs.

**Tab 2: Simulation Results**

The second tab shows the results of three simulations performed at the two worst-case case conditions and when all input averages are at their targets. To perform a simulation, use the *Simulation* menu item on the *Analysis* menu as described in Section 8.4. The worst-case conditions are determined analytically and displayed on the third tab.
If no simulation was performed, the message “No Simulation Data” will appear. Otherwise, the results will appear as above. The results are almost identical to those for the analytic approach on the first tab with the following exceptions:

- At the top, histograms of the three simulations are shown.
- The defect rate is determined by counting the number of units outside the specifications. It does not assume the normal distribution.

### Tab 3: Worst-Case Conditions

The third tab shows the settings of the inputs that result in the minimum and maximum average of the output reported on the first tab. These are the settings used for the two worst-case simulations shown on the second tab.
Pros and Cons of Process Tolerancing

Statistical tolerancing assumes that all processes are on-target, an unlikely assumption. Worst-case tolerances guards against all units simultaneously being at the worst-case conditions which can only occur if there is no variation. This is just as unlikely. Process tolerancing provides middle ground by allowing both variation and off-target processes.

Like worst-case tolerancing, process tolerancing is safe. If the inputs all meet their stated process tolerances, the output is guaranteed to meet its resulting process tolerance. Process tolerancing is less expensive than worst-case tolerancing. While not as inexpensive as statistical tolerancing, process tolerancing is as inexpensive as possible while maintaining guaranteed safety.

Process tolerancing has another distinct advantage. When performing statistical tolerancing, statistical tolerances must be specified for all inputs. When performing worst-case tolerancing, worst-case tolerances must be specified for all inputs. However, when performing process tolerancing, statistical tolerances can be specified for some inputs, worst-case tolerances for others and process tolerances for still others. No longer are you forced to select the same type of tolerance for all inputs.

Process tolerancing represents a unified approach to tolerancing encompassing all the previous approaches. A process tolerance where the minimum and maximum averages are equal represents a statistical tolerance. A process tolerance where the maximum variation is zero represents a worst-case tolerance. This is why VarTran is so easily able to handle all three approaches to tolerancing.
5.6 Objective Functions

Capability studies can also be performed for objective functions. In the event that statistical tolerances are specified for the inputs, the capability study simply gives the value of the objective function as shown below.

If worst-case tolerances or process tolerances are specified for some of the inputs, the capability study reports the minimum and maximum values of the objective function over the worst-case tolerances and operating windows for the averages of the continuous input variables. It also gives the value of the objective function when the inputs are at their target values. In all cases it is assumed that the category input variables are set to their selected categories. An example is shown below.

Rather than display separate capability studies for each output, you can display a Summary Table window showing the capability study results of all the output variables and objective functions in a single window. See Section 4.8.

What if the capability study results are not acceptable? There are two approaches to improving the design:

- Selecting new targets for the inputs to optimize the design and make it robust (Chapter 6).
- Reducing the variation by tightening the tolerances of the inputs (Chapter 7).
6 Optimization and Robustness

One way of improving the performance of your product or process is to change the targets of the inputs to optimize the average and to reduce the variation to obtain a more robust design. In VarTran this can be accomplished by simply asking the software to maximize $C_{pk}$ or some other objective. Within minutes the optimization will be completed and the results displayed. Don’t be fooled by the simplicity of accomplishing this task. While this is a much simpler approach to robust design than using inner/outer arrays and signal to noise ratios, the strategy is the same and the results are superior to those of Taguchi Methods.

6.1 Find Optimal Targets Dialog Box

The Find Optimal Targets dialog box is used to find the set of input targets optimizing an objective function or a characteristic of an output variable. It is displayed by clicking on the button on the toolbar. This is a shortcut for the Find Optimal Targets... menu item on the Analysis menu. The optimal targets for the continuous input variables are found for the current tolerances and selected categories of the category input variables. The optimization is performed over the region bounded by the Minimum Target and Maximum Target edit boxes on the Continuous Input Variable dialog box for those inputs whose Use for Optimization check box is checked.
The **Output list box** is used to select which output variable or objective function to optimize. If there are multiple output variables with specifications, one can also select "All Included Output Variables". This will result in the simultaneous optimization of all output variables with specifications that have the **Include in Optimizations with Multiple Outputs** check box in the **Output Variable** dialog box checked.

The **Characteristic list box** is used to select which characteristic to optimize. The items in the list change depending on the selection in the **Output** list box. If you selected an output variable in the **Output** list box, you have the following choices:

<table>
<thead>
<tr>
<th>Characteristic</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Percent Defective</td>
<td>The percent defective or defect rate will be minimized. Only available for statistical and process tolerances with at least one specification limit.</td>
</tr>
<tr>
<td>Cpk</td>
<td>$C_{pk}$ is maximized. Only available for statistical and process tolerances with at least one specification limit.</td>
</tr>
<tr>
<td>Distance Inside Spec.</td>
<td>Distance inside specification is maximized. Available for all three types of tolerances with at least one specification limit. This is the counterpart to $C_{pk}$ when worst-case tolerances are used.</td>
</tr>
<tr>
<td>Distance From Target</td>
<td>Distance from target is minimized. Available for all three types of tolerancing when a target for the output is specified.</td>
</tr>
<tr>
<td>Lower End of Interval for Values</td>
<td>The lower end of interval for values is maximized. Available for all three types of tolerances even when no targets or specification limits are specified.</td>
</tr>
<tr>
<td>Upper End of Interval for Values</td>
<td>The upper end of interval for values is minimized. Available for all three types of tolerances even when no targets or specification limits are specified.</td>
</tr>
</tbody>
</table>

Only those characteristics applicable to your problem are displayed. For example, $C_{pk}$ is only displayed when at least one specification limit has been entered for the output variable and if statistical or process tolerances are specified. The value initially displayed is the characteristic the software is recommending be optimized based on the type of tolerance and the specification limits and target entered.

If an objective function has been selected, you can choose between maximizing or minimizing the objective function’s value.

If you selected “All Included Output Variables” in the **Output** list box, the **Characteristic** list box will contain the following choices:

<table>
<thead>
<tr>
<th>Characteristic</th>
<th>Description</th>
</tr>
</thead>
</table>
| Total Percent Defective        | The total percent defective is minimized. Only available for statistical and process tolerances with at least one specification limit. If there are
two outputs $O_1$ and $O_2$, uses the objective function:

$$O_1\{PD\} + O_2\{PD\}$$

**Worst Cpk**

The worst $C_{pk}$ is maximized. Only available for statistical and process tolerances with at least one specification limit. If there are two outputs $O_1$ and $O_2$, uses the objective function:

$$\text{Minimum}[O_1\{Cpk\},O_2\{Cpk\}]$$

**Worst Relative Distance Inside Spec**

The worst relative distance inside spec is maximized. Available for all 3 types of tolerances with either two specification limits or 1 specification limit and a target. If there are two outputs $O_1$ and $O_2$, uses the objective function:

$$\text{Minimum}[O_1\{RDIS\},O_2\{RDIS\}]$$

If the desired characteristic to optimize does not appear, it is either because it is not appropriate for the method of tolerancing specified or because a required value has not been entered. For example, $C_{pk}$ is not appropriate if worst-case tolerancing is used and cannot be calculated if at least one spec limit has not been entered.

Once the output and characteristic to optimize has been selected, press either the **Optimize Using Simplex button** or **Optimize Using Interval button** to perform the optimization. The interval method is safer but slower. The simplex method is faster but does not always yield the global optimum. Start with the interval method. It is guaranteed to find the global optimum with at least 2 digits accuracy. If it takes too long to converge, press the **Halt button** to stop the optimization and use the simplex method instead. The simplex method, while faster, may converge to a local optimum which is not the global optimum. Examination of the plots as described in Chapter 8 can help to determine if local optimums exist. If so, the simplex optimization should be repeated several times. These two methods of optimization are covered in detail in Sections 6.2 and 6.3.

As the optimization proceeds, status messages will be displayed in the message box. When completed, the message box will notify you whether a better set of targets has been found. If a better set have been found, the current targets of the inputs are updated. To close the **Find Optimal Targets** dialog box, click the **Close button** or press the **Esc** key. To view the results, perform a capability study. To view the new targets, display a Summary window.

The optimization is performed for the current set of tolerances. If these tolerances are later changed, the optimization should be repeated. The optimization is also performed only for the currently selected categories of the category input variables. To determine which category is best, separate optimizations should be performed for each category and the category with the best results selected.
In the event that worst-case or process tolerances are specified, VarTran actually performs a minimax or maximin optimization. For example, to maximize Cpk, VarTran would determine for each set of input targets the minimum Cpk across the worst-case tolerances and operating windows for the average. It would then find the set of input targets maximizing the minimum Cpk. This requires that one optimization routine be nested within another, which takes longer.

The Precision button at the bottom of the dialog box is used to increase the precision of the results. This button performs an additional simplex optimization beginning at the current set of targets. The termination conditions of this optimization are set to improve the precision of the previous result. Since the interval analysis approach terminates after determining 2 significant digits, this button can be used to obtain more exact results.

The Options button is used to change the termination parameters used by the two methods of optimization. Clicking this button results in the Optimization Options dialog box being displayed. This dialog box is covered in Section 6.4.

Clicking the Help button displays further help concerning Find Optimal Targets dialog box including definitions of the different characteristics to optimize.

6.2 Simplex Method

This section describes the simplex method of optimization. It is for information only and can be skipped. For purpose of explanation, it will be assumed that we are minimizing a function. The simplex method starts at a randomly selected point in the region of optimization and then travels downhill until it can find no direction resulting in further improvement. The weakness of this approach is that it may locate the bottom of one valley and terminate without recognizing that another valley exists with an even better point. To reduce this error, the simplex optimization should be performed multiple times. The presence of local optima can also be determined by careful examination of plots generated using the Plots dialog box.

The simplex method is based on a geometric object called a simplex. In two dimensions, a simplex is a triangle (three corner points). In three dimensions it is a pyramid (four corner points). In n-dimensions a simplex is represented by n+1 points. In VarTran each input variable being optimized represents a dimension. An initial simplex is randomly generated and the function being optimized evaluated at each corner of the simplex. The simplex then moves downhill through a series of shifts, expansions and contractions as illustrated below. The first move is to shift away from the highest point. If this results in an improvement, an expansion is tried. If a worst point is found, a contraction is tried. The idea is to continuously replace the highest point with a better point.
As the optimization proceeds, the simplex is able to wind and twist itself downhill changing shapes as it goes until it can go no further. Unfortunately, the stopping point may be a local minimum, not the global minimum. Another difficulty with this approach is recognizing when the minimum has been found. The corners of the simplex do not necessarily bound the optimum so it cannot be estimated with certainty what the relative error is. Unless well designed stopping criteria are selected, the optimization can terminate before reaching the minimum. VarTran uses a complex combination of stopping criteria, which rarely terminates prematurely. Further details on the simplex method can be found in Olsson (1974) and Olsson and Nelson (1975).

6.3 Interval Method

This section describes the interval method of optimization. It is for information only and can be skipped. The interval method of optimization is based on a new branch of mathematics called interval analysis. Interval analysis redefines the arithmetic operators for use with intervals. For example, let \([a,b]\) and \([c,d]\) be two intervals. Then the addition operator is:

\[
[a,b] + [c,d] = [a+c, b+d]
\]

The interval \([a+c, b+d]\) is the set of all real values \(x+y\) where \(x\) is from the interval \([a,b]\) and \(y\) is from the interval \([c,d]\). The interval log function is defined to be:

\[
\log([a, b]) = [\log(a), \log(b)]
\]

The interval \([\log(a), \log(b)]\) is the set of all real values \(\log(x)\) such that \(x\) is from the interval \([a,b]\). Likewise interval operators and functions can be defined as extensions of the real operators and functions.

Real arithmetic is a special case of interval arithmetic. Real numbers can be represented by intervals of length 0. For example the real number 2 is equivalent to \([2,2]\). In this case the interval functions and operators reduce to the real operators and functions. For example:

\[
2 + 3 = [2,2] + [3,3] = [5,5] = 5
\]
\[ \log(6) = \log([6,6]) = [\log(6), \log(6)] = [1.792, 1.792] = 1.792 \]

Interval analysis has important applications in optimization. It can frequently be used to directly calculate the minimum and maximum. Take the case of two inputs \( X_1 \) which has a worst-case tolerance of \([1,2]\) and \( X_2 \) which has a worst-case tolerance of \([3,4]\). The output \( Y = \log (X_1 + X_2) \). Then the worst-case tolerance for \( Y \) is \([0.602, 0.778]\) since:

\[
0.778 = \max \left\{ \log(X_1 + X_2) \right\}_{X_1 \in [1,2], X_2 \in [3,4]} \quad \quad 0.602 = \min \left\{ \log(X_1 + X_2) \right\}_{X_1 \in [1,2], X_2 \in [3,4]}
\]

The first equation is read as the maximum of the function \( \log(X_1 + X_2) \) for \( X_1 \) between 1 and 2 and for \( X_2 \) between 3 and 4. The minimum and maximum could be calculated using the simplex routine of the previous section.

Interval analysis can be used to determine the worst-case tolerance for \( Y \) by simply performing interval operations on the worst-case tolerances for the inputs. This results in:

\[ Y = \log (X_1 + X_2) = \log ([1,2] + [3,4]) = \log([4,6]) = [\log(4), \log(6)] = [0.602, 0.778] \]

The resulting interval gives the minimum and maximum. Determining maximum and minimum cannot really be this easy can it?

The spoiler is that this approach only works if each input appears in the equation exactly once. Take as an example \( Y = X - X \). In this case \( Y \) is always zero. Therefore, the maximum and minimum of \( Y \) when \( X \) is between 1 and 2 is also zero. However:

\[ Y = X - X = [1,2] - [1,2] = [-1,1] \]

The resulting interval contains zero but does not equal zero.

In general, interval calculations bound the minimum and maximum. They may be wider than necessary when variables appear more than once in the equation. This is because interval calculations treat each occurrence of a variable as a new variable which can vary independent of all others.

The saving grace is the fundamental law of the interval analysis. It states that as the size of the interval shrinks, the calculated bound converges to the true bound. This allows optimization to be performed by splitting the intervals. After each split, those intervals that cannot contain the maximum or minimum are discarded. The remaining intervals are split again. This continues until the desired accuracy is achieved. Further details can be found in Snyder (1992).

The key feature of this approach is that it bounds the true maximum or minimum each step of the way. As the optimization proceeds, the message box displays these bounds. The optimization is set to terminate when two significant digits are assured. Bounding the maximum or minimum to 2 digits accuracy generally results in 3 or 4 digits accuracy.
6.4 Optimization Options

The Optimization Options dialog box shown below is used to change the termination conditions for the two methods of optimization. It is displayed by clicking on the Options button of the Find Optimal Targets dialog box.

There are two tabs, **Simplex tab** and **Interval tab**. Different termination conditions can be entered for each method of optimization.

The **Stop when relative error below edit box** is used to specify the relative error. Optimization terminates when the relative error is less than the specified value. For the interval method, the relative error is guaranteed to be below the value specified. Generally it is significantly better. The default value is 0.01 ensuring two significant digits.

For the simplex method, the relative error is estimated using the corners of the current simplex. This underestimates the relative error because these corners do not generally bound the optimum. The default value is 0.0000001 which frequently results in 4 or 5 significant digits. However, there is no guarantee and it is possible for the simplex method to terminate with only one or no significant figures.

The **Stop after number trials edit box** is used to specify the maximum number of trials to allow before forcing the optimization routine to end. The optimization terminates when the number of trials exceeds the specified number even if none of the other termination conditions have been met. For the interval method, a trial is a splitting of an interval. For the
simplex method, a trial is a contraction, expansion or shifting of the simplex. In both cases
the default value is 100,000.

The **Stop when below edit box** is used to terminate the optimization when it appears to be
converging to zero. The optimization terminates when the magnitude (absolute value) of the
optimum is bounded below the specified value. This prevents the algorithm from fruitlessly
trying to meet the relative error criteria when the optimum is zero. For the interval method,
the magnitude of the optimum is guaranteed to be below the specified value. For the simplex
method, the optimization terminates when the magnitude of all corners of the simplex are
below the specified value. This does not provide a guarantee. In both cases the default value
is 1.0 \(10^{-40}\).

The **Stop when above edit box** is used to terminate the optimization when it appears to be
converging to either infinity or negative infinity. The optimization terminates when the
magnitude (absolute value) of the optimum is bounded above the specified value. This
prevents the algorithm from fruitlessly trying to meet the relative error criteria when the
optimum is ±infinity. For the interval method, the magnitude of the optimum is guaranteed
to be above the specified value. For the simplex method, the optimization terminates when
the magnitude of all corners of the simplex are above the specified value. This does not
provide a guarantee. In both cases the default value is 1.0 \(10^{40}\).

When the desired termination conditions have been entered, click on the **OK button** or press
the **Enter** key to save the values and close the **Optimization Options** dialog box. If illegal
values are specified for any of the options, a message is displayed and the user is asked to
correct the problem first.

To exit without saving the changes click the **Cancel button** or press the **Esc** key. Clicking
the **Default button** resets all options to their default values. Clicking the **Help button**
displays help on using the **Optimize Options** dialog box.
Optimization of the input targets results in a robust design. This reduces the variation or width of the tolerance of the outputs. However, there is no guarantee that robustness alone will allow you to achieve the desired results. Following optimization, further improvements must be achieved by tightening tolerances of the inputs. Deciding which input tolerances to tighten and by how much requires knowledge of the relative costs of tightening the different tolerances as well as the effects of tightening the tolerances. The effects of tightening the tolerances can be determined using the Pareto Chart window.

### 7.1 Pareto Chart Window

The Pareto Chart window is a child window used to display the contributions of individual input variables to the variation or tolerance of a selected output variable. It is displayed by clicking on the button on the toolbar. This is a shortcut for the Pareto Chart of Variation menu item on the Analysis menu. If there is only one output, the results will be displayed immediately. If there is more than one, a menu will appear as shown below for specifying which variable to display the results for.

![Pareto Chart Window](image)

An example of the Pareto Chart window is shown on the next page. It has 4 tabs containing the results. Click on the X in the upper right corner to close this window.

The Pareto Chart window automatically updates itself when information affecting the displayed results is changed. When the program is in immediate update mode, the updates occur immediately following the change being made. If the program is in delayed update mode, the Pareto Chart window draws a red X through itself when it is not current. Clicking on the window will cause it to update and redraw itself. The update mode is selected using the Options menu.

Double clicking on the title in the window displays the variable’s Output Variable dialog box. Double clicking on any of the inputs displays their Continuous Input Variable dialog box. These are shortcuts to selecting the Edit menu item on the Variables menu.
The buttons and controls at the bottom can be hidden by removing the check from the *Show Buttons* menu item on the *Options* menu. When hidden, the popup menu can still be used to perform the functions of these buttons and controls. To display the popup menu, right mouse click over the graphic. The following buttons and controls are available:

- **Options**
  - Clicking this button displays the popup menu associated with this window. This popup menu has menu items that correspond to each of the buttons shown at the bottom of the window. It also has items that can be used to change how the graphic is sized within the window. A short cut is to right mouse click on the graphic.

- **Print**
  - Prints the graphic on the selected tab. Shortcuts are to click the *Print* button on the toolbar or to select the *Print* menu item on the *File* menu.

- **Copy**
  - Copies the graphic on the selected tab to the clipboard in graphic format. Shortcuts are to click the *Copy to Clipboard* button on the toolbar or to select the *Copy to Clipboard* menu item on the *File* menu.

- **Help (F1)**
  - Displays help on using this window. Short cut is to press *F1* key.

**Lock check box:** Checking this box locks the window so that it does not update as changes are made to the variables. Locking the window causes a complete copy of the I/O System to be saved. It also causes the *Restore* button to be displayed which can be used to restore the I/O System to the state it was in when the *Lock* check box was clicked. Unlocking a window deletes the saved copy of the I/O System.
Note edit box: Used to enter a note that appears on the caption bar. It is primarily intended to be used when the window is locked to describe the version of the design being displayed.

This button is only displayed when the window is locked. Clicking it restores the I/O System to the exact state it was in when this window was locked.

Tab 1: Percent Reduction

The first tab graphically displays the percent reduction in the width of interval for values of the output variable that results from tightening the tolerance of each of the individual input variables. The original interval for values of the output variable is shown at the top and is the same as shown on the Capability Study window. The inputs are listed in order of importance. For example, B has the largest effect making it the VIP. Tightening its tolerance can shorten the interval for values of the output by about 50%.

For exact values, see the third tab.

Tab 2: Transmitted Variation

Tab 2 graphically displays the variation transmitted by each input variable to the output variable along with the total variation of the output variable. The interval for values of the output variable is shown at the top and is the same as shown on the Capability Study window. The figure at the right of the chart represents this interval. The figures for the inputs represent the variation transmitted by each input individually, not taking into account interactions. The inputs are listed in order of importance. For exact values, see the third tab.
Tab 3: Table

Tab 3 displays in tabular form both the transmitted variation and percent reduction in the total variation of each input variable. The interval for values of the output variable is shown at the top and is the same as shown on the Capability Study window. Each row in the table shows the results of setting that input tolerance width to zero, while leaving all the other input tolerances at their original values. The resulting interval for values for the output variable is shown along with the percent reduction in the width of the original interval for values. Also shown is the transmitted variation for each input. This the width of the resulting interval for values for the output due to a single input variable alone. The values in this table were used to construct the graphics on first two tabs.
Tab 4: Plot for Input

Tab 4 displays a plot of the effect of tightening the tolerance of one of the inputs on the width of interval for values of the output variable. The input plotted is initially that having the largest effect. The input plotted can be changed using the Input to Plot menu item on the associated popup menu. This popup menu is displayed by clicking the Options button or right mouse clicking over the plot. For worst case tolerances, the plots are linear. For statistical and process tolerances, the plots are curved.

On Tab 3 we saw that tightening the tolerance for B to zero (100% reduction) resulted in a 52% reduction in the width of the interval of values for F. In the plot above, we can see that tightening the tolerance for B by 50% shortens the interval of values for F by around 30%.

In both the table and graphics, the inputs are listed in order of importance. The top or left-most inputs have the largest effects. If tolerances must be tightened, these are the inputs one should begin with. Of course one should also consider the costs associated with tightening each tolerance to obtain the best value.

To tighten a tolerance associated with an input, double click on that input in the graphic or table. A Continuous Input Variable dialog box showing this input is displayed for editing. Whenever a tolerance is changed, the process should be re-optimized. Remember when performing an optimization you are finding the best targets for the specified set of tolerances. The Pareto chart assumes all categorical input variables are at their selected categories.
7.2 Working With More Than One Design

VarTran allows you to play “What if?” games. What effect does changing to a $2 dollar value have? How about a $20 motor? It is a good idea to save each design so that they can be compared and you can revert back to a previous design. To save a copy of the design, lock a Capability Study window, a Pareto Chart window or a Summary Table window as shown below.

Locking a window saves a copy of the design at the point the window was locked. It also adds a Restore button. Clicking the Restore button resets the current design back to the point that the window was locked. It is a good idea to enter a note in the slot provided to keep track of the designs. To lock several windows at once and give them all the same description, use Lock All Unlocked Windows... menu item on the Analysis menu. The original design has a worst-case $C_{pk}$ of 0.4 and is 2.70 sigma. It needs improvement.

Now suppose we go ahead and optimize the design. We can open a new Capability Study window to view the design as shown on the next page. Once again we might want to lock it and add a label. The $C_{pk}$ has improved to 1.20 and the sigma level to 5.10. It is still not Six Sigma.
Next we can explore the tolerances and decide which to tighten. The Pareto chart is shown below. Tightening Motor Speed (S) has the biggest effect. This requires the use of the $20 motor. Value Backflow (B) has a smaller effect but is considerably cheaper. We will explore both options.

Entering the tolerances for the $20 motor and repeating the optimization improves the $C_{pk}$ to 1.80 and the sigma level to 7.17. This meets our objective but requires adding $15 to the cost of the design ($5 motor to $20 motor).
Entering the tolerances for the $2 value and repeating the optimization improves the Cpk to 2.31 and the sigma level to 8.43. This meets our objective while only adding $1 to the cost of the design ($1 valve to $2 valve). This is the better option.
Now we have four different designs displayed: the original, the optimized without tightening any tolerances, the $20 motor and the $2 value. We can switch between the designs by clicking the *Restore* buttons on each of the *Capability Study* windows. Closing a *Capability Study* window erases the design associated with that window. Saving the file saves all four versions of the design together.
The optimizations performed by VarTran make it easy to determine the optimal targets. Understanding why these targets are best is much more difficult. Effects tables and plots can be used to help you develop an understanding of why?

### 8.1 Effects Tables

Effects tables are used to determine which variables have the largest effects on the average and the variation. It also helps to identify when strong nonlinear effects and interactions are present which need to be understood. Using the effects table, you can determine which plots are of greatest interest.

The *Effects Table* window is a child window used to display the effects that changing the targets of individual inputs has on the average, standard deviation and coefficient of variation (CV) of the selected output variable or the value of the selected objective function. It is displayed by clicking on the button on the toolbar. This is a shortcut for the *Effects Table* menu item on the *Analysis* menu. If there is only one output or objective function, the results will be displayed immediately. If there is more than one, a menu will appear as shown below for specifying which variable to display the results for.

An example of the *Effects Table* window is shown on the next page. It has 2 tabs containing the results. Click on the X in the upper right corner to close this window. Double clicking on a variable in the window displays the variable’s dialog box for editing. This is a shortcut to selecting the *Edit* menu item from the *Variables* menu.

The *Effects Table* window automatically updates itself when information affecting the displayed results is changed. When the program is in immediate update mode, the updates occur immediately following the change being made. If the program is in delayed update mode, the *Effects Table* window draws a red X through itself when it is not current. Clicking on the window will cause it to update and redraw itself. The update mode is selected using the *Options* menu.
The buttons and controls at the bottom can be hidden by removing the check from the *Show Buttons* menu item on the *Options* menu. When hidden, the popup menu can still be used to perform the functions of these buttons and controls. To display the popup menu, right mouse click over the graphic or table. The following buttons and controls are available:

Clicking this button displays the popup menu to the right associated with this window. This popup menu has menu items that correspond to each of the buttons shown at the bottom of the window. It also has items that can be used to change how the graphic is sized within the window. A short cut is to right mouse click on the graphic.

Prints the graphic or table on the selected tab. Shortcuts are to click the *Print* button on the toolbar or to select the *Print* menu item on the *File* menu.

Copies the graphic or table on the selected tab to the clipboard in graphic format. Shortcuts are to click the *Copy to Clipboard* button on the toolbar or to select the *Copy to Clipboard* menu item on the *File* menu.

Displays help on using this window. Short cut is to press *F1* key.

**Tab 1: Diagram**
The first tab shows the results in diagram form. The first column lists the terms. Both linear and quadratic effects are calculated for each input as well as interaction effects for all possible interactions between two inputs. These interaction effects are denoted with an * separating the symbols of the two inputs. An interaction between two variables is when their combined effect either exceeds or is below their individual effects.

The second column shows the effects of the different terms on the flow rate average. The effects are calculated by adjusting each input’s target over the region bounded by the minimum and maximum targets specified in the Continuous Input Variable dialog box. The longer the bar is, the greater the effect. The maximum effect shown at the bottom of the column is the size of the effect of the term with the longest bar.

The third column shows the effects that changing the input targets has on the flow rate standard deviation. Achieving robust designs requires identifying inputs whose targets affect the output's standard deviation. The targets of these inputs are generally set to minimize the variation. The targets of the other inputs are then set to achieve the desired average.

The last column shows the effects of the inputs on the flow rate coefficient of variation or CV for short. CV is the standard deviation divided the average. On many processes, the variation increases as the averages does. Therefore all inputs that affect the average also affect the standard deviation. One can achieve a robust design if one can identify an input that affects the CV. Setting this input to minimize the CV reduces the variation for a given average.

**Tab 2: Table**

The second tab shows the results in table form. Everything appears the same except the bars are replaced with numbers. The linear effects for the inputs represent the amount that the output characteristic (average, standard deviation, or CV) changes as the target for the input is adjusted from minimum target to the maximum target in the Input Variable dialog box. The quadratic effects represent the distance the value at the midpoint deviates off of a straight line drawn between the values at the minimum and maximum targets. The interaction effect is calculated using the four high/low combinations of the two inputs involved. Three of the points are used to predict what the forth point would be if there was no interaction effect, i.e., if the effects where additive. The interaction effect represents the distance between what one would expect at this fourth point and its actual value. The effects table assumes all categorical variables are at their selected categories.

Since the effects are calculated over the region defined by the minimum and maximum targets in the Input Variable dialog box, changing these values will change the effects table. Wide regions should be selected for the input targets. However, care should also be taken to exclude impossible values such as a radius of zero and a motor speed of zero.
The general strategy is to start with those inputs affecting the variation. Their targets are set to reduce the variation in order to achieve a robust design. Then the targets of those inputs affecting the average but not the variation are set to optimize the average. Finally, if inputs exist affecting neither the average nor the variation, their targets are set to their low cost values in order to minimize costs.

As a general rule, if the average and standard deviations sections appear different, then use those two columns and ignore the CV. If the average and standard deviation sections appear very similar, then ignore the standard deviation and use the average and CV columns.

Examining the effects tables for flow rate given previously, you should notice that the average and standard deviation columns look similar. Those variables with large effects on the average also have large effects on the standard deviation. Looking in the CV column you should notice that motor speed (S) does not have much of an effect on the CV. The linear and quadratic terms as well as all its interactions (R*S, L*S, B*S) have minimal effects. This suggests the strategy of setting the targets of the other three inputs to minimize the CV. Then adjust the target of motor speed to achieve the desired target. This important information indicates that if in the future we wanted to design the pump to deliver a different flow rate or wanted to add an adjustment for flow rate, we should use motor speed to make the adjustment. To gain further understanding, it would be useful to plot the effects of piston radius (R), stroke length (L), and valve backflow (B) on the CV as well as plot of the effect of motor speed on the average. Using the effects table and plots to develop a better understanding requires patience but can yield enormous benefits.
8.2 Plots Dialog Box

The *Plots* dialog box is used to quickly view different plots of the effects of the inputs on the output variables and objective functions. Plots of particular interest can then be transferred to their own window and modified as desired. The effects table in the previous section is useful in determining which plots will be most meaningful. To display the *Plots* dialog box, click on the button on the toolbar. This is a shortcut for the *Plots*... menu item on the *Analysis* menu. The dialog box shown below will then appear.

![Plots Dialog Box](image)

The *Type of Plot* radio buttons are used to specify whether a line, interaction or contour plot is desired. Line plots are easiest to interpret but can be misleading in the event of strong interactions. Generally you should get interaction or contour plots for those pairs of input variables involved in strong interactions. Then obtain line plots for the remaining input variables not involved in any interactions.

Next you need to specify the variables to plot. The *Output list box* is used to select the output variable or objective function to plot. You also need to specify the continuous input variables. A line plot requires a single input variable. Interaction and contour plots require two input variables. The *Input 1 list box* is used to select the first input variable. For all three types of plots this input variable appears along the bottom axis. The *Input 2 list box* only appears if you have selected an interaction or contour plot. For interaction plots, several...
lines appear on the plot representing different values of this input. For contour plots, this input appears on the y-axis.

The Characteristic radio buttons are used to specify the characteristic of the specified output variable or objective function that is to be plotted. For output variables, the following characteristics are available: value, average, standard deviation, percent defective, \(C_p\), \(C_c\), \(C_{pk}\), Z-Score, CV, \(C_{pm}\), root MSE, distance inside spec, distance from target, lower end of interval of values and upper end of the interval of values. Plotting the output’s value plots the equation for the output exactly as entered in the Output Variable dialog box. While all these characteristics are available, not all will be appropriate for your particular problem. For example \(C_{pk}\) requires at least one specification limit and the use of statistical or process tolerancing. Selecting a characteristic that is not defined results in a blank plot. For an objective function, the only characteristic available is the value.

The plots are initially scaled based on the minimum and maximum targets specified in the Continuous Input Variable dialog box. All plots are drawn assuming the inputs not included in the plot are at their selected target or selected category. The value of these inputs is displayed along the right edge of the plot. The characteristics percent defective, \(C_p\), \(C_c\), \(C_{pk}\), Z-Score, CV, \(C_{pm}\), root MSE, distance inside spec, distance from target, lower end of interval of values and upper end of the interval of values are calculated ignoring any worst-case tolerances. The values plotted represent their values when all inputs are on target.

The Plots dialog box is used to quickly view a variety of plots. You can save a copy of a plot by clicking on the Windows button. Pressing this button displays a copy of the plot in a separate Plot window. This allows multiple plots to be viewed at the same time. The Plot window is described in the next section. Once in the Plot window, almost every aspect of the plot can be modified including changing the values of the inputs variables not included in the plot.

The Plots dialog box differs from most dialog boxes in that it may be left open and multiple copies can be opened at once. It is in fact a child window which can be minimized, shown in the background, etc. The Plot dialog box draws a red X through the plot when it is not current. Clicking on the dialog box will cause it to redraw itself. To close the Plots dialog box, click the Close button or press the Esc key. Other buttons are:

- Print: Prints the plot. Shortcuts are to click the Print button on the toolbar or to select the Print menu item on the File menu.
- Copy: Copies the plot to the clipboard in graphic format. Shortcuts are to click the Copy to Clipboard button on the toolbar or to select the Copy to Clipboard menu item on the File menu.
- Help (F1): Displays help on using this window. Short cut is to press F1 key.
8.3 Plot Window

The Plot window is a child window used to display plots. To create a Plot window, click on the Windows button in the Plots dialog box as described in the preceding section. An exact copy of the displayed plot will be copied to a new Plot window. You can create as many Plot windows as you like.

Once in the Plot window you can modify the plot including rescaling, changing the values of any off-axis input variables and changing the style. To change an item, double click on it or select the Plot Options menu item from the popup menu associated with the Options button. The buttons are:

Clicking this button displays the popup menu to the right associated with this window. This popup menu has menu items that correspond to each of the buttons shown at the bottom of the window. It also has items that can be used to change how the graphic is sized within the window and for changing the plot options. The Plot Options menu item display the Plot Options dialog box described in the next section. The Number Lines menu item also displays the Plot Options dialog box with the tab displayed for changing the number of lines on either an interaction or contour plot. It only appears on the popup menu for these two types of plots. A short cut is to right mouse click on the plot.
Prints the plot. Shortcuts are to click the Print button on the toolbar or to select the Print menu item on the File menu.

Copies the plot to the clipboard in graphic format. Shortcuts are to click the Copy to Clipboard button on the toolbar or to select the Copy to Clipboard menu item on the File menu.

Displays help on using this window. Short cut is to press F1 key.

You cannot change the inputs or output variables plotted in a Plot window. A new plot must be generated using the Plots dialog box. Further, the Plot window will automatically close itself if a change is made to the I/O system that makes it impossible to update the plot. Examples include the deletion of one of the variables plotted and a change in an equation that adds or removes an input.

The Plot window draws a red X through itself when it is not current. Clicking on the window will cause it to redraw itself. All plots are drawn for the currently selected category of any category input variables. If a new category is selected, the plot is updated.

Plot Options Dialog Box

Selecting the Plot Options menu item from the popup menu associated with the Options button displays the Plot Options dialog box shown on the next page. There are up to nine tabs displayed for changing different features of the plot. The tabs are summarized in the table below. Most of these tabs can be displayed automatically by double clicking on the appropriate part of the plot. For example, to display the Title tab, double click on the title.

<table>
<thead>
<tr>
<th>Tab</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title</td>
<td>Changes title text and style.</td>
</tr>
<tr>
<td>Axis Style</td>
<td>Changes the axis style, tic mark style and the plot's aspect ratio.</td>
</tr>
<tr>
<td>Y-Axis</td>
<td>Changes y-axis label, scale, style and orientation.</td>
</tr>
<tr>
<td>X-Axis</td>
<td>Changes x-axis label, scale and style.</td>
</tr>
<tr>
<td>Key</td>
<td>Used to specify whether to display the key and for setting style options.</td>
</tr>
<tr>
<td>Lines</td>
<td>Changes the labels, values and styles associated with the lines.</td>
</tr>
<tr>
<td>Off-Axis</td>
<td>Changes the value and labels of the off-axis variables. The off-axis variables are those continuous input variables not displayed on an axis. This tab only appears if there are off-axis variables</td>
</tr>
<tr>
<td>Comments</td>
<td>Changes the comments displayed on the plot. The comments describe the selected levels of category input variables. This tab only appears if there are category input variables.</td>
</tr>
<tr>
<td>Other</td>
<td>Changes the resolution of the plot, whether to automatically update axis scales, and the number of lines.</td>
</tr>
</tbody>
</table>
When you are done, click the OK button to close the dialog box and update the plot. An alternative is to press the Enter key. Clicking the Cancel button instead closes the dialog box without saving any changes. An alternative is to press the Esc key. The Help button provides help concerning the Plot Options dialog box.

**Plot Options Dialog Box – Title Tab**

The Title tab is used to change the text, color and size of the title and subtitle at the top of the plot. Double clicking on the title displays this tab.

The Main Title edit box is used to change the text for the main title. It may be left blank if no title is desired. The Main Title Size combo box is used to select the size for displaying the main title. Normal size is the same size as the system font. The default is twice the normal size. You can select one of the values in the list or type your own value. Entering a value of 1.3 results in the title being 1.3 times normal size. The Main Title Color list box is used to change the color of the main title.

The Sub Title edit box, Sub Title Size combo box and Sub Title Color list box are used to enter an optional subtitle. By default it is blank. They work the same as the main title controls.

**Plot Options Dialog Box – Axis Style Tab**

The Axis Style tab is used to change the axis style, tic mark style, tic mark size and the plot’s aspect ratio.
The *Axis Style radio buttons* are used to select one of four different axis styles. The *Tic Style radio buttons* are used to select from three different tic styles. Tic marks can appear next to the values on an axis as well as in between values. The *Tic Size Number or Label combo box* is used to select the size for displaying tics marks appearing next to values. The *Tic Size Between combo box* is used to select the size for displaying tics marks appearing between values. The default is to make the tic marks appearing next to values 0.4 times normal size and the tic marks appearing between values smaller at 0.2 times normal size.

The *Ratio X-Axis to Y-Axis edit box* is used to change the plot’s aspect ratio. A value of 1 results in a square plotting region. A value of 2 makes the x-axis twice as long as the y-axis. A value of 0.5 makes the x-axis half as long as the y-axis. The y-axis size remains fixed.

**Plot Options Dialog Box – Y-Axis Tab**

The *Y-Axis tab* is used to change the y-axis label, scale, tic marks and orientation. Double clicking on the y-axis displays this tab.

The *Text edit box* is used to change the axis label. By default this is the symbol of the variable displayed on the y-axis. The *Label Size combo box* is used to select the size for displaying the axis label. The default is 1.5 times normal size. The *Display Label Vertically check box* allows the label to be displayed either vertically or horizontally.

The *Minimum Value* and *Maximum Value edit boxes* are used to change the scale of the y-axis. The minimum value must be less than the maximum value. When changing the scale, automatic scaling should be on to avoid shifting the lines or contours off the edge of the plot. Automatic scaling is turned on and off using the *Other tab*. The *Value Size combo box* is used to select the size for displaying axis values. The default is normal size.
The **Number of Values on Axis edit box** is used to change the number of values displayed along the y-axis. The minimum is two. The default is 3. The **Number of Tics Between Values edit box** is used to change the number of tic marks displayed between each value on the y-axis. A value of zero can be entered. The default is 4.

**Plot Options Dialog Box – X-Axis Tab**

The **X-Axis tab** is used to change the x-axis label, scale and tic marks. Double clicking on the x-axis displays this tab. It functions identical to the **Y-Axis tab** except it affects the bottom or x-axis.
Plot Options Dialog Box – Key Tab

The Key tab is used to change the key title and style. On an interaction plot, the key describes how the lines correspond to the different values of the second input variable. For a contour plot, the key describes which value of the output each line represents. Double clicking on the key title displays this tab.

![Plot Options Dialog Box]

The Key Title edit box is used to change the text for the key title. It may be left blank if no title is desired. The Key Title Size combo box is used to select the size for displaying the key title. Normal size is the same size as the system font and is the default size. You can select one of the values in the list or type your own value. Entering a value of 1.3 results in the title being 1.3 times normal size. The Key Title Color list box is used to change the color of the key title.

The Display Key To Line check box is used to specify whether to display the key to the lines. Generally the key is desired but can be removed for purposes of printing and copying to the clipboard. The Size of Line Labels in Key combo box is used to select the size for displaying the line labels in the key. The default is normal size.

Plot Options Dialog Box – Lines Tab

The Lines tab is used to change the label, style and value of a line on either an interaction or contour plot. A short cut is to double click on the key for the lines. Double clicking on a line in either the plot or key displays this tab.
The Line tabs are used to select which line to change. The values displayed in the other controls are for the line whose tab is selected.

The Label edit box is used to change the label shown next to the line in the key for lines. The Color list box is used to change the color of the line. The Style list box is used to select the line style. If a line style other than a solid line is selected, the line thickness is set to hairline. The Thickness combo box is used to change the line thickness of solid lines. Only solid lines can have a thickness other than hairline. If a thickness other than hairline is selected, the line style will be set to solid.

The Value edit box is only shown for interaction plots and contour plots. It is used to change the values associated with the line. For interaction plots, this value represents the value of the second input selected. For contour plots, this value represents the value of the output associated with the contour.

Plot Options Dialog Box – Off-Axis Tab

The Off-Axis tab is used to change the values of continuous input variables that are not displayed along an axis. Double clicking on an off-axis variable in the key displays this tab.

The Size of Off-Axis Variables combo box is used to select the size for displaying the off-axis variables in the key. The Display Off-Axis Variables check box is used to specify whether to display the values of off-axis variables in the key. Generally this information is desired but can be removed.

The Variable tabs are used to select which off-axis variable to change. The values displayed in the other controls are for the off-axis variable whose tab is selected.
The **Name edit box** is used to change the name of the off-axis variable. This field is initially set to the variable's symbol. The **Value edit box** is used to change the value of the off-axis variable. This field is initially set to the current target. Changing the values of the off-axis variables can dramatically alter the shape of the plot if the variable changed interacts with the plotted inputs. When changing off-axis variables, automatic scaling should be on to avoid the lines or contours from shifting off the plot. Automatic scaling is turned on and off using the **Other** tab.

### Plot Options Dialog Box – Comments Tab

The **Comments** tab is used to change the comments displayed to the right of the plot. VarTran uses these comments for displaying the selected levels of the category input variables. Double clicking on a comment displays this tab.

The **Size of Comments combo box** is used to select the size for displaying the comments. The default is normal size. The **Display Comments check box** is used to specify whether to display comments on the key. Generally this information is desired but can be removed.

The **Comment tabs** are used to select which comment to change. The **Comment edit box** is used to change the text of the comment on the selected tab. This does not change the selected category of the category input variables. That must be done using the **Category Input** dialog box.
Plot Options Dialog Box – Other Tab

The *Other* tab is used to change whether automatic scaling is performed, the plot’s resolution and the number of lines.
The **Automatic Scaling check box** is used to select whether automatic scaling is active. Changing an off-axis variable, the x-axis scale and so on can cause the curves to shift so that they are no longer visible on the plot. Automatic scaling automatically changes the plot's scales whenever such a change occurs so that the curves remain visible. For line and interaction plots the y-axis changes whenever the x-axis, an off-axis variable or a category input variable changes. For contour plots, the contour values change whenever the x-axis, y-axis, an off-axis variable or a category input variable changes. Uncheck this box if you want to override the default scaling.

The **Resolution list box** is used to select the plot’s resolution. For line and interactions plots, the resolution is the number of points used to construct the curve. For contour plots, the resolution is the number of points along each axis used to construct the grid for locating the contours. The default is low resolution which speeds up the drawing of the plots. Higher resolutions can be used to produce smoother plots.

The **Number of Contours/Lines edit box** is used to change the number of lines for interaction plots and the number of contours for contour plots. The number of lines entered must be at least 2. For interaction plots, the default is 3. Generally 2-3 is best. For contour plots, the default is 5. Generally 5-10 looks best.

### 8.4 Checking Results Using Simulations

VarTran analytically derives equations for the average and standard deviation of the output variables. These equations can be viewed using the **View Equations** dialog box. Some approximation is involved in deriving these equations. A simulation can be performed to check the accuracy of the derived equations.

The **Simulation** dialog box is used to simulation to behavior of the outputs for comparison with the analytic results. The results of the simulation can be viewed using the **Summary Tables** and **Capability Study** windows. The **Simulation** dialog box is displayed by clicking on the **button on the toolbar. This is a shortcut for the Simulation... menu item on the **Analysis** menu.

The **Number Trials edit box** specifies the number of trials to perform. For each trial, random values are generated for each of the input variables and the resulting values of the output variables calculated. The default number of trials is 100,000. This is the recommended number of trials. Minimally 10,000 trials should be performed. To perform a smaller number of trials, it is not necessary to change this value. Just begin the simulation and halt it when sufficient trials have been completed.

Click on the **Simulation button** to begin the simulation. The simulation will run until the specified number of trials has been performed. The message window displays the progress. The simulation can be stopped at any time by clicking on the **Halt button.** The **Halt** button is only displayed while the simulation is being performed. It does not initially appear on the dialog box.
For statistical tolerances, the simulation is performed at the current set of targets for the continuous input variables and the currently selected categories for the category input variables. For process tolerances, three simulations are performed: one at the current targets, one at the targets producing the minimum average and one at the targets producing the maximum average. The targets producing the minimum and maximum averages are displayed on the third tab of the Capability Study window. Simulations are not performed for worst-case tolerances.

Once the simulations are completed, the results can be viewed by clicking on the View Results button. A Summary Tables window is displayed showing the results of simulation along with the predicted values using the analytic approach. See Section 4.8 for further information on interpreting the summary table. The simulation results are also shown on the second tab of the Capability Study window as described in Sections 5.3 to 5.5. If discrepancies exist between the simulated values and analytic values, consider choosing a different method for estimating the average and standard deviation using the Output Variables dialog box.

The Close button is used to close the Simulation dialog box without viewing the results. A short cut is to press the Esc key. Pressing the Reset button causes previous simulation results to be deleted. This allows a new simulation to be run from scratch. Otherwise, new trials will be added to the previous trials. Clicking the Help button displays help on using the Simulation dialog box.
Performing a variation transmission analysis requires an equation for how the inputs affect the outputs. If you cannot obtain this equation any other means, you can always obtain it using a designed experiment such as a response surface study. This section addresses some of the special issues involved with performing a robust tolerance analysis following a designed experiment.

### 9.1 Types of Equations

VarTran allows two types of equations: the equations associated with output variables and the equations associated with objective functions. What is the difference between these two types? The equations associated with output variables are the direct result of the physical laws of nature. They describe how the values of the inputs affect the value of the output. For example, the equation for the area of a rectangle is:

\[
\text{Area} = \text{Width} \times \text{Length}
\]

For a particular rectangle, if its length is 2” and its width is 3”, then its area is 6”. This equation applies to individual units of product. Such equations will be referred to as value equations.

The equations associated with objective functions, on the other hand, do not deal with individual units of product. Instead they deal with properties of the inputs and outputs. For example, one objective function is:

\[
\text{OF} = \text{Minimum} [\text{O1}\{\text{Cpk}\}, \text{O2}\{\text{Cpk}\}]
\]

This equation is defined in terms of the \(C_{pk}\) of the output variables \(O1\) and \(O2\). It does not make reference to individual values of these two outputs. Instead it references their behavior. Such equations will be referred to as property equations.

Two other examples of property equations are given below:

\[
\text{Area}\{\text{Average}\} = \text{Width}\{\text{Average}\} \times \text{Length}\{\text{Average}\}
\]

\[
\text{Area}\{\text{SD}\} = \text{SquareRoot} [\text{Length}\{\text{Average}\}^2 \times \text{Width}\{\text{SD}\}^2 + \text{Width}\{\text{Average}\}^2 \times \text{Length}\{\text{SD}\}^2 + \text{Width}\{\text{SD}\}^2 \times \text{Length}\{\text{SD}\}^2]
\]
These equations represent the average and standard deviation of the area of a rectangle as a function of the averages and standard deviations of width and length. VarTran derives these two property equations from the value equation given above.

Now let us consider what happens when a designed experiment is run. Suppose a response surface study was run on a heat seal machine to investigate the effect that time and temperature has on seal strength. The following equation was obtained

\[ SS = b_0 + b_1 \text{TIME} + b_2 \text{TEMP} + b_3 \text{TIME}^2 + b_4 \text{TEMP}^2 + b_5 \text{TIME} \times \text{TEMP} \]

where \( SS \) = seal strength and \( b_0 \)-\( b_5 \) are constants estimated by the response surface study. What type of equation is this: a value equation or a property equation? The response surface study was run by adjusting the two inputs to different target combinations. For each set of targets a number of seals were produced, tested and the average of these results calculated. The above equation was then fit to these averages. In which case this equation describes how the targets of the inputs affect the average of the output. It is in fact a property equation. It is more correctly written as:

\[ SS_{\text{Average}} = b_0 + b_1 \text{TIME}_{\text{Target}} + b_2 \text{TEMP}_{\text{Target}} + b_3 \text{TIME}_{\text{Target}}^2 + b_4 \text{TEMP}_{\text{Target}}^2 + b_5 \text{TIME}_{\text{Target}} \times \text{TEMP}_{\text{Target}} \]

Frequently equations are also fit to the standard deviations of the outputs as well. This might result in a second property equation:

\[ SS_{\text{SD}} = c_0 + c_1 \text{TIME}_{\text{Target}} + c_2 \text{TEMP}_{\text{Target}} + c_3 \text{TIME}_{\text{Target}}^2 + c_4 \text{TEMP}_{\text{Target}}^2 + c_5 \text{TIME}_{\text{Target}} \times \text{TEMP}_{\text{Target}} \]

While the equation for the seal strength average is in fact a property equation, it generally closely approximates the underlying value equation. However, there are differences so this introduces some error. For the area equation on the previous page, the value equation and the property equation for the average are identical so no distinction is needed. For the pump example in Chapter 2, the value equation is:

\[ F = (16.388 \pi R^2 L - B) S \]

The property equation for the average is:

\[ F_{\text{Average}} = (16.388 \pi [R^2 L - B] \ A) S + 0.5 * (32.776 \pi S [A] \ L \ A) \ R [SD]^2 \]

where \( A \) denotes average and \( SD \) denotes standard deviation. These equations are not identical, although when plotted they are very similar.

Following a response surface study, VarTran can be used to two ways. First, it can be used to plot and optimize the resulting property equations for the average and standard deviation. This approach is referred to as the dual response approach and covered in Section 9.2. You can also treat the property equation for the average as a value equation and perform a robust tolerance analysis. This approach is covered in Section 9.3.
9.2 Dual Response Approach

To use the equations for the average and standard deviation directly, you should construct two objective functions, one for the average and one for the standard deviation. For the heat seal case study presented in Section 2.2, the objective functions for the seal strength average (SSM) and seal strength standard deviation (SSS) are shown below. Notice that the equations are written in terms of the targets of the inputs.

Transferring the equations from your response surface package is accomplished using the Paste button. This automatically constructs the inputs as well. For each input you will need to enter the current target plus the minimum and maximum targets. The minimum and maximum targets should be set to the edges of the study region. The current target can initially be set to the middle of the study region. It will be optimized later. The tolerances do not have to be entered.
In order to find the optimal targets, a third objective function should be constructed combining the average and standard deviation. One choice is to use $C_{pk}$ as shown below.

You can then use the *Find Optimal Targets* dialog box to maximize the value of the objective function $C_{pk}$. Once the optimization is completed, use the summary table to view the new settings of the inputs and a capability study to view the expected performance of the output. These are shown below.
You can also obtain effects tables and plots of these objective functions to further understand their relationships. Many design of experiment packages now have some ability to find optimal targets. However, most are based on desirability functions and do not have the ability to handle the variation and more complex objective functions like $C_{pk}$. VarTran can be a useful addition.

The dual response approach has two major weaknesses. First, it optimizes the process for the conditions that existed while the study was run. If the study’s variation is not representative of actual manufacturing variation, the wrong targets may result. For example, if only one roll of plastic sheeting was used, roll-to-roll variation of sheeting thickness is not captured in the study. Taguchi solves this problem by running noise arrays to mimic actual variation. However, this makes the study more expensive and complicated to run.

The second weakness of the dual response approach is that it does not identify the root cause of the variation (VIP). As a result it does not support the next step of tightening tolerances. Since there is no guarantee that the quality objectives can be met by robustness alone, the dual response approach frequently falls short of the final objective without guidance for how to proceed further.

VarTran can be used to overcome both these shortcomings. The real benefit of VarTran is not as an aid in performing the dual response approach to robustness, but as an alternative approach to achieving robustness which will be referred to as the tolerance analysis approach to robust design.

### 9.3 Tolerance Analysis Approach

The tolerance analysis approach only uses the equation for the average from the response surface study. It also requires additional information about how much the inputs vary during long term production. Based on this information, VarTran can perform a robust tolerance analysis to predict the behavior of the output, to find the optimal targets and to tighten tolerances as needed.

The tolerance analysis approach requires that an output variable be constructed based on the equation for the average from the response surface study. As shown on the next page, the property equation for the average has been converted to a value equation. Notice that the equations are written in terms of the inputs themselves and not their targets as before. Transferring the equations from your response surface package is accomplished using the *Paste* button.

The input variables must also by entered. This time tolerances must be entered which are representative of long term manufacturing, not the variation during the study. An example is shown on the next page. In this case a temperature transducer was used to continuously record the temperature over many days of production. Temperature was seen to fluctuate up and down 6 degrees from target. This included startups, following breaks, etc. and not just during steady production.
Once the data is entered, VarTran can be used to find the optimal targets, predict the capability, and determine the effects of the different tolerances. The optimal targets and the predicted capability are shown below.

In this case, the tolerance analysis approach produced results similar to those of the dual response approach in the previous section. This is because study conditions were representative of long-term manufacturing. Had this not been the case, the two approaches could produce very different results.
What the dual response approach did not find was the cause of the variation (VIP). The VIP can be identified by clicking on the Pareto Chart button. The result is displayed below. The VIP is dwell time. If the variation needed to be reduced further, only tightening the tolerance of dwell time would do any good.

![Pareto Chart](image)

The tolerance analysis approach using response surface studies has several important advantages over Taguchi’s approach based on inner/outer arrays and signal-to-noise ratios. First, the studies are less costly to run. Second, while both require knowledge of how the inputs behave, Taguchi uses this information to design the study. The tolerance analysis approach does not use this information until the analysis phase. This allows alternate sets of tolerances to be evaluated and optimized without requiring additional data.

The best practice is to use both the dual response and tolerance analysis approaches. Both approaches require exactly the same data to be collected. Comparison of the results can yield significant insights. For example, if the predicted variation from the tolerance analysis approach is below that actually observed by the dual response approach, it means an important source of variation was not included in the study.
This chapter covers the menus and toolbar. Many of the menu items have already been covered elsewhere. However, a few have not yet been described. This chapter explains those remaining menu items.

The menu bar contains the menus listed below.

**File menu:** Used to start a new I/O system, open an existing I/O system, save an I/O system, print and to exit the program.

**Variables menu:** Used to add and edit variables and display the information entered.

**Analysis menu:** Used to perform the various analyses.

**Window menu:** Used to rearrange the child windows or to select a particular child window.

**Options menu:** Used to specify options for calculating intervals for values, displaying buttons and the toolbar, and for updating the child windows.

**Help menu:** Used to display the help index, help on specific topics, registration and support information and the *About* dialog box containing copyright information.

### 10.1 File Menu

The *File* menu is the first menu on the menu bar. It is used to start a new I/O system, open an existing I/O system, save an I/O system, print and to exit the program. The first group of six buttons on the toolbar contains shortcuts for those menu items with icons (except for *Print Setup* and *Exit*). The available menu items are:
**New**

Starts a new session. Shortcut is Ctrl+N. First asks whether to save the current session.

**Open...**

Reads previously saved session from a file. The *Open File* dialog box is displayed for selecting the file to open. VarTran files have the extension "vta". Shortcut is Ctrl+O. You will first be asked whether to save the current session.

**Save**

Saves changes to a session back in the file which was originally opened to start the session. If no file is shown, the *Save As* menu item is invoked instead. The file associated with a session is displayed on the caption bar of the main window. Shortcut is Ctrl+S.
Save As... Saves the session in a new file. The Save File dialog box on the previous page is displayed for selecting the file to save the session in. An extension of "vta" will automatically be added to indicate it is a VarTran file. If the file already exists, prompts to prevent accidental overwriting.

Print Prints the contents of the displayed tab of the active child window. Shortcut is Ctrl+P.

Print Setup… Displays the Print Setup dialog box for selecting the printer to use and for changing printer options such as portrait versus landscape, paper size and paper source.

The Name list box is used to select which printer to print to. Clicking on the Properties button displays a dialog box for modifying printer options such as landscape versus portrait mode and the number of copies. When done, click on the OK button. To exit without changing the selected printer, click on the Cancel button.

Copy to Clipboard Copies the contents of the displayed tab of the active child window to the clipboard. Shortcut is Ctrl+C.

Exit Exits the program. First asks whether to save the current session. Same as double clicking the system menu button (icon in top-left corner) or clicking the close button (x in top-right corner). A shortcut is to press Alt-F4.
10.2 Variables Menu

The Variables menu is the second menu on the menu bar. It is used to add and edit variables and to display the information entered. The second group of four buttons on the toolbar provides short cuts for those menu items with icons. The available menu items are:

**Add**

Used to add a new variable. Displays menu for selecting type of variable shown below. The appropriate variable dialog box is then displayed so that the variable's information can be entered.

**Duplicate Variable…**

Displays Number Duplicate Copies dialog box for making duplicate copies of a variable in order to save time when there are a large number of similar variables that must be entered.

Select which variable to duplicate and specify the number of copies. Click the OK button or press the Enter key to close the
dialog box and make the duplicate copies. Clicking the Cancel button or pressing the Esc key instead closes the dialog box without duplicating a variable.

**Edit**

Displays additional menus for selecting a variable to edit as shown below. Shortcut is to double click on the variable in the I/O System window or any of the other child windows that displays information about the variables.

**Modify All Tolerances**

Displays additional menus for changing the tolerances of all continuous inputs variables at one time.

**I/O System Window**

If the I/O System window is closed, this menu item will open a new one. Otherwise it will make the I/O System window the top child window. See Section 4.7.

**Summary Tables**

Displays a new Summary Tables window for displaying the data entered for the variables. See Section 4.8.

**Notes Window**

Displays a Notes window for typing notes and comments.

An example of the Notes window is shown below. This child window is a text editor. The information typed into the Notes window is saved in the same file as the rest of the data. You can use it as a to-do list to keep track of what additional data is required. You can also enter a message before emailing the file to someone else.
10.3 Analysis Menu

The Analysis menu is the third menu on the menu bar. It is used to specify which analysis to perform. The third and fourth groups of buttons on the toolbar are shortcuts for the menu items from the Analysis menu. The available menu items are:

- **Find Optimal Targets...**
  Robust design option. Displays Find Optimal Targets dialog box for determining optimal targets. See Section 6.1.

- **Capability Study**
  Tolerance analysis option. Performs capability study on the selected output assuming inputs are at their current targets. Shows results in a Capability Study window described in Section 5.1.

- **Variation Pareto Chart**
  Sensitivity analysis option. Draws Pareto chart of the contributions of the individual inputs to the total variation for the selected output. Assumes the inputs are at their current targets. Shows results in a Pareto Chart window described in Section 7.1.

- **Simulation...**
  Displays Simulation dialog box for performing simulation of all outputs assuming inputs are at current targets. See Section 8.4.
Lock All Unlocked Windows... Locks all unlocked Capability Study, Pareto Chart and Summary Table windows. First displays Enter Note dialog box for entering a note to add to the windows being locked. See Section 7.2.

First enter a note to display on the newly locked windows. When done, click the OK Button. To exit without locking any windows, click the Cancel button.

Effects Table Draws effects table for the selected output. Shows result in Effects Table window. See Section 8.1.

Plot... Displays Plots dialog box for displaying plots of the effects of the inputs on the outputs. See Section 8.2.

### 10.4 Window Menu

The Window menu is the fourth menu on the menu bar. It is used to rearrange the child windows or to select a particular child window. A list of opened child windows is appended to the bottom of this menu. These can be used to select a child window. Selecting a child window brings it to the top. Clicking on a child window has the same effect but the menu items can be used when the child window is buried under other windows.

**Tile** Displays all the child windows in a tile pattern. The windows are reduced in size so that none of the windows overlap. A shortcut is to press shift+F4.

**Cascade** Stacks the child windows slightly offset from each other so that the caption of each window is visible. A shortcut is to press shift+F5.

**Arrange Icons** Places the icons of all child windows that are minimized along the bottom of the parent window.
10.5 Options Menu

The *Options* menu is the fifth menu on the menu bar. It is used to specify options for calculating intervals for values, displaying buttons and the toolbar and for updating the child windows. The available menu items are:

**Number of Standard Deviations for Intervals for Values**

Display the *Number of Standard Deviations for Intervals for Values* dialog box for specifying number of standard deviations to use when calculating intervals for individual values. The formulas appear in Sections 5.3 to 5.5.

The *Number Standard Deviations* combo box is used to enter a new value for the number of standard deviations. Type a value or select one from the list. Values are limited to the range 1.0 to 6.0. A value of 4.5 when combined with process tolerancing results in an interval for values that if it is inside the specification limits means that Six Sigma quality has been achieved. A value of 3 has been used historically in conjunction with statistical tolerancing but this practice results in high levels of defects.

Once the number of standard deviations has been entered, click the *OK* button to save the change. If the information entered is incorrect, an error message will be displayed. Otherwise the setting is updated and all effected child windows are notified of the change.

Clicking the *Make Default* button makes the value displayed in the *Number Standard Deviations* combo box the new default value. An error message is displayed if it is
not a valid number between 1.0 and 6.0. This new default value will effect all new sessions but does not effect previously saved sessions. It also will not effect the current session unless the OK button is also selected. Clicking the Cancel button closes the dialog box without making a change.

**Immediate Update Mode**
If checked, causes all child windows to be immediately updated following each change. This may result in slower execution if a series of changes are made or if numerous windows must be updated. Removing the check, delays updating child windows. When in delay update mode and a child window requires updating, a red X is drawn through it. Clicking on the window will cause the window to update itself. The top child window is always automatically updated. The delay update mode is the default mode and is in effect each time the program is started.

**Update Equations When Symbols Change**
If checked and the symbol for a variable changes, automatically changes all reference to the variable in any equations. The update symbols mode is the default mode and is in effect each time the program is started.

**Show Buttons**
If checked, shows buttons at bottom of child windows. The state of this menu item is stored in the system registry and remains in effect until changed.

**Show Toolbar**
If checked, shows toolbar. The state of this menu item is stored in the system registry and remains in effect until changed.

---

## 10.6 Help Menu

![Help Menu Screenshot]
The *Help* menu is the last menu on the menu bar. It is used to display the help index, help on specific topics, registration and support information and the *About* dialog box containing copyright information. The last group of buttons on the toolbar provides short cuts for some of the more commonly used menu items on the *Help* menu. The available menu items are:

- **Contents...** Displays table of contents or index of the help system. A short cut is to press the F1 key.

- **Glossary** Displays glossary of terms that is a part of help system.

- **Search for Help On....** Search for help based on a key word.

- **How to Use Help...** Displays help on using the help system.

- **How to Register** Displays instructions for registering the software. Registration and payment is required to continue using the software after the 30-day evaluation period.

- **Registration Form** Displays a registration form that can be printed out and used to register your copy of VarTran by Fax or mail.

- **Enter Registration Code...** Displays the *Registration* dialog box for entering user and registration codes so that VarTran can continue to be used after the 30-day free trial period. See Section 1.3.

- **Technical Support** Displays instructions for obtaining technical support.

- **VarTran Home Page** If you have an internet connection and a web browser, displays the home page for VarTran containing downloads of the most recent version and up to date information.

- **Register Using Web Site** If you have an internet connection and a web browser, displays the web page for registering your copy of VarTran over our secure web server using either a VISA or Master Card.

- **About VarTran...** Displays copyright and registration information in the *About* dialog box.
The toolbar buttons provide short cuts for the more frequently used menu items. Holding the mouse cursor over a toolbar button displays a popup description of the button. The menu items associated with each button is given in the table below.

<table>
<thead>
<tr>
<th>Control</th>
<th>Menu Item</th>
<th>Menu</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>New</td>
<td>File</td>
</tr>
<tr>
<td></td>
<td>Open…</td>
<td>File</td>
</tr>
<tr>
<td></td>
<td>Save</td>
<td>File</td>
</tr>
<tr>
<td></td>
<td>Save As…</td>
<td>File</td>
</tr>
<tr>
<td></td>
<td>Print</td>
<td>File</td>
</tr>
<tr>
<td></td>
<td>Copy to Clipboard</td>
<td>File</td>
</tr>
<tr>
<td></td>
<td>Add</td>
<td>Variables</td>
</tr>
<tr>
<td></td>
<td>I/O System Window</td>
<td>Variables</td>
</tr>
<tr>
<td></td>
<td>Summary Tables</td>
<td>Variables</td>
</tr>
<tr>
<td></td>
<td>Notes Window</td>
<td>Variables</td>
</tr>
<tr>
<td></td>
<td>Find Optimal Targets…</td>
<td>Analysis</td>
</tr>
<tr>
<td></td>
<td>Capability Study</td>
<td>Analysis</td>
</tr>
<tr>
<td></td>
<td>Pareto Chart of Variation</td>
<td>Analysis</td>
</tr>
<tr>
<td></td>
<td>Simulation…</td>
<td>Analysis</td>
</tr>
<tr>
<td></td>
<td>Lock All Unlocked Windows</td>
<td>Analysis</td>
</tr>
<tr>
<td></td>
<td>Effects Table</td>
<td>Analysis</td>
</tr>
<tr>
<td></td>
<td>Plots</td>
<td>Analysis</td>
</tr>
<tr>
<td></td>
<td>Contents</td>
<td>Help</td>
</tr>
<tr>
<td></td>
<td>Search for Help On…</td>
<td>Help</td>
</tr>
<tr>
<td></td>
<td>VarTran Home Page</td>
<td>Help</td>
</tr>
</tbody>
</table>
Category Input Variable

Input of I/O system that is restricted to specific values or levels which are referred to as categories. One example is material type A and B. Types A and B represent the categories. Other examples are mold cavity 1, 2, 3 and 4, and vendor A, B and C.

Cc

Capability index comparing the process average with the target and spec. limits to assess the centering of the process. Its formula is:

\[ C_c = \text{Maximum} \left( \frac{\mu - T}{\text{USL} - T}, \frac{T - \mu}{T - \text{LSL}} \right) \]

where USL is the upper specification limit, LSL is the lower specification limit, T is the target and \( \mu \) is the process average. \( C_c \) is independent of the units of measure. See Section 5.2.

Child Window

Child windows are displayed in the interior of the main window. They are used to display the data inputted and analysis results. The available child windows are: I/O System window, Summary Table window, Notes window, Capability Study window, Pareto Chart window, Effects Table window, Plots dialog box and Plot window.

The top child window is called the active window. Its caption bar is highlighted. To make a child window active, click on any part of the child window. One can also select a child window using the Window menu. A third way of selecting a child window is to hold down the Ctrl key and repeatedly press the Tab key till the appropriate child window is made active.

Clipboard

Utility provided by Windows operating system for sharing data with other programs. VarTran copies graphics in a form called a Metafile to the clipboard. These graphics can then be inserted into a word processing document by selecting the Paste menu item on the Edit menu of the word processor. For tables it copies them to the clipboard in both text and Metafile formats. The text is tab delimited to allow easy pasting into EXCEL. In Word, pasting will result in the text being pasted. To paste the graphic instead, in Word select the Paste Special menu item from the Edit menu and then check the picture option.
Coefficient of Variation (CV) The coefficient of variation or CV of a variable is its standard deviation divided by its average. It is frequently multiplied by 100 and reported on a percentage basis. For many products and processes, the standard deviation increases as the average is increased. An example is fill volume for a filling process. This type of process is better characterized by its CV. For example a CV of 3% means, regardless of the average, the standard deviation is 3% of the average.

Constant Expression Expressions containing only numbers, operators, functions and parenthesis. No variables or properties are allowed. Constant expressions represent a numerical constant such as a fraction. Examples include: "2/3", "1/(2 \pi)", and "e\]". Within VarTran, when a constant or number is required, one can enter a constant expression.

Continuous Input Variable Input of I/O system that can be adjusted over a continuous scale. Examples include dwell time and temperature on a heat seal machine and stroke length and motor speed on a pump. Targets and tolerances are to be determined for these inputs.

$C_p$ Capability index comparing the process variation with the width of the specification limits. Its formula is:

$$C_p = \frac{USL - LSL}{6\sigma}$$

where USL is the upper specification limit, LSL is the lower specification limit and $\sigma$ is the standard deviation. $C_p$ is independent of the units of measure. See Section 5.2.

$C_{pk}$ Capability index measuring the ability of the process to meet the specifications. Both variation and centering are considered. One way of writing its formula is

$$C_{pk} = \text{Minimum} \left( \frac{USL - \mu}{3\sigma}, \frac{\mu - LSL}{3\sigma} \right)$$

where USL is the upper specification limit, LSL is the lower specification limit, $\mu$ is the average and $\sigma$ is the standard deviation. If only one specification limit exists, calculate only that part of the equation and omit the minimum. $C_{pk}$ is independent of the units of measure. See Section 5.2.
**C_{pm}**

Capability index measuring the ability of the process to meet the specifications. Both variation and centering are considered. The formula is:

\[
C_{pk} = \frac{USL - LSL}{6\sqrt{\sigma^2 + (\mu - T)^2}}
\]

where USL is the upper specification limit, LSL is the lower specification limit, T is the target, \(\mu\) is the average and \(\sigma\) is the standard deviation. \(C_{pm}\) is independent of the units of measure. The denominator of \(C_{pm}\) contains the Root MSE. Maximizing \(C_{pm}\) is equivalent to minimizing Taguchi loss.

**Defect Rate**

The defect rate is a measure of the relative number of units that are defective. It is measured either in terms of percent defective or defects per million (dpm) units.

**Differentiable Expression**

Expressions restricted to those functions that are differentiable. Differentiable functions are Log, Log10, Exponential, SquareRoot, Sine, Cosine, Tangent, ArcSine, ArcCosine, ArcTangent, HyperbolicSine, HyperbolicCosine, HyperbolicTangent, NormalDistribution, InverseNormalDistribution, \(\pi\), and \(e\). Entering a differentiable expression for the equation of an output variable allows VarTran to use the Taylor Series approach in the *Output Variable* dialog box. Otherwise, one is restricted to the curve fitting approach.

**Distance From Target**

The distance from target is the maximum amount that the interval for values is from the target. Its formula is

\[
\text{Maximum}(UIV - \text{Target}, \text{Target} - LIV)
\]

where UIV is the upper end of the interval for values and LIV is the lower end of the interval for values.

**Distance Inside Spec**

The distance inside spec is the amount that the interval for values is from the specification limits. Its formula is

\[
\text{Minimum}(USL - UIV, LIV - LSL)
\]

where USL is the upper specification limit, LSL is the lower specification limit, UIV is the upper end of the interval for values and LIV is the lower end of the interval for values. If only one specification limit exists, calculate only that part of the equation and omit the minimum. A negative value means that the interval for individual values is outside the specification limits.
Expressions consist of numbers, operators, functions, variables, properties and parentheses.

**Numbers:** Examples are “1”, “1.0”, “.1”, “1.1 10^2”, and “-1.1 10^-2”.

**Operators:** Unary operators: - and +. Binary operators: +, -, *, /, and ^. If the parentheses are omitted, the operations are performed in the order determined by the operator precedence and association rules. Multiplication operators may be omitted.

**Functions:** Of form “function [param1, param2, ...]”. The following functions are supported: Log, Log10, Exponential, SquareRoot, Sine, Cosine, Tangent, ArcSine, ArcCosine, ArcTangent, HyperbolicSine, HyperbolicCosine, HyperbolicTangent, Gamma, LogGamma, Beta, LogBeta, AbsoluteValue, Minimum, Maximum, NormalDistribution, InverseNormalDistribution, pi, and e. Most functions require one parameter. Exceptions are Beta, LogBeta, Minimum and Maximum which require 2 and pi and e which require zero. Squared brackets must be used with functions.

**Variables:** String consisting of characters, the digits 0-9 and underscores. The first character cannot be a digit. Examples are: “SS”, “Seal_Strength”, “Zone_1”, and “_1”.

**Properties:** Of form “Symbol { Symbol }”. Examples are: “SS{Average}”, “Y{StandardDeviation}” and “O2{Cpk}”. Properties are used to specify characteristics of output variables and categories of category input variables.

**Rounded Parentheses:** “(” and “)” are used to control the order that operations are performed. Without parentheses, the operations are performed in the order determined by the operator precedence and association rules. If in doubt about the order the operations will be performed, use parentheses.

Special types of expressions are constant expressions and differentiable expressions.

**Input**

Jointly refers to continuous input variables and category input variables.

**Input/Output System**

Model fitting both products and process consisting of one or more output variables along with all the input variables affecting these outputs. Our goal is optimize and reduce the variation of the outputs by setting targets and tolerances on the inputs.
Interval for Values
The interval for values represents a range containing almost all of the individual values. Methods are given for calculating the interval for individual values for worst-case, statistical and process tolerances in Sections 5.3 to 5.5.

Kurtosis
Measure of how heavy the tails of a distribution are. The normal distribution has a kurtosis of 3. Higher values mean the tails are heavier than the normal distribution, i.e., more units fall outside the specifications than predicted using the normal distribution. Smaller values indicate lighter tails than the normal distribution, i.e., fewer units fall outside the specifications than predicted using the normal distribution. For example, the uniform distribution, with no tails, has a kurtosis of 1.8.

Objective Function
Objective functions are used to simultaneously optimize several output variables. They can reference any of the characteristics of the outputs and inputs. One example is Minimum\{O1\{Cpk\},O2\{Cpk\}\} where O1 and O2 are output variables. Maximizing this objective function ensures all the outputs have acceptable values of Cpk. Objective functions can also be written for Taguchi's signal to noise ratios allowing them to be maximized.

Optimization and Variation Reduction
Goal of VarTran. Jointly refers to optimizing the average and minimizing the variation. It is the outputs of the input/output system for which optimization and variation reduction is desired. Depending on the nature of the outputs, optimization of the average can mean to maximize the average (seal strength), minimize the average (harmful emissions or the center the average on target (fill volume). In all three cases, variation must also be reduced to ensure all units are within specifications.

Output
Jointly refers to output variable and objective function. Part of input/output system.

Output Variable
Output of I/O system that is a measurable characteristic. Examples include seal strength of a heat sealer and flow rate of a pump.

Precedence and Association
The operator precedence and association rules determine the default order that the operators in expressions are performed. This order can always be overridden using parentheses. See Section 4.5.
**Process Tolerance**

A process tolerance is a tolerance that specifies requirements for a process producing large quantities of parts. A process tolerance specifies a minimum and maximum average and a maximum standard deviation. Equivalently, a process tolerance can be defined by specifying values for $C_p$ and $C_c$. See Section 5.5.

**Relative Distance Inside Spec**

The relative distance inside spec is the relative distance that the interval for values is from the specification limits. Its formula is:

$$
\begin{align*}
\text{Relative Distance} &= 2 \times \min \left\{ \frac{\text{USL-UIV}}{\text{USL-LSL}}, \frac{\text{USL-LSL}}{\text{LIV-LSL}} \right\} \\
&\quad \text{If 2-sided spec}
\end{align*}
$$


$$
\begin{align*}
&= \frac{\text{USL - UIV}}{\text{USL - Target}} \\
&\quad \text{If upper spec and target}
\end{align*}
$$

$$
\begin{align*}
&= \frac{\text{LIV - Target}}{\text{Target - LSL}} \\
&\quad \text{If lower spec and target}
\end{align*}
$$

where USL is the upper specification limit, LSL is the lower specification limit, UIV is the upper end of the interval for values and LIV is the lower end of the interval for values. It represents the ratio of the distance from the interval for values to the nearest spec and half the width of the spec.

The relative distance inside spec is independent of the units of measure and is defined for all three types of tolerances, including worse-case tolerances. It requires that a target be specified for those outputs that have a 1-sided spec limit.

**Robust Tolerance Analysis**

Systematic approach to setting targets and tolerances to achieve a specified level of quality at the lowest possible cost. The process involves:

- Determining the key outputs and their specifications, the key inputs and their low cost tolerances and the relationship between the inputs and outputs.
- Find the optimal targets starting with the low-cost tolerances to achieve a robust design.
- Determine if the capability meets specified level of quality.
- If not, determine cause of variation and tighten its tolerance.
- Repeat previous 3 steps until the specified level of quality is achieved.
Robustness

Taguchi has emphasized the importance of robust designs. A robust product or process is one that is less sensitive to variation of the inputs. That way the inputs can continue to vary but less of this variation is transmitted to the output. This minimizes the need to tighten tolerances. Robustness is achieved by careful selection of targets for the inputs. See Section 3.4.

In VarTran, robust designs are achieved by finding the set of targets minimizing the defect rate, maximizing $C_{pk}$, or maximizing the distance inside specification. This minimizes the transmitted variation while driving the average to its ideal value.

Root Mean Square Error (Root MSE)

The root MSE is:

$$\text{Root MSE} = \sqrt{(\mu - \text{Target})^2 + \sigma^2}$$

where $\mu$ is the average and $\sigma$ is the standard deviation. It has the same units as the average and standard deviation.

The root MSE is always greater than or equal to zero. It can only be zero if the average is on target and the standard deviation is zero. Minimizing the root MSE drives the average to target with minimum variation. Minimizing the root MSE is equivalent to minimizing the Taguchi Loss.

Sigma Level

Measure of quality that directly relates to the defect rate. Six Sigma corresponds to 3.4 defects per million. Three sigma to 0.13% defective or 1300 defects per million. See Section 5.2.

Six Sigma Quality

Six sigma quality requires that for each measurable characteristic such as fill volume, seal strength and so on, the defect rate to be no more than 3.4 defects per million. In a table of the normal curve, the value 3.4 defects per million is found at 4.5 standard deviations. Six sigma quality requires that the process average be kept at least $4.5\sigma$ from the nearest specification limit. See Section 5.2.

This is accomplished if:

- $C_{pk} \geq 1.5$
- $C_p \geq 2$ and $C_c \leq 0.25$
- The Interval for Values based on +/-4.5 SD is within the specification limits.
| **Skewness** | Measure of whether the distribution is symmetric, i.e., both tails of the distribution are of the same size. A value of zero means the distribution is symmetrical. A positive value means the right tail is longer. A negative value means the left tail is longer. |
| **Statistical Tolerance** | A statistical tolerance is a tolerance that specifies requirements for the process variation while assuming a centered process. A statistical tolerance is determined by its target, standard deviation and distribution. A statistical tolerance is a special case of a process tolerance with no operating window, i.e., minimum average = maximum average = target. |
| **Symbol** | Unique identifier for variable. It is used in equations to represent the variable. It can be any combination of letters, the digits 0-9 and underscores so long as the first character is not a digit. It can be of any length but is best limited to 1-4 characters. Examples of valid symbols are: A A1 _1 Res_1 Examples if illegal symbols are: A B (No embedded blanks allowed) AS1 (Illegal character) 1_ (Digit not allowed as first character) |
| **Variation Transmission Analysis** | Jointly refers to methods of predicting the behavior of an output based on the behaviors of inputs and the effect of the inputs on the outputs. Several approaches include Monte Carlo simulation, propagation of errors, and statistical tolerancing. |
| **Variation Inducing Parameter (VIP)** | Input variable primarily responsible for inducing or causing the variation of an output variable. While all the input variables are potential sources of variation, the Pareto principle implies that most of the variation is the result of just 1 or 2 inputs. |
| **Worst-case Tolerance** | A worst-case tolerance specifies a minimum and maximum value for a unit of product. Use of worst-case tolerances is safe. However, because they guard against a worst-case scenario that is unlikely if not impossible, worst-case tolerancing results in the setting of tolerances tighter than necessary. As a result worst-case tolerancing unnecessarily drives up costs. A worst-case tolerance is a special case of a process tolerance with zero standard deviation allowing all units to be at either extreme of the operating window. |
**Z-score**

Measure of how close the process average is to the specification relative to the variation. For a single specification limit its formula is:

\[ Z - \text{Score} = \frac{\text{USL} - \mu}{\sigma} \quad \text{or} \quad Z - \text{Score} = \frac{\mu - \text{LSL}}{\sigma} \]

where USL is the upper specification limit, LSL is the lower specification limit, \( \mu \) is the average and \( \sigma \) is the standard deviation. In the 1-sided spec case the Z-Score is 3 times \( C_{pk} \). The z-score is independent of the units of measure. See Section 5.2.


Index

A
Add Category dialog box, 62
Analysis menu, 152
Association, 65, 72, 163
Automatic scaling, 136

C
Capability study, 79, 90
Capability Study window, 79
Caption bar, 49
Category Input dialog box, 61
Category input variable. See input variable
Cc, 84, 91, 98, 159
Child window, 147, 159
Clipboard, 159
Coefficient of variation, 123, 160
Constant expression, 160
Continuous input variable. See input variable
Continuous Input Variable dialog box, 51
Contour plot, 30, 125
Costs
Reducing, 39, 42
Cp, 81, 90, 98, 160
Cpk, 85, 91, 98, 104, 160
Cpm, 161
Curve fit approach, 66
CV. See coefficient of variation

D
Defect rate, 88, 91, 98, 104, 161
Dialog box
Add Category, 62
Category Input, 61
Continuous Input Variable, 51
Enter Note, 153
Find Optimal Targets, 103
Keypad Equation, 68
Name I/O System, 75
Number of Duplicate Copies, 150
Number Standard Deviations for Interval for Values, 154
Objective Function, 70
Optimization Options, 109
Output Variable, 63
Paste Equation, 69
Plot Options, 128
Plots, 125
Print Setup, 149
Registration, 156
Simulation, 136
View Equations, 67
Differentiable expression, 161
Dimensional stack-up problems, 20
Distance from target, 104, 161
Distance inside spec, 104, 161
Distribution, 53
Dual response approach, 12, 141, 143

E
Effects table, 121
Effects Table window, 121
Enter Note dialog box, 153
Environment. See usage conditions
Equation. See expression
Errors, 58
EXCEL, 69
Expression, 162
Constant, 160
Differentiable, 161
Objective function, 71
Output variable, 64
Value versus property, 139

F
File
Open, 148
Save, 50, 148
Save as, 149
File menu, 147
Find Optimal Targets dialog box, 103
Functions, 64, 71, 162

H
Help menu, 156

I
I/O System window, 74
Input variable, 34, 162
Category, 61, 134, 159
<table>
<thead>
<tr>
<th>Continuous, 51, 160</th>
<th>Precedence, 65, 72, 163</th>
</tr>
</thead>
<tbody>
<tr>
<td>Input Variable dialog box, 51</td>
<td>Optimization, 32, 103, 105</td>
</tr>
<tr>
<td>Input/output system, 34, 162</td>
<td>Excluding inputs, 56</td>
</tr>
<tr>
<td>Installing software, 1</td>
<td>Interval method, 32, 107, 109</td>
</tr>
<tr>
<td>Interaction, 41, 123, 125</td>
<td>Multiple responses, 66, 104</td>
</tr>
<tr>
<td>Interval for values, 91, 95, 99, 104, 154, 163</td>
<td>Simplex, 106, 109</td>
</tr>
<tr>
<td><strong>J</strong></td>
<td>Optimization and variation reduction, 33, 163</td>
</tr>
<tr>
<td>JMP, 69</td>
<td>Closer to target the better, 33</td>
</tr>
<tr>
<td><strong>K</strong></td>
<td>Larger the better, 33</td>
</tr>
<tr>
<td>Keypad Equation dialog box, 68</td>
<td>Smaller the better, 34</td>
</tr>
<tr>
<td>Kurtosis, 163</td>
<td><strong>M</strong></td>
</tr>
<tr>
<td><strong>Main window, 49</strong></td>
<td>Math capabilities, 28</td>
</tr>
<tr>
<td><strong>Manufacturability, 11, 48</strong></td>
<td>Mathematica, 69</td>
</tr>
<tr>
<td><strong>Math menu, 49, 147</strong></td>
<td>Menu, 49, 147</td>
</tr>
<tr>
<td>Analysis, 152</td>
<td>Analysis, 152</td>
</tr>
<tr>
<td><strong>File, 147</strong></td>
<td>File, 147</td>
</tr>
<tr>
<td><strong>Help, 156</strong></td>
<td>Help, 156</td>
</tr>
<tr>
<td><strong>Options, 154</strong></td>
<td>Options, 154</td>
</tr>
<tr>
<td><strong>Plot, 127</strong></td>
<td>Plot, 127</td>
</tr>
<tr>
<td><strong>Variables, 50, 150</strong></td>
<td>Plot menu, 127</td>
</tr>
<tr>
<td><strong>Window, 153</strong></td>
<td>Plots dialog box, 125</td>
</tr>
<tr>
<td><strong>Minitab, 69</strong></td>
<td>Precedence, 65, 72, 163</td>
</tr>
<tr>
<td>Name I/O System dialog box, 75</td>
<td>Print Setup dialog box, 149</td>
</tr>
<tr>
<td>Normal distribution, 53, 88</td>
<td>Process tolerance, 45, 97, 164</td>
</tr>
<tr>
<td><strong>Notes window, 151</strong></td>
<td>Example, 25</td>
</tr>
<tr>
<td><strong>Number of Duplicate Copies dialog box, 150</strong></td>
<td>Pros and cons, 26, 101</td>
</tr>
<tr>
<td><strong>Number Standard Deviations for Interval for Values dialog box, 154</strong></td>
<td>Six sigma, 88</td>
</tr>
<tr>
<td><strong>Numbers Writing, 64, 71, 162</strong></td>
<td>Propagation of errors. See variation transmission analysis</td>
</tr>
<tr>
<td><strong>P</strong></td>
<td>Properties, 162</td>
</tr>
<tr>
<td>Pareto Chart window, 111</td>
<td><strong>R</strong></td>
</tr>
<tr>
<td>Paste Equation dialog box, 69</td>
<td>Registering software, 2</td>
</tr>
<tr>
<td>Percent defective. See defect rate</td>
<td>Registration dialog box, 156</td>
</tr>
<tr>
<td>Plot menu, 127</td>
<td>Relative distance inside spec, 164</td>
</tr>
<tr>
<td>Plot Options dialog box, 128</td>
<td>Reliability, 41, 47</td>
</tr>
<tr>
<td>Plot window, 127</td>
<td>Response surface study, 12, 139</td>
</tr>
<tr>
<td>Plots dialog box, 125</td>
<td>Robust tolerance analysis, 48, 164</td>
</tr>
<tr>
<td>Precedence, 65, 72, 163</td>
<td>Robustness, 8, 11, 39, 40, 103, 165</td>
</tr>
<tr>
<td>Print Setup dialog box, 149</td>
<td>Dual response approach, 12, 141, 143</td>
</tr>
<tr>
<td>Process tolerance, 45, 97, 164</td>
<td>Taguchi methods, 12, 146</td>
</tr>
<tr>
<td>Example, 25</td>
<td>Tolerance analysis approach, 12, 19, 143, 146</td>
</tr>
<tr>
<td>Pros and cons, 26, 101</td>
<td>Root mean square error, 165</td>
</tr>
</tbody>
</table>

| **Six sigma, 88** | Properties, 162 |
| **Registration dialog box, 156** | **R** |
| **Relative distance inside spec, 164** | **Registration dialog box, 156** |
| **Reliability, 41, 47** | **Relative distance inside spec, 164** |
| **Response surface study, 12, 139** | **Robust tolerance analysis, 48, 164** |
| **Robustness, 8, 11, 39, 40, 103, 165** | **Robustness, 8, 11, 39, 40, 103, 165** |
| **Dual response approach, 12, 141, 143** | **Taguchi methods, 12, 146** |
| **Taguchi methods, 12, 146** | **Tolerance analysis approach, 12, 19, 143, 146** |
| **Root mean square error, 165** | **Root mean square error, 165** |
S
Sensitivity analysis. See variation transmission analysis
Sigma level, 91, 99, 165
Simulation, 43, 136, 166
Simulation dialog box, 136
Six sigma quality, 88, 99, 165
Skewness, 166
Statgraphics, 69
Statistical tolerance, 44, 52, 90, 166
  Benderizing, 93
  Example, 22
  Pros and cons, 24, 93
Status line, 50, 58
Summary Table window, 76
Symbol, 51, 61, 62, 63, 71, 166

T
Taguchi, 8, 40
  Inner/outer arrays, 12, 146
  Loss function, 36, 73
  Signal-to-noise ratios, 73, 146
Target
  Input, 52
  Minimum and maximum, 56
  Output, 65
Taylor series approach, 66
Tolerance
  Benderizing, 93
  Individual values, 104
  Process. See process tolerance
  Selecting type to use, 47, 58
  Statistical. See statistical tolerance
  Unified approach, 26
  Worst-case. See worst-case tolerance
Toolbar, 50, 157

Transmission of variation, 37

U
Uninstalling software, 2
Updating windows, 58, 155
Usage conditions, 41, 47

V
Variable
  Add, 50, 74
  Editing, 74
  Input. See input variable
  Off-axis, 133
  Output. See output variable
  Symbol. See Symbol
Variables menu, 50, 150
Variation inducing parameter, 38, 113, 143, 146, 166
Variation reduction
  Benefits, 35
  Strategy, 37
Variation transmission analysis, 43, 79, 166
View Equations dialog box, 67
VIP. See variation inducing parameter

W
Wear and deterioration, 41
Window menu, 153
Worst-case tolerance, 44, 94, 166
  Example, 20
  Pros and cons, 24, 96

Z
Z-score, 87, 91, 99, 167
Taylor Enterprises, Inc

5510 Fairmont Road, Suite A, Libertyville, IL 60048